
SFMAR 
\   J    / 

■_▼_ 
▼ 

Systems Center 
San Diego 

TECHNICAL DOCUMENT 3028 
April 1998 

Advanced Refractive 
Effects Prediction System 

(AREPS) 
Version 1.0 User's Manual 

Wayne L. Patterson 

Approved for public release; 
distribution is unlimited. 

i 



TECHNICAL DOCUMENT 3028 
April 1998 

Advanced Refractive 
Effects Prediction System 

(AREPS) 
Version 1.0 User's Manual 

Wayne L. Patterson 

Approved for public release; 
distribution is unlimited. 

SFWAR 

Systems Center 
San Diego 

Space and Naval Warfare Systems Center 
San Diego, CA 92152-5001 

DTIC QUALITY INSPECTED 1 19980707 172 



SPACE AND NAVAL WARFARE SYSTEMS CENTER 
San Diego, California 92152-5001 

H. A. Williams, CAPT, USN R- C. Kolb 
Commanding Officer Executive Director 

ADMINISTRATIVE INFORMATION 

The Advanced Refractive Effects Prediction System (AREPS): Version 1.0 User's Manual was 
funded by the Space and Naval Warfare Systems Command, PMW 185. Wayne L. Patterson of the 
Tropospheric Branch, Space and Naval Warfare Systems Center, D883, prepared the manual under 
program element 0603207N, accession number DN305062, work unit D88-MP67. 

Note: the AREPS program software supplied with this document has the same classification and 
distribution as the document. 

Third-Party Software. Windows® is a registered trademark of the Microsoft Corporation. Addi- 
tional Microsoft products mentioned in this document may be either trademarks or registered(trade- 
marks. InstallShield® is a registered trademark of the InstallShield Software Corporation. The fol- 
lowing software may be trademarks or servicemarks of their respective companies: DEC Fortran, 
Digital Equipment Corporation; Spread 2.5, FarPoint Technologies, Inc. 

Released by Under authority of 
R. A. Paulus, Head J- H. Richter, Head 
Tropospheric Branch Propagation Division 

LH 



Contents i 

CONTENTS 

Chapter 1: Getting Started 1 
About AREPS 1 
Installing/Uninstalling AREPS 1 

Hardware and Operating System Requirements 1 
Installing AREPS 2 
Uninstalling AREPS 3 

AREPS Support Services 4 
On-line Help 4 
Technical Support 5 

How to Run the AREPS Program 6 
Navigating the AREPS Windows 6 
Entering or Editing Data 7 

Data Limits 7 
Changing Units 8 

Initializing AREPS 8 
Populating Your EM System Database 9 
Entering the Current Atmosphere's Condition 11 
Creating and Running a Project 12 

Chapter 2: Conventions and files 13 
Terms and Conventions 13 

Typographical Conventions 13 
Keyboard Conventions 13 
Mouse Conventions 14 
Data Input Point Illustrations 14 

Program Files 16 
Permanent Program Files 16 
Sample Program Files 17 
Created Program Files 18 
Technical Support Files 20 
Installation Files 20 
Third-Party and Windows Support Files 20 

Chapter 3: The Earth's Atmosphere 23 
Structure and Characteristics 23 
Refraction 23 

Index of Refraction 23 
Refractivity and Modified Refractivity 24 
Effective Earth Radius 25 
Refractive Conditions 25 

Standard and Normal Conditions 25 
Subrefractive Conditions 26 
Superrefractive Conditions 26 
Trapping Conditions 26 



11 

Atmospheric Ducts 27 
Surface Ducts 28 
Evaporation Ducts 29 
Elevated Ducts 30 

Standard Wave Propagation 31 
Propagation Loss and Signal-to-Noise Ratio 31 
Standard Propagation 31 

Free-space Propagation 31 
Optical Interference and Surface Reflection 32 
Diffraction 33 
Tropospheric Scatter 33 

Anomalous Propagation Mechanisms 33 
Subrefractive Layers 33 
Superrefractive Layers 34 
Trapping Layers 34 

Chapter 4: AREPS Menus 35 
AREPS Main Menu 35 

File Menu 35 
Edit Menu 36 
View Menu 36 
Systems Menu 36 
Environments Menu 37 
Windows Menu 37 
Help Menu 37 

AREPS Popup Menus 38 
Change Units 38 

Chapter 5: Project and EM Systems 39 
Open/Remove Window 39 
Project Window 40 

Project Label 41 
Classification 41 
Decision Aids 41 
Systems and Environment Grouping 42 

Platform/Site Name 42 
Radar Name or Transmitter Name 42 
Antenna Height 42 
Target Name 43 
Receiver Name (Communications or ESM) 43 
Environment Name 43 

Project Geographic Area Grouping 43 
Latitude and Longitude 43 
First Bearing 43 
Bearing Increment 44 
Number of Bearings 44 



Contents iii 

Graphic Display Options Grouping 44 
Minimum Height 44 
Maximum Height 45 
Maximum Display Range 45 
Map Options 45 
Earth Surface Depiction 46 

Command Buttons 46 
Execute 46 
Display 47 
Save 47 
Cancel 47 

Project Initialization File 47 
Platform Window 48 

Platform Type and Location Grouping 48 
Height Reference 49 
Emitter Library 49 
Platform Emitter Suite 49 
Command Buttons 50 

Add Emitter 50 
Remove Emitter 50 
New Radar 50 
New Comm 50 
View Emitter 50 

Radar Window 51 
Radar Calculations Options 51 
EM System Parameters ^52 

Your Identification Label 52 
Frequency 52 
Peak Power ..52 
Pulse Length 53 
Compressed Pulse Length 53 
Receiver Noise Figure 53 
Assumed System Loss 53 
Maximum Instrumented Range 53 
Pulse Rate 54 
Probability of False Alarm 54 
Antenna Pattern 54 
Antenna Type 55 
Polarization 55 
Hits Per Scan 55 
Antenna Gain 56 
Antenna Scan Rate 56 
Horizontal Beam Width 56 
Vertical Beam Width 56 
Antenna Elevation Angle 56 



IV 

Communications Window 57 
Receiver Sensitivity 57 

ESM Window 57 
Target Window 57 

Radar Cross-Section 58 
SweriingCase 58 

Chapter 6: Options Window 59 
Command Buttons 59 

OK Button 59 
Save Button 59 
Cancel Button 59 
Defaults Button 59 
Reset Button 59 

Folders and Drives Tab 60 
CD-ROM Drive 60 
Terrain Folder 62 
System Database Folder 62 
Projects Folder 62 
Environments Folder 62 
Automode Folder 63 
Browse Command Button 63 

Security Labels Tab 63 
Program Flow Tab 64 

Pause Program for Option Selection 64 
Platform and Emitter Links 65 

Attenuations Tab 65 
Save and Edit Tab 66 

APM Output Data Options 67 
Save in EREPS Binary Format 67 
Save in AREPS Binary Format 68 
Save in ASCII Text Format 70 
Save in Bitmap Image Format 72 
Save Terrain in ASCII Text Format 72 

Remove All Optional Files 72 
Convert Values When Units Change 73 

Displays Tab 73 
Coverage Display 74 
Loss Versus Range and Height Display 74 
Curved Earth Display Attributes 74 

Terrain Tab 75 
Which Terrain Data to Use 75 
Use DTED Level 76 
Other DTED Options 76 

Recreate Terrain Map with Each Run 76 
Save Map Heights as ASCII Text 76 



Contents v 

Copy DTED Data to Hard Disk 76 
Overwrite DTED Data on Hard Disk 77 
Search for Data if not on Hard Disk 77 
Interpolate Between DTED Data Holes 77 
If Terrain not on CD, Create Empty File 77 
Rescan CD to Update Empty Files 77 
If CD is Missing, Assume Water 78 
Assume Empty Files are Water 78 
Ask Me for Missing CD-ROMs 78 

If Terrain is Higher Than Display Height 78 
Environment Tab 79 

Lack of Environment Data in Range 79 
Lack of Environment Data in Bearing 80 
Lack of Environment Data in Height 80 

Chapter 7: The Environment 81 
Environment Window 81 
Common Input Fields 82 

Environmental Label 82 
WMO Station Type 82 
Station Elevation 83 
Profile Legend 83 

Import WMO Code Tab 83 
Enter WMO Code Tab 85 
Enter Profile Tab 86 
Evaporation Duct Tab 87 

Surface Observation Input Fields 88 
Air Temperature 88 
Humidity 89 
Sea Surface Temperature 89 
Surface Wind Speed 89 

Evaporation Duct Input Fields 89 
Evaporation Duct Height 89 
Monin-Obukhov Length 89 
Richardson Number 90 

Evaporation Duct Profile 90 
Climatology Tab 90 
Refractive Summary Window 91 
World Meteorological Organization (WMO) Code 92 

Five-Character Figure Groups 93 
Station Identification Group 93 
Date and Time Group 93 
Latitude Group 94 
Longitude Group 94 
Marsden Square Group 94 
Station Elevation Group 94 



VI 

Significant Pressure Groups 95 
Significant Temperature Groups 95 

Environmental File Format 96 
Bearing Dependency 96 
Radio-refractivity (Meteorological) Field Restrictions 97 
File Key Words and Symbols 97 
File Units 99 

How to Construct a Range Dependent Environmental File 100 
Preparing the Data 101 

Gathering the Profile Data 101 
Evaluating the Profile Data 102 
Reducing the Profile Data 105 

Mapping the Evaporation Duct Portion of the Profile 109 
Mapping the Upper-air Portion of the Profile 117 
Merging the Profiles into One File 125 

Chapter 8: Terrain 127 
DTED Terrain Data 127 
DTED Folder Structure 128 
Terrain CD-ROM File Manager Window 128 
My Own Terrain 129 

Center Location 129 
Bearing from Center 129 
Terrain Range and Height 130 
Surface Type 130 
Surface Electrical Characteristics 131 
Command Buttons 132 

Open 132 
Save 132 
Insert and Delete Range 132 
Cancel 132 

Terrain File Format 133 
Terrain File Name 133 
Terrain File Considerations 133 
Terrain File Restrictions 134 
Key Words and Symbols 134 

Chapter 9: Decision Aids 136 
Coverage Display Window 136 

Display Window Toolbar 137 
Display Window Color Bar 137 
Coverage Display Options 138 

Loss Versus Range Display Window —• 138 
Loss Versus Height Display Window 140 

Loss Versus Range and Height Options 140 



Contents vii 

Chapter 10: Tactical Applications 141 
Strike and Electronic Counter Measures Considerations 141 
Early Warning Aircraft Stationing Considerations 143 
Electronic Surveillance Measures (ESM) 146 
UHF/VHF Communications 147 
Use for Hardware Maintenance 148 



Chapter 1: Getting Started 1 

GETTING STARTED 

About AREPS 

The Advanced Refractive Effects Prediction System (AREPS) program computes 
and displays a number of tactical decision aids. These are radar probability of detection, 
electronic surveillance measure (ESM) vulnerability, UHF/VHF communications, and 
simultaneous radar detection and ESM vulnerability. All decision aids are displayed as a 
function of height, range, and bearing. Detection probability, ESM vulnerability, and 
communications assessments are based on electromagnetic (EM) system parameters 
stored in a changeable database you maintain. Paths containing land features depend on 
terrain data either obtained from the National Imagery and Mapping Agency's (NIMA) 
Digital Terrain Elevation Data (DTED) or specified from your own source. 

All calculations depend on atmospheric refractivity data derived from radiosondes 
or other sensors. The propagation model used is the Advanced Propagation Model 
(APM). AREPS creates a height versus range coverage diagram for each azimuth 
desired. Each coverage diagram is stored in a bitmap graphics file. When all coverage 
diagrams requested have been computed and stored, AREPS displays the coverage 
diagrams in rapid sequence, rotating through the various azimuths. You may change the 
rotation speed, pause the sequence at any azimuth, step the sequence forward in azimuth 
one diagram at a time, or step the sequence backward in azimuth one diagram at a time. 
For each diagram, you may also display a propagation loss versus range and/or height 
decision aid. Using a mouse or other pointing device, you may display many additional 
pieces of information, including height, range, latitude, and longitude from the decision 
aid's geographical center, terrain elevations, and propagation loss values. 

Installing/Uninstalling AREPS 

Hardware and Operating System Requirements 

You may install and run AREPS on an IBM PC or 100 percent compatible 
computer running the U.S. English regional version of the Microsoft Windows® 
operating system. The minimum hardware requirement to run AREPS is the same as the 
minimum requirements for the operating system. A CD-ROM drive is highly 
recommended. To take advantage of the full capabilities of the AREPS program, we 
recommend a Pentium class computer, at least 16 megabytes of random access memory 
(RAM), a large hard disk drive (1 gigabyte or larger), and a printer. While the AREPS 
program has been tested in all screen modes for large and small fonts, it is designed for 
an 800x600 (or larger) small font display. Should the AREPS windows fail to appear in 
proper proportion or scroll bars appear on all AREPS windows, we recommend setting 
the computer's display to the 800x600 (or larger) small font mode if your monitor will 
allow it. 



The AREPS program runs under the U.S. English regional setting of 
Windows 95, 98, NT 3.51 and NT 4.0. If your regional setting is something 
other than U.S. English, AREPS may not function correctly.  Some regional 
settings substitute the comma character for the decimal point character. This 

will cause type mismatch errors while working with the EM system ^^ 
database.   If this occurs and you still desire to use AREPS, you must ^A 
change your regional setting to U.S. English.  This change is made from . 
the regional settings icon found in the Windows Control Panel. Settings 

Installing AREPS 

AREPS normal distribution is via the Internet or on a CD-ROM. Contact 
technical support about other distribution options. If you are installing AREPS and a 
previous version currently exists on your computer, we recommend you uninstall and 
remove it prior to installing it again. 

If you are installing AREPS under Windows NT, you must have system 
Ä   x     administrator authority. 

► To obtain and install AREPS from the Internet. 

Steps Comments  
1 Request the AREPS software from our Internet homepage 

(http://sunspot.spawar.navy.mil) by clicking on the 
Request AREPS hypertext link. 

2 Complete the AREPS registration form. If you request, we 
will use your email address to inform you of any software 
service packages or other items of general interest. Your 
information will not be used for any other purpose. When 
the registration form is complete, click on the Send request 
to SSC button. 

3 AREPS is segmented into parts, each of which is sized to fit 
on a 3.5-inch floppy diskette. Click on the hypertext link 
for each segment and save it in a temporary folder. 

4 After all the segments have been obtained, move to the 
temporary folder and double click on the first segment's 
file name (arepsl.exe). It will automatically expand its 
contents. The default expansion folder is your system's 
temporary folder, but you must choose the temporary folder 
containing the other segment files. 
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Steps              Comments 
Double click Setup.exe and follow any instructions 
provided on the screen. After AREPS is installed, you may 
delete all the compressed and expanded segment files. 
Prior to deleting the compressed segment files, you may 
wish to copy them onto floppy diskettes for installation on 
another computer. 

►  To install AREPS from a CD-ROM. 

Steps Comments 
1 Insert the CD-ROM distribution disk into your CD drive. 

2 Click the Start button, point to Settings, and then click the 
Control Panel icon. 

3 Double click the Add/Remove Programs icon. 

4 Follow the instructions on your screen. 

►        To create AREPS program shortcut. 

To get to the AREPS program more quickly once it is installed, you may wish to 
create a shortcut icon on your desktop. 

Steps Comments 
1 In  My   Computer  or  Windows   Explorer,   locate  the 

AREPS.EXE file. 

2 Using the right mouse button, drag the program icon to the 
desktop. 

3 Click Create Shortcut(s) Here. 

Uninstalling AREPS 

When AREPS installs itself, a number of files are installed to your 
System subfolder. These files are dependent upon which operating system 
you are using. Should you need to remove the AREPS program, we highly 
recommend you use the Add/Remove program icon found in the Windows 
Control Panel and let the Install Shield uninstall program remove AREPS for you 



Some system files may be needed by other programs. The Install Shield 
uninstall program will alert you as to which files these are and will ask for your 
permission to remove them. If in doubt, it is best to just leave these files in 
place. 

To uninstall AREPS 

Steps Comments 
1 Click the Start button, point to Settings, and then click the 

Control Panel icon. 

2 Double click the Add/Remove Programs icon. 

3 Select AREPS from the installed component list. 

4 Click the Add/Remove button. 

AREPS Support Services 

On-line Help 

,,---..        If you   have   a   question   about   AREPS,   first   look   in   the   printed 
( ^ ^)     documentation, or consult Help. Each input parameter, menu item, program 
^^T       option, or window has its own on-line help that defines or describes the 

parameter and any special considerations, cautions, and proper parameter 
uses. The on-line help is in two forms, quick look help and full help. 

► To use the quick look help feature 

Point to the item in question and press the Fl key. You do not need to 
click a mouse button nor does the item in question have to be the current input point. 
Items that are currently not available (showing as gray on the screen) will not have quick 
look help. To get help for these items, make them active by performing any necessary 
action or refer to the full help. In some cases, an item may not have quick look help at 
all. If so, you will see the message "No HELP topic is associated with this item." For 
help on these items, refer to the full help feature. 

► To use the full help feature 

Select Help and then Contents from the AREPS main menu bar. 
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Technical Support 

We provide no-charge support for AREPS, including help with software-related 
problems or questions and training and consultation in the proper use of the AREPS 
products. Support is available between 7:15 a.m. and 4:45 p.m. Pacific Time, Monday 
through Thursday, excluding holidays. Our working hours are such that every other 
Friday is a non-working Friday. Should you call on the non-working Friday, you may 
leave a message and a developer will return your call as soon as possible. 

For technical support via a toll call, dial (619) 553-1424; or via the Defense 
Switching Network (DSN), dial 553-1424. 

For technical support via the Internet, electronically mail your questions to 
D883@spawar.navy.mil. 

For technical support via facsimile, dial (619) 553-1417. 

■TT5Txl 

c .;  As now capabilites are added and/or trouble reports resolved, 
r'software service pads are posted ta our internet homepage. If you 

are connected to an on-line Internet provider for FTP services, you 
may obtain the service pack automatically. 

OAs additional capabilities are implemented or software problems are discovered 
and resolved, service packs will be posted on our Internet homepage. To 
obtain the latest service pack, to request the complete AREPS program, to view 

other people's questions or ask your own, and to receive other announcements via the 
Internet, point your browser to our homepage at http://sunspot.spawar.navy.mil. 

For those users who have an 
active connection to an Internet 
Service Provider (ISP) that supports 
File Transfer Protocol (FTP), AREPS 
provides an automatic software update 
feature. The software update window, 
shown in figure 1-1, displays the 
version of AREPS you are currently 
using. By clicking the Check Service 
Pack command button, AREPS will 
query our technical support Internet 
homepage for the most current AREPS 
version. If your version is not the most 

recent, you may click the Obtain Service Pack command button and the latest AREPS 
service pack will download to your AREPS folder. To install the service pack, follow the 
instructions shown in this window and those within the "Read Me" file in the service 
pack. 

■©: _)   Your are currently using AREPS Version (D.7OJ0OOOJ. 

Step.1. Olck command button to check for service pack. 

Check Service Pack» '   Obtain Service Pack! PK« 

Figure 1-1: Software update window. 



How to Run the AREPS Program 

Steps Comments 
Start AREPS by double clicking the AREPS icon or by clicking 
the Windows Start button, clicking the Run button, and typing the 
AREPS.EXE file name in the run field. 

If running AREPS for the first time, complete the program 
initialization information. 

If running AREPS for the first time, populate your EM system 
database. Additional EM systems may be entered into the 
database at any time. 

Enter the atmosphere's current refractive conditions or create an 
environmental file from climatology. 

Create a new project or select a previously created project. Edit 
the project as necessary. 

Click the Execute command button. 

Navigating the AREPS Windows 

The AREPS main window has controls, a menu system across the top of the 
window as shown in figure 1-2 and a status bar across the bottom of the window as 
shown in figure 1-3. 

F£l AREPS - A dvanc e d Refractive Eff e cts Pre diction System UHU SH 

Rle    Edit   View   Systems    Environments    Options    Windows    Help 

Figure 1-2: AREPS main menu. 

1000 <= Maximum height (It) <= 100000 m 
Figure 1-3: AREPS status bar. 

The main menu controls all the AREPS functionality such as creating decision 
aids, editing data input, viewing toolbars, performing EM system database management 
functions, creating and displaying environmental data, setting program options, arranging 
all other AREPS windows, and obtaining help. All windows are opened, closed, and 
otherwise managed from the menu. Refer to chapter 4 (AREPS Menus) for a complete 
discussion of each menu item. 
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The status bar is divided into three panels. The left panel provides limit 
information about the AREPS control that currently requires your attention (has the 
focus). The right panel provides information about how to select an item or how to 
obtain an optional menu. The center panel shows the status of certain keys such as the 
NUM LOCK key. 

All other AREPS windows contain a combination of data input points (controls) 
which gain focus when they are accessed. You use these input points to provide any 
necessary data. At the top of each window is a title bar describing the window's type. 
Since Windows is capable of multi-tasking, more than one window of the same type may 
be open at the same time; for example, you may have three radar windows open 
simultaneously. If so, the window's number shows in the title bar as Element(O), 
Element(l), etc. You have access to the AREPS menu system at any time, except when 
the Options window and the Error window are open. These two windows require you to 
make a critical decision before AREPS can proceed. 

Entering or Editing Data 

A flashing cursor for text fields or a highlighted background for other controls 
shows the item which has the focus. An instructional prompt for this item shows in the 
status bar. For a text field, when the field first gains your attention, the text will be 
highlighted. While highlighted, the DELETE key will erase the contents of the field. If 
the text is not highlighted, the DELETE key will erase only the character to the right of 
the cursor. To input or edit data, just type a new value. Once any change is made to a 
field, the highlight will disappear. The <— and ->■ keys move the cursor to the left and 
right within the field. The t and ■i keys move the cursor up and down within a tabular 
form. It is not necessary to press the ENTER key before moving to another field. 

Data Limits 

AREPS assigns limits to most input items. The limits are divided into two 
groups, a hard limit group and a soft limit group. Hard limits may not be exceeded and 
will not be accepted. Soft limits are those we consider to be out of the normal usage 
range but we will still allow you to enter. An input item's validity range shows in the left 
panel of the status bar. If you exceed a hard limit, the background color of the input 
value will turn to red. An error message shows and your only option is to re-enter the 
item. If you exceed a soft limit, the background color of the input value will turn yellow. 
A warning message shows and you may choose to re-enter the value or accept the value. 
While you may leave a field with an unresolved error, you will not be allowed to save a 
system in the database or create a decision aid until the hard limit error is corrected. 

STOP 
A value outside the valid range may yield erroneous BUT NOT 
NECESSARILY OBVIOUSLY WRONG results and may cause AREPS 
to abort with a runtime error, may cause loss of computer memory, or may 
cause some other undesirable consequence. You are encouraged to adhere 
to the recommended limits when entering a value. 



Changing Units 

All allowable units are preprogrammed and you may not deviate from them. 
Units may be changed by typing the first letter of the desired unit in the input field, or by 
clicking the right mouse button on the information label appearing adjacent to the field. 
For items within a tabular form, you may click the right mouse button on the column's 
title bar. For a right mouse click, a unit's selection popup menu appears. Highlight your 
choice with the t and I keys and press the ENTER key, or click on your choice with the 
left mouse button. 

When you change units, the value may or may not be converted. By default, the 
value is not converted. You may change the default by selecting the Convert the input 
value when its units change check box from the Save/Edit item on the Options menu. 
More than one field may be "tied" to a particular unit, especially for items in a tabular 
form. Converting such a field will convert ALL fields tied to that unit. For example, 
when entering pressures in the Environment window, changing any pressure from 
millibars to inches of Mercury will cause all pressures to be converted. For the 
Environment window, changing units without converting the values will cause the 
calculated height versus M-unit profile to become a whole new profile. By changing the 
units and converting the values, the profile remains the same. 

When values are converted, they may be rounded with a loss in 
precision. Converting the value again could compound the rounding error. 
Therefore, changing back to the original units may not convert the value 
back to its original value. USE THE CONVERT UTILITY WITH CARE. 

Initializing AREPS 

When starting AREPS for the 
first time, an initialization window, 
figure 1-4, opens showing the 
proposed AREPS folder structure. The 
DTED Terrain folder contains terrain 
data for your projects. The System 
database folder contains your EM 
system database file. 

Normally your database file 
will be in the AREPS main folder. 
However, you may want to have your 
database file reside on a removable 
disk so it may be kept in a secure 
location when AREPS is not in use. 

AREPS application folder Is - C\Prog,ram fllesVAreps 

CD-ROM drive |F 

DTED Terrain I Q\Program  iles\Areps\DTED 

System database | C:\Program files\Areps 

Projects |C\Program files\Areps\Projects 

Environments |C:\Program files\Areps\Emriro 

Automode |C:\Program files\Areps\AutoMode 

Security label 1 |Level 1 

Security labol 2 flLevel 2 

Socunty label 3    JLevcl 3 

i Corrtli8el:l Exit ' 

Browse...) 

Browse—| 

Browse...] 

:BrBwse..7| 

Browse...! 

Figure 1-4: Initialization window. 
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The Projects folder contains a number of subfolders for the projects you create. 
Each project becomes a subfolder of the Projects folder and contains all the necessary 
files to run and display your project in addition to any optional files you request for your 
project. 

The Environment folder contains all your environmental files and any terrain 
files you create. The Automode folder contains any Automode menus you create. 
Automode is not implemented in AREPS version 1.0. You may change the folder 
structure by typing new folder paths, or choose a folder name from the Change folder 
window opened by clicking on the Browse button. In addition, you may change the 
location of these folders on subsequent runs of the AREPS program by selecting Files 
and Folders from the Options menu. 

In addition to the proposed folder structure, the initialization window contains 
three input fields for your security definitions. AREPS allows you to label 
your data with four different security labels. For example, label 1 may be 
"My eyes only." Label 0 is predefined as "None" and may not be changed. It 

is your sole responsibility to adhere to the data security requirements dictated by higher 
authorities. This utility is strictly a convenient labeling feature and, as such, the AREPS 
developers assume no responsibility for unauthorized release of classified data or misuse 
of this feature. You may change the security labels on subsequent runs of the AREPS 
program by selecting Files and Folders from the Options menu. 

After you enter your security labels, 
and if the folder structure is acceptable (we 
recommend it), click on the Continue 
button to continue. The initialization 
information is stored in the program's mail 
folder under a binary file named areps. ini. 
You may not read or edit the file with an 
external text editor such as Notepad. If you 
delete the areps.ini file, it must be created 
again the next time you start AREPS. A 
title window, figure 1-5, providing support 
information now opens. At the top of the 
title window is the AREPS menu system. 
Clicking on any menu item clears the title 
graphic. 

\müMMmmhKmmi.mnmmmn.mm  

AREPS smim 
Advanced Refractive Effects    ^W 

Prediction System System Cajrter 
Sanßfego 

For information contact: 
Voice:   619-553-1424 
Fax:      619-553-1417 
Email: D883@spawar.navy.mil 

  

Figure 1-5: AREPS title window. 

Populating Your EM System Database 

If this is your first time running AREPS, you will want to populate your EM 
system database. There are three ways to populate the EM system database: enter each 
system individually from the menu system, import an EM system database created from 
the Radio Propagation Over Terrain (RPOT) program, or open an EM system database 
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provided by another agency.  U.S. military organizations may contact technical support 
for additional information about EM system parameters. 

►  To enter an individual EM system from the system menu. 

Follow these steps for each system you wish to enter into the database. For a 
detailed discussion of each EM system window, refer to chapter 5 (Project and EM 
Systems). 

Steps Comments 
Select Systems from the AREPS menu and then New Radar, 
Target, ESM, or Communication. A specialized data input 
window opens for each system. 

2 Enter the necessary data. 

3 Click the Save command button. A Save System window 
opens allowing you to enter a name for your newly created 
system. 

4 Should you choose to create another system with just a slight 
variation of data, you may edit the necessary fields and then 
select Save As item from the File menu. The Save/Open 
System window will open so you may enter a new name. 

5 When you are finished, click the Cancel command button or 
click the Close command button located in the window's 
upper right corner. 

► To import a RPOT database. 

BEI« 
FHe-i 

IÜ 

Click the File menu item to find a RPOT 3.0 database file. 
RPOT 3.0 database files are named RPOT300.MDB 

Close 

Figure 1-6: RPOT to AREPS database 
conversion utility. 

For the convenience of those 
who use our RPOT program, we 
provide a stand-alone utility program 
(RpotToAreps.exe) that will convert 
a RPOT 3.0 database into an AREPS 
database. The RPOT database is 
unaffected by the conversion, so it 
may still be used with the RPOT 
program. The program is installed 
into the AREPS main folder. 
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►        To run the RpotToAreps program 

Steps Comments 
1 Start the RpotToAreps.exe program as any other Windows 

program. 

2 Select the Open RPOT 3.0 database item from the File menu as 
shown in figure 1-6. 

3 Using the Open window, locate and open the RPOT database. If 
you use the RPOT default installation, its name and location is 
c: \Program Files\rpot\rpot300. mdb. 

4 Select the Save as AREPS 1.0 database item from the File 
menu. Then click the Close command button. By default, the 
database is saved in the AREPS main folder with a name of 
ArepsData.mdb. If you save it in a different folder, you must 
change the database folder by using the Folder and Drives items 
from the Options menu. If you save it under a different name, 
you must specifically open it by using the Open database item 
on the File menu. 

►  To open an EM system database from another agency. 

AREPS can use only one EM system database at a time. By default, the database 
filename is ArepsData.mdb and it is located in the AREPS main folder. 

Steps Comments 
1 Select Files from the AREPS menu and then Open 

Database. 

2 The Explorer window will open, allowing you to enter a file 
name. By default, the database file name is ArepsDatamdb 
but it may be named anything by the providing agency. 

3 Using the Explorer window controls, locate the desired 
database file and click the Open button. 

Entering the Current Atmosphere's Condition 

Prior to creating or executing a project, you need to create at least one height 
versus M-unit profile environment file.   Select Environments from the AREPS menu 
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fects Prediction Svstem 
BdiVfJUJili'iIdiUJ Options    Windows     Help  .  . 

j     New Environment               ►! ImportWMO Code 
Enter WMO Code Delete Environment Files 

My Own'Terrain File Enter Profile 

Refractive Summary Evaporation Duct 

. ; ' 1 Climatology 

..■•   1 To Be Determined 

and then choose one of the 
environmental data input methods 
as shown in figure 1-7. Refer to 
chapter 7 (The Environment) for a 
complete discussion on each input 
method. 

Figure 1-7: Environments menu. 

Creating and Running a Project 

Select either New Project or Open Project from the Files menu. A project 
window opens, allowing you to specify the radar, platform, target, ESM receiver, 
communications system, environment, location, bearing(s), and maximum range and 
height and axis display options. For a complete discussion of the project window, refer 
to chapter 5 (Project and EM System). 

After the project information is entered, click the Compute button. This action 
saves the current project information and begins computations. If the project requires 
terrain not previously copied from DTED CD-ROMs, you are asked to insert the 
appropriate DTED CD-ROMs into the CD drive. You may skip the CD-ROMs should 
they not be available, or you may select Terrain from the Options menu to specify the 
name of a file containing your own terrain data. If DTED terrain files are used, they are 
copied to the hard drive and a full-circle or wedge terrain map is (optionally) created. 
AREPS creates a terrain profile for each azimuth and then executes the Advance 
Propagation Model (APM) program to generate the appropriate coverage diagram. After 
all the diagrams are created, AREPS displays the coverage diagrams in sequence. Refer 
to chapter 9 (Decision Aids) for a further discussion of decision aid options and displays. 
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CONVENTIONS AND FILES 

Terms and Conventions 

Typographical Conventions 

Formatting convention Type of information  
Triangular bullet (► )      Step-by-step procedures. Complete the procedural 

instructions by using either the mouse or the 
keyboard. 

Bold type Words or characters you type or a menu item you 
select. For example, if the instructions are to type 
run setup, you type the lowercase letters "run" 
followed by a space and the lowercase letters 
"setup." 

Italic type Specialized terms, titles of books or manuals, or 
placeholders for items you must supply, such as a 
filename. For example, if the instructions are to type 
folder name, you type the name of the folder. 

Keyboard Conventions 

JWVWWVWJ 

All key names are in capital letters. For example, the Control key is CTRL 
and the Escape key is ESC. (The keys on your keyboard may not be 
labeled exactly as used here.) 

Keys Comments 
Shortcut keys Keys   frequently   used   in   combinations   or 

sequences as shortcut keys. For example, 
SHIFT+F1 means to hold down the SHIFT key 
while pressing the Fl key, and ALT, F, A means 
press and release each key in order. 

RETURN and ENTER These keys perform the same action in AREPS. 
In most cases, the ENTER key will move the 
focus from one data insertion point to another. It 
is not necessary to press the ENTER key, 
however, before you move to another item using 
the mouse. 
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 Keys   
Arrow keys (<-, T, -», -l), 
HOME, END, TAB, 
SHIFT TAB, PAGE UP, 
PAGE DOWN 

Comments 

Numeric keypad keys 

Many navigation keys may be used to move the 
focus to a data insertion point. Some keys may 
be used in combinations, such as the 
CTRL+HOME. Some key combinations, such as 
the SHIFT+t, are not available on all keyboards. 
In some cases, the arrow keys may cause an 
automatic update feature not to function 
correctly. If this should occur, use the mouse to 
select or move to an item. 

If you have an extended keyboard, you can type 
numbers with the numeric keypad if you first 
press the NUM LOCK key. 

Mouse Conventions 

ÖThe most efficient method of moving about within AREPS is by using a 
mouse. You can use a single or multiple-button mouse with AREPS. If you 
have a multiple-button mouse, the left mouse button is the primary mouse 
button. Any procedure that requires you to click the secondary button will 

refer to it as the "right mouse button." Using the center button of a three-button mouse 
may give unpredictable results. 

Term 
Point 

Click 

Double click 

Drag 

Comments 
Position the mouse pointer until the tip of the 
pointer rests on whatever you want to point to on 
the screen. 

Press and then immediately release the mouse 
button without moving the mouse. 

Click the mouse twice in rapid succession 
without moving the mouse. 

Click the mouse twice in rapid secession without 
moving the mouse. 

Data Input Point Illustrations 

AREPS uses a number of different controls to accept your inputs. These are: 
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Controls or input point names Illustration 
Command button. A command button 
performs the action stated on the button. The 
button may have a word or just an image. Left 
click on the button to cause the action to happen. 

Continue| 

Check box. To check or uncheck a box, left 
click on the box. The ENTER key will also 
"toggle" the check off and on. 

C This platform is mobile 

Dropdown menu. For some dropdown menu 
items, AREPS will perform automatic update 
functions for you. In these cases, an input field 
value may change. Be sure you have examined 
all input fields before proceeding with the 
program. 

Input field. You are required to type a value 
into an input field. A field label and units label 
is generally associated with an input field. The 
limits of an input field show in the left panel of 
the status bar. To change units, right click on 
the field label. 

OMNI Antenna type 

Project label  My Project Label 

Option button. Option buttons appear in a 
group. To select an option, left click on the 
option circle. The arrow keys will also move 
you between option buttons within the group. 
Selecting an option button deselects the other 
option buttons in the group. 

Tab. The tab is a way to organize and show 
many options within the same window. To 
move between tabs, left click on the tab's label. 

(? Radar detection only 

Import WHO Codef EnterWMQ Code]' 

Tabular form. The tabular form is just rows 
and columns of input fields (called cells). If you 
are in the last cell and press the ENTER key, a 
new row of cells will be added to the form. The 
label and units show at the top of each column. 
To change units for all entries in the column, 
right click on the label. 

Pattern Reduction 
Angle (dea) 

Pattern Reduction 
Factor 



16 

Program Files 

The distribution media of AREPS contains of a number of files that may or may 
not be used based upon your computer's operating system and how you choose to install 
AREPS. In addition to files provided on the distribution media, AREPS will create a 
number of files (some optional and some required) and may use files provided by other 
agencies. These files may be grouped into categories based upon how the files are used. 
So you may better understand how AREPS is structured and how AREPS will affect your 
disk space, the following file group discussion is provided. 

Permanent Program Files 

Permanent files are those that comprise the AREPS main program. These files 
reside in the AREPS main folder. 

File name File description 
AREPS.EXE The AREPS executable program. 

AREPS.INI Binary initialization file containing the folder 
structure and universal program options. You may 
not edit this file externally to AREPS. To change its 
contents, use the Options menu. 

AREPS.HLP 

AREPS.CNT 

AREPSDATA.MDB 

Stand-alone Windows AREPS on-line help. You 
may view the help by double clicking on the file 
name from the Explorer window. 

On-line help table of contents 

Microsoft Access Database of EM system 
parameters (created but not populated by AREPS if 
it doesn't exist.) 

AREPSDATA.LDB 

AREPS.DEP 

Microsoft   Access   Database   index   (Created   by 
Microsoft Database manager if it doesn't exist.) 

AREPS dependency file.     Used should AREPS 
require an update. Don't delete it. 

RPOTTOAREPS.EXE A  stand-alone  program  that  converts  a  RPOT 
database into an AREPS database. 

UNINST.ISU Install log used by Install Shield Uninstall utility. 
Don't delete it. 



Chapter 2: Conventions and Files 17 

File name 
APMLIB.DLL 

File description  
Advanced Propagation Model Dynamic Link 
Library. This file resides in the Windows/System 
folder. 

RSONDE.RSD Climatology radiosonde database. 

Sample Program Files 

When you install AREPS, you may also choose to install sample environment and 
project files. These files are located in their respective environment and project folders. 

File name File description 
ELEVATED DUCT.ENV 

SURFACE DUCT.ENV 

STANDARD.ENV 

RANGDEP.ENV 

Height versus M-unit profile for an 18,500-foot 
elevated ducting environment. 

Height versus M-unit profile for a 1000-foot 
surface-based ducting environment. 

Height versus M-unit profile for standard 
atmosphere environment. 

Range dependent environment with six height 
versus M-unit profiles. These profiles were 
measured from an aircraft flying a saw-tooth 
pattern from San Diego, CA, to Guadelupe Isle, 
Mexico. 

Folder name File description 
3D Surface Radar Project APM090.BMP, AREPS.INP, AREPS090.BIN, 

SURFACE DUCT.ENV, TERRAINMAP.BIN, 
TERRAINMAP.BMP, and TERRAINMAP.TXT, 
files necessary for the sample project. Refer to 
the created files discussion below for a description 
of each file. 

AEW Aircraft Project APM090.BMP, AREPS.INP, AREPS090.BIN, 
ELEVATED DUCT.ENV, TERRAINMAP.BIN, 
TERRAINMAP.BMP, and TERRAINMAP.TXT, 
files necessary for the sample project. Refer to 
the created files discussion below for a description 
of each file. 
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Folder name 
Radar and ESM Project 

File description 
APM090.BMP, AREPS.INP, AREPS090.BIN, 
SURFACE DUCT.ENV, TERRAINMAP.BIN, 
TERRAINMAP.BMP, and TERRAINMAP.TXT, 
files necessary for the sample project. Refer to 
the created files discussion below for a description 
of each file. 

UHF Communications 
Project 

APM090.BMP, AREPS.INP, AREPS090.BIN, 
SURFACE DUCT.ENV, TERRAINMAP.BIN, 
TERRAINMAP.BMP, and TERRAINMAP.TXT, 
files necessary for the sample project. Refer to 
the created files discussion below for a description 
of each file. 

AREPSDATA.MDB Microsoft   Access   Database   of   EM   system 
parameters for the systems in the sample projects. 

Created Program Files 

As the AREPS program executes, a number of files are created. Some of these 
are optional and if you choose, will automatically be removed prior to each project 
execution (see the Save/Edit tab from the Options menu). The first part of the file name 
is optional (defaults are shown). The second part of the file name is ddd where the ddd 
represents a bearing in whole degrees relative to true north. The file name extensions are 
fixed and you may not change them. AREPS will append the appropriate ddd and 
extension to all optional files even if you think you are including your own extension. 
For example, if you specify the name of a coverage decision aid's bitmap image as 
IMAGE.001. The created file will have the name IMAGE.001 ddd.BMP. These created 
files are: 

File name File Description 
AREPS.INP ASCII text file containing the necessary file names, EM 

system, and display parameters required by the particular 
project you are executing. While you may edit this file 
externally to AREPS, we don't recommend it. 

AREPSddd.BIN 

APMddd.BMP 

Binary  array  of propagation loss values  in  centibels. 
Optional file and is saved by default. 

Bitmap image of propagation loss values. Not an optional 
file and is always saved. You may not change the name. 
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File name 
AREPSddd.BMP 

EREPS.EBF 

TERRNddd.TER 

AREPSddd.TXT 

TERRAINMAP.BIN 

TERRAINMAP.BMP 

File Description 

TERRAINMAP.TXT 

Bitmap image of coverage decision aid. Optional file and is 
not saved by default. 

Propagation loss data saved in EREPS binary format. 
Optional file and is not saved by default. 

Terrain file. This file may be the one you create using the 
terrain window, or it may be the file created by AREPS 
when the DTED CD-ROM data are read. Refer to terrain 
file names for addition information about file name 
conventions. 

ASCII text file of propagation loss values. Optional file 
and is not saved by default. 

Integer array of heights. Assuming you requested a terrain 
map, not an optional file and is always saved. You may 
not change the name. 

Bitmap image of terrain map. Assuming you requested a 
terrain map, not an optional file and is always saved. You 
do have the option to recreate this image if your project's 
location changes. You may not change the name. 

Information used to generate TERRAIN.BMP file. 
Assuming you requested a terrain map, not an optional file 
and is always saved. You may not change the name. 

Technical Support Files 

Under a technical support option exercised by the support personnel, AREPS 
creates a number of investigation files. Unless you receive specific technical support for 
AREPS, you will not have these files. These files reside in the AREPS main folder. 

File name File description 
APMDUMP.DMP ASCII listing of all variables in APMLIB.DLL 

AREPSDEBUG.LOG Listing of AREPS activities 

ARDUMP.DMP ASCII listing of EM system database 

ANYDBASE.DAT ASCII listing of any general database 
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Installation Files 

The Install Shield installation utility requires a number of instructional files. 
While these files exist on the distribution media, they are not part of the AREPS program 
and will not be copied into your computer's system folder. 

File name 
_INST32I.EXE 
SYS1.CAB 
DATA.TAG 
LAYOUT.BIN 
SETUP.EXE 
SETUP.LID 

JSDEL.EXE 
JUSER1.CAB 
DATA1.CAB 
OS.DAT 
SETUP.INI 
STDOLE2.TBL 

_SETUP.DLL 
DA02535.TBL 
LANG.DAT 
SETUP.BMP 
SETUP.INS 

Third-Party and Windows Support Files 

When AREPS installs itself, a number of files are installed to your 
System subfolder. These files are dependent upon which operating system 
you are using. Should you need to remove the AREPS program, we highly 
recommend you use the Add/Remove program icon found in the Control 
Panel and let the Install Shield uninstall program remove AREPS for you. 

Some system files may be needed by other programs. The Install Shield 
/' | \     uninstall program will alert you as to which files these are and will ask for your 

permission to remove them. If in doubt, it is best to just leave these files in 
place. The following is a complete list of support files provided in the AREPS package. 

File name File description 
ASYCFILT.DLL Microsoft Object Linking and Embedding Library 2.20 for 

Windows NT and Windows 95 Operating Systems - version 
2.20.4118 

AXDIST.EXE Microsoft Win32 Cabinet Self-Extractor - version 
4.71.0030.1 

COMCAT.DLL Microsoft Component Category Manager Library - version 
4.71 

COMCTL32.0CX       Windows Common Controls ActiveX Control DLL - version 
5.01.4319 

COMDLG32.0CX       Microsoft Common Dialog ActiveX Control DLL - version 
5.01.4319 

CTL3D32.DLL Microsoft 3D Windows Controls - version 2.31.000 
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File name File description 
DAO350.DLL 

DFORRT.DLL 

INETWH16.DLL 

INETWH32.DLL 

MSEXCL35.DLL 

MSINET.OCX 

MSJET35.DLL 

MSJINT35.DLL 

MSLTUS35.DLL 

MSPDOX35.DLL 

MSRD2x35.DLL 

Microsoft Data Access Object Library - version 3.50.3602.0 

DEC Fortran Support file 

Adds Internet access to help using HC31/HCP help compiler. 

Adds Internet access to help using HCW help compiler. 

Microsoft Jet Excel ISAM - version 3.50.3602.5 

Microsoft Internet Transfer Control - version 5.01.4511 

Microsoft Jet Engine Library - version 3.51.0623.4 

Microsoft Jet Database Engine International - version 
3.50.3602.5 

MSJTER35.DLL Microsoft Jet Database Engine Error Library - version 
3.50.3602.0 

Microsoft Jet Lotus 1-2-3 Isam - version 3.50.3602.5 

Microsoft Jet Paradox ISAM - version 3.50.3602.0 

Microsoft RED ISAM - version 3.50.3602.0 

MSREPL35.DLL Microsoft Replication Library - version 3.51.0623.0 

MSTEXT35.DLL        Microsoft Jet Text Isam - version 3.50.3602.0 

MSVBVM50.DLL 

MSVCRT.DLL 

MSVCRT40.DLL 

MSXBSE35.DLL 

Visual Basic Virtual Machine - version 05.00.4319 (SP2) 

Microsoft C Runtime Library - version 5.00.7022 

Microsoft C Runtime Library - version 4.10.6038 

Microsoft Jet xBase Isam - version 3.50.3602.0 

OLEAUT32.DLL        Microsoft OLE 2.20 for Windows NT(TM) and Windows 
95(TM) Operating Systems - version 2.20.4118 

OLEPR032.DLL Microsoft (R) OLE Property Support - version 5.0.4118 

SETBROWSE.EXE     Utility program to specify an Internet browser. 
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File name File description 
SS32x25.0CX 

TABCTL32.0CX 

VBAJET32.DLL 

VBAR332.DLL 

WINT351.EXE 

FarPoint Technologies, Inc. Spreadsheet Control - version 
2.5.020 

Microsoft Tabbed Dialog OLE Control - version 5.01.4319 

Microsoft Visual Basic Application Development 
Environment Expression Service Loader - version 5.0.7122 

Visual Basic for Applications Runtime Expression Service - 
version 3.0.6908 

Win32 Cabinet Self-Extractor for NT 3.51 - version 
4.71.0030.1 
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THE EARTH'S ATMOSPHERE 

Structure and Characteristics 

The earth's atmosphere is a collection of many gases together with suspended 
particles of liquids and solids. Excluding variable components such as water vapor, 
ozone, sulfur dioxide, and dust, the gases of nitrogen and oxygen occupy about 99 
percent of the volume, with argon and carbon dioxide being the next two most abundant 
gases. From the earth's surface to an altitude of approximately 80 kilometers, 
mechanical mixing of the atmosphere by heat-driven air currents evenly distributes the 
components of the atmosphere. At about 80 kilometers, the mixing decreases to the point 
where the gases tend to stratify in accordance with their weights. 

The lower, well-mixed portion of the atmosphere is called the homosphere, while 
the higher, stratified portion is called the heterosphere. The bottom portion of the 
homosphere is called the troposphere. 

The troposphere extends from the earth's surface to an altitude of 8 to 10 
kilometers at polar latitudes, 10 to 12 kilometers at middle latitudes, and up to 18 
kilometers at the equator. It is characterized by a temperature decrease with height. The 
point at which the temperature ceases to decrease with height is known as the tropopause. 
The average vertical temperature gradient of the troposphere varies between 6 and 7 
degrees Celsius per kilometer. 

The concentrations of gas components of the troposphere vary little with height, 
except for water vapor. The water vapor content of the troposphere comes from 
evaporation of water from oceans, lakes, rivers, and other water reservoirs. Differential 
heating of land and ocean surfaces produces vertical and horizontal wind circulations that 
distribute the water vapor throughout the troposphere. The water vapor content of the 
troposphere rapidly decreases with height. At an altitude of 1.5 kilometers, the water 
vapor content is approximately half of the surface content. At the tropopause, the content 
is only a few thousandths of what it is at the surface. 

In 1925, the International Commission for Aeronavigation defined the 
international standard atmosphere. This is a hypothetical atmosphere having an 
arbitrarily selected set of pressure and temperature characteristics that reflect an average 
condition of the real atmosphere. 

Refraction 

Index of Refraction 

The term refraction refers to the property of a medium to bend an electromagnetic 
wave as it passes through the medium. A measure of the amount of refraction is the 
index of refraction, n, defined as the velocity, c, of propagation in free space (away from 
the influence of the earth or other objects) to the velocity, v, in the medium. This is 
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n = ~. (1) 
v 

Refractivity and Modified Refractivity 

The normal value of the refractive index, n, for the atmosphere near the earth's 
surface varies between 1.000250 and 1.000400. For studies of propagation, the index of 
refraction is not a very convenient number, therefore a scaled index of refraction, N, 
called refractivity, has been defined. At microwave frequencies and below, the 
relationship between the index of refraction n and refractivity N for air that contains 
water vapor is given as 

„.(„-Dtf-Z^i^ , (2) 

where es is the partial pressure of water vapor in millibars or 

rh 6.105 ex 
e<!   =          > (3) 

100 

„c„r-273.2    „1t      f   T   \ 
x = 25.22 53 Hog.      , (4) 

T \2732J 
p =    atmosphere's barometric pressure in millibars, 
T =    atmosphere's absolute temperature in Kelvin, and 
rh =   atmosphere's relative humidity in percent. 

Thus, the atmospheric refractivity near the earth's surface would normally vary between 
250 and 400 TV-units. 

Since the barometric pressure and water vapor content of the atmosphere decrease 
rapidly with height while the temperature decreases slowly with height, the index of 
refraction, and therefore refractivity, normally decreases with increasing altitude. 

As a tool in examining refractive gradients and their effect upon propagation, a 
modified refractivity, defined as 

M =   N + 0.157 h for altitude h in meters and (5) 

M =   N+ 0.048 h for altitude h in feet, (6) 

is often used in place of the refractivity. 
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Effective Earth Radius 

In free space, an EM wave will travel in a straight line because the index of 
refraction is the same everywhere. Within the earth's atmosphere, however, the velocity 
of the wave is less than that of free space, and the index of refraction normally decreases 
with increasing altitude. Therefore, the propagating wave will be bent downward from a 
straight line. It is convenient to compute refractive effects in terms of waves traveling in 
straight lines. Replacing the actual earth's radius with an effective earth radius and 
replacing the actual atmosphere may approximate this by one that is homogeneous in 
nature. 

The effective earth radius factor, k, is defined as 

k = 
1 1 

Wa^UlO^) ' 
dz ) 

(7) 

where — and are the N and M gradients, respectively, and z is in the same units as 
dz dz 

a.   The mean earth radius is generally taken to be 637HO6 meters.   For standard 

refractive conditions where — = -0.039JV-units per meter or  = 0.118 M-units per 
dz dz 

meter, k = 133 or four-thirds. 

Refractive Conditions 

SUBREFRACTION 

Figure 3-1 illustrates the four 
refractive conditions as discussed 
below. 

Standard and Normal Conditions 

The     refractivity     distribution 
within  the  atmosphere   is  nearly  an 
exponential function of height.     The 
exponential decrease of N with height 
close to the earth's surface (within 1 
kilometer)    is    sufficiently    regular, 

however, to allow an approximation of the exponential function by a linear function. 
This linear function is known as a standard gradient and is characterized by a decrease of 
39 JV-units per kilometer or an increase of 118 M-units per kilometer.   A standard 

Figure 3-1: Refractive conditions. 
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gradient will cause traveling EM waves to bend downward from a straight line. Gradients 
that cause effects similar to a standard gradient but vary between 0 and -79 iV-units per 
kilometer or between 79 and 157 M-units per kilometer are known as normal gradients. 

Subrefractive Conditions 

If the motions of the atmosphere produce a situation where the temperature and 
humidity distribution create an increasing value of N with height, the wave path would 
actually bend upward and the energy would travel away from the earth. This is termed 
subrefraction. Although this situation occurs infrequently in nature, it still must be 
considered when assessing electromagnetic systems' performance. 

Superrefractive Conditions 

If the troposphere's temperature increases with height (temperature inversion) 
and/or the water vapor content decreases rapidly with height, the refractivity gradient will 
decrease from the standard. The propagating wave will be bent downward from a 
straight line more than normal. As the refractivity gradient continues to decrease, the 
radius of curvature for the wave path will approach the radius of curvature for the earth. 
The refractivity gradient for which the two radii of curvature are equal is referred to as 
the critical gradient. At the critical gradient, the wave will propagate at a fixed height 
above the ground and will travel parallel to the earth's surface. Refraction between the 
normal and critical gradients is known as superrefraction. 

Trapping Conditions 

Should the refractivity gradient decrease beyond the critical gradient, the radius of 
curvature for the wave will become smaller than the earth's curvature. The wave will 
either strike the earth and undergo surface reflection, or enter a region of standard 
refraction and be refracted back upward, only to reenter the area of refractivity gradient 
that causes downward refraction. This refractive condition is called trapping because the 
wave is confined to a narrow region of the troposphere. The common term for this 
confinement region is a tropospheric duct or a tropospheric waveguide. It should be 
noted that a tropospheric waveguide is not a waveguide in the true sense of the word 
because there are no rigid walls that prevent the escape of energy from the guide. 

The refractivity gradients and their associated refractive conditions are 
summarized in table 3-1. 

Table 3-1: Refractive gradients and conditions. 
Condition JV-Gradient M-Gradient 

Trapping <-157iV/kmor<  48iV/kft < 0 M/km or < 0 M/kft 
Superrefraction -157 to - 79 TV/km or -48 to -24 JV/kft 0  to  79 M/km or 0 to24Mkft 
Normal -79 to    OMkm or-24 to   OiV/kft 79 to 157 M/km or 24 to 48 M/kft 
Standard -39iV7km 118 M/km 
Subrefraction > OMkm or > OJV/kft > 157 M/km or > 48 M/kft 
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Atmospheric Ducts 

A duct is a channel in which electromagnetic energy can propagate over great 
ranges. To propagate energy within a duct, the angle the electromagnetic system's 
energy makes with the duct must be small, usually less than 1 degree. Thicker ducts in 
general can support trapping for lower frequencies. The vertical distribution of 
refractivity for a given situation must be considered as well as the geometrical 
relationship of transmitter and receiver to the duct in order to assess the duct's effect at 
any particular frequency. 

Ducts not only give extended 
radar detection or ESM intercept 
ranges for systems within the duct, 
they may also have a dramatic effect 
upon transmitter/receiver systems 
that transcend duct boundaries. For 
example, an air target that would 
normally be detected may be missed 
if the radar is within or just above the 
duct and the target is just above the 
duct. This area of reduced coverage 
is known as a radar hole or shadow 
zone. These ducting consequences 
are illustrated in figure 3-2. 

Figure 3-2: Ducting consequences. 

Although the duct acts like a waveguide for the energy, this waveguide does not 
have rigid and impenetrable boundaries, except for the earth's surface in cases where the 
duct's bottom lies at the surface. Therefore, energy is continually leaking from the duct. 
While the energy level within a radar hole may be insufficient for radar detection, it may 
be sufficient for ESM intercept of the radar. 

In a discussion of ducting conditions upon EM wave propagation, the usual 
concern is propagation beyond the normal horizon. Within the horizon, however, ducting 
also has an effect. Ducting can alter the normal lobe pattern caused by the interference of 
the direct ray and the surface-reflected ray. The relative phase between the direct and 
reflected path may be changed as well as the relative amplitudes of the two rays. The 
effect of the duct on the line-of-sight propagation is to reduce the angle of the lowest 
lobe, bringing it closer to the surface. 

Several meteorological conditions will lead to the creation of ducts. Where these 
conditions exist and what these conditions are will determine the name and nature of the 
duct. 
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Surface Ducts 

If the meteorological conditions 
cause a trapping layer to occur, such that the 
base of the resultant duct is at the earth's 
surface, a surface duct is formed. There are 
three types of surface ducts based on the 
trapping layer's relationship to the earth's 
surface. The first type is a surface duct 
created from a surface-based trapping layer. 
This duct is referred to as a surface duct and 
is illustrated in figure 3-3. The second type 
of surface duct is created from an elevated 
trapping layer. This duct is commonly 
referred to as a surface-based duct and is 
illustrated in figure 3-4. The third type of surface duct is one created by a rapid decrease 
of relative humidity immediately adjacent to the air-sea interface. This duct is referred to 
as an evaporation duct. Because the evaporation duct is of great importance for over- 
water EM propagation, it warrants a detailed discussion. This discussion appears in its 
own section below. 

Surface 

Duct 

Modified Refractivity 

Figure 3-3: Surface duct. 

2> Trapping Layer 

_   Surface-based 

Duct 

Surface-based ducts occur when 
the air aloft is exceptionally warm and 
dry compared with the air at the earth's 
surface. Several        meteorological 
conditions may lead to the formation of 
surface-based ducts. 

Modified Refractivity 

Figure 3-4: Surface-based duct. 

Over the ocean and near land 
masses, warm, dry continental air may be 
advected over the cooler water surface. 
Examples of this type of advection are the 
Santa Ana of southern California, the 

Sirocco of the southern Mediterranean, and the Shamal of the Persian Gulf. This 
advection will lead to a temperature inversion at the surface. In addition, moisture is 
added to the air by evaporation, producing a moisture gradient to strengthen the trapping 
gradient. This type of meteorological condition routinely leads to a surface duct created 
by a surface-based trapping condition. However, as you travel from the coastal 
environment into the open ocean, this trapping layer may well rise from the surface, 
thereby creating the surface-based duct. Surface-based ducts tend to be on the leeward 
side of land masses and may occur both during the day or at night. In addition, surface- 
based ducts may extend over the ocean for several hundred kilometers and may be very 
persistent (lasting for days). 

Another method of producing surface-based ducting conditions is by divergence 
(spreading out) of relatively cool air under a thunderstorm. While this method may not 
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be as frequent as the other methods, it may still enhance surface propagation during the 
thunderstorm activity, usually on the order of a few hours. 

With the exception of thunderstorm conditions, surface-based ducting is 
associated with fair weather, with increased occurrence of surface-based ducts during the 
warmer months and in more equatorial latitudes. Any time the troposphere is well- 
mixed, such as with frontal activity or with high wind conditions, surface-based ducting 
is decreased. 

An interesting feature of surface-based ducts is the skip zone near the normal 
horizon, in which the duct has no influence. This skip zone is easily illustrated using 
AREPS (see chapter 10, hardware maintenance tactical application for an illustration) or 
a raytrace program such as RAYS within the EREPS suite of software programs. It 
should be noted that the surface duct created from a surface-based trapping layer does not 
have this skip zone phenomenon. 

Evaporation Ducts 

As can be seen from the equation for refractivity, a change in the moisture 
distribution without an accompanying temperature change can also lead to a trapping 
refractivity gradient. The air in contact with the ocean's surface is saturated with water 
vapor. A few meters above the surface the air is not usually saturated, so there is a 
decrease of water vapor pressure from the surface to some value well above the surface. 
The rapid decrease of water vapor initially causes the modified refractivity, M, to 
decrease with height, but at greater heights the water vapor distribution will cause M to 
reach a minimum and, thereafter, increase with height. The height at which M reaches a 
minimum is called the evaporation duct height as illustrated in figure 3-5. 

Evaporation ducts exist over the 
ocean, to some degree, almost all of the 
time. The duct height varies from a meter 
or two in northern latitudes during winter 
nights to as much as 40 meters in 
equatorial latitudes during summer days. 
On a world average, the evaporation duct 
height is approximately 13 meters. It 
should be emphasized that the evaporation 
duct "height" is not a height below which 
an antenna must be located in order to have 
extended propagation but a value that 
relates to the duct's strength or its ability to 
trap radiation. The duct strength is also a 
function of wind velocity. For unstable 
atmospheric   conditions,   stronger   winds 

generally result in stronger signal strengths (or less propagation loss) than do weaker 
winds. 

_ Evaporation 

Duct 

Modified Refractivity 

Figure 3-5: Evaporation duct. 



30 

Since the evaporation duct is much weaker than the surface-based duct, its ability 
to trap energy is highly dependent on frequency. Generally, the evaporation duct is only 
strong enough to affect electromagnetic systems above 3000 MHz. 

Assessment of the evaporation duct is best performed by making surface 
meteorological measurements and inferring the duct height from the meteorological 
processes occurring at the air/sea interface. The evaporation duct height cannot be 
measured using a radiosonde, rocketsonde, or a microwave refractometer. With the 
advent of newer, high-resolution sondes that may be lowered to the surface from a ship, 
the impression is given that the evaporation duct may be measured directly. For practical 
applications, however, this impression is false and a direct measurement should not be 
attempted. Due to the turbulent nature of the troposphere at the ocean surface, a 
refractivity profile measured at one time would most likely not be the same as one 
measured at another time, even when the two measurements are seconds apart. 
Therefore, any measured profile would not be representative of the average evaporation 
ducting conditions, the conditions that an assessment system must consider. 

The long-term statistical frequency distribution of worldwide evaporation ducts is 
readily available through our EREPS Surface Duct Summary (SDS) program or our 
Ducting Climatology Summary (DCS) program. Both of these programs may be 
obtained from our Internet homepage. 

Elevated Ducts 

Trapping Layer 

Elevated 

Duct 

If meteorological conditions cause a 
trapping layer to occur aloft, such that the 
base of the duct occurs above the earth's 
surface, the duct is referred to as an 
elevated duct as illustrated in figure 3-6. 

Great semipermanent surface high- 
pressure systems, centered at 
approximately 30 degrees north and south 
latitude, cover the ocean areas of the world. 
Poleward of these systems lay the mid- 
latitude westerly winds and, equatorward, 
the tropical easterlies or the tradewinds. 
Within these high-pressure systems, large- 
scale subsidence of air causes heating as 
the air undergoes compression.  This leads 

to a layer of warm, dry air overlaying a cool, moist layer of air (often called the marine 
boundary layer). 

The resultant inversion is referred to as the tradewind inversion and may create a 
strong ducting condition at the top of the marine boundary layer. Elevated ducts may 
vary from a few hundred meters above the surface at the eastern part of the tropical 

Modified Refractivity 

Figure 3-6: Elevated duct. 
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oceans to several thousand meters at the western part. For example, along the southern 
California coast, elevated ducts occur an average of 40 percent of the time, with an 
average top elevation of 600 meters. Along the coast of Japan, elevated ducts occur an 
average of 10 percent of the time, with an average top elevation of 1500 meters. 

It should be noted that the meteorological conditions necessary for a surface- 
based duct are the same as those for an elevated duct. In fact, a surface-based duct may 
slope upward to become an elevated duct as warm, dry continental air glides over cool, 
moist marine air. The tradewind inversion may also intensify, thereby turning an 
elevated duct into a surface-based duct. 

Standard Wave Propagation 

Propagation Loss and Signal-to-Noise Ratio 

AREPS may present its results in terms of propagation loss or radar signal-to- 
noise ratio. The definitions of each term as used by AREPS is: 

Propagation loss: The ratio, expressed in decibels, of the effective radiated power 
transmitted in the direction of maximum radiation of the antenna pattern to the power 
received at any point by an omnidirectional antenna. Widely used definitions of path loss 
are based on omnidirectional antennas. In AREPS, propagation loss is equivalent to path 
loss when an omnidirectional antenna is specified. Propagation loss is closely related to 
many definitions of transmission loss. Transmission loss generally includes effects from 
both an antenna pattern and the absolute gain of the antenna, whereas propagation loss 
only includes the pattern effects with the gain normalized to 1 (i.e., 0 dB) in the direction 
of maximum transmission. Therefore, propagation loss would be equal to transmission 
loss plus the antenna gain in decibels. 

Signal-to-noise ratio: The ratio, expressed in decibels, of the signal received at the 
input of the radar receiver to the noise generated within the receiver itself. For AREPS, 
the signal level is based upon the reflection from a target of specified radar cross-section, 
all the engineering parameters of the radar, and the applicable propagation factors. 

Standard Propagation 

Standard propagation mechanisms are those mechanisms and processes that occur 
in the presence of a standard atmosphere. These propagation mechanisms are free-space 
propagation, optical interference (or surface reflection), diffraction, and tropospheric 
scatter. 

Free-space Propagation 

The simplest case of electromagnetic wave propagation is the transmission of a 
wave between a transmitter and a receiver in free space. Free space is defined as a region 
whose properties  are isotropic, homogeneous,  and loss-free,  i.e.,  away  from the 
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influences of the earth's atmosphere.   In free space, the electromagnetic wave front 
spreads uniformly in all directions from the transmitter. 

Optical Interference and Surface Reflection 

When an electromagnetic wave 
strikes a nearly smooth large surface, 
such as the ocean, a portion of the energy 
is   reflected   from   the    surface    and 

Direct paft^^Reflected patfa continues propagating along a path that 
makes an angle with the surface equal to 
that of the incident wave as illustrated in 
figure 3-7. 

The strength of the reflected wave 
Figure 3-7: Surface reflection. is     determined     by     the     reflection 

coefficient, a value that depends upon the 
frequency and polarization of radiation, the angle of incidence, and the roughness of the 
reflecting surface. 

For shallow incidence angles and smooth seas, typical values of the reflection 
coefficient are near unity (i.e., the reflected wave is almost as strong as the incidence 
wave). As the wind speed increases, the ocean surface grows rougher and the reflection 
coefficient decreases. For a transmitter near the surface, the reflection process results in 
two paths to a receiver within the line of sight. 

As stated above, upon reflection, a portion of the energy is propagated in the 
direction of initial wave motion. A portion of energy is also reflected backward toward 
the transmitter. This backward reflected energy is also received by the radar and may 
interfere with the radar's ability to distinguish a desired target. This backward reflected 
energy is called clutter. 

Not only is the magnitude of the reflected wave reduced, but the phase of the 
wave is also altered. For horizontally or vertically polarized waves at low grazing angles, 
the phase change upon reflection is approximately 180 degrees. Whenever two or more 
wave trains traveling over different paths intersect at a point in space, they are said to 
interfere. If two waves arrive at the same point in phase, they constructively interfere and 
the electric field strength is greater than either of the two component waves taken alone. 
If the two waves arrive together out of phase, they destructively interfere, and the 
resultant field strength is weakened. 

As the geometry of the transmitter and receiver change, the relative lengths of the 
direct path and reflected path also change, which results in the direct and reflected wave 
arriving at the receiver in varying amounts of phase difference. The received signal 
strength, which is the vector sum of the signal strengths of the direct and reflected wave, 
may vary up to 6 dB above and 20 dB or more below the free-space value. 
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Diffraction 

Energy tends to follow along the curved surface of an object. Diffraction is the 
process by which the direction of propagating radiation is changed so that it spreads into 
the geometric shadow region of an opaque or refractive object that lies in the radiation 
field. In the earth-atmosphere system, diffraction occurs where the straight-line distance 
between the transmitter and receiver is just tangent to the earth's surface. For a 
homogeneous atmosphere, this point of tangency with the earth is referred to as the 
geometrical horizon. For an inhomogeneous atmosphere (using an effective earth radius) 
and at radar and optical frequencies, this point of tangency is referred to as the radar and 
optical horizon, respectively. 

The ability of the electromagnetic wave to propagate beyond the horizon by 
diffraction is highly dependent upon frequency. The lower the frequency, the more the 
wave is diffracted. At radar frequencies, the wavelength is small when compared to the 
earth's dimensions, and little energy is diffracted. At optical frequencies or very short 
radar wavelengths, the optical horizon represents the approximate boundary between 
regions of propagation and no propagation. 

Tropospheric Scatter 

At ranges far beyond the horizon, the propagation loss is dominated by 
troposcatter. Propagation in the troposcatter region is the result of scattering by small 
inhomogeneities within the atmosphere's refractive structure. 

Anomalous Propagation Mechanisms 

A deviation from the normal atmospheric refractivity leads to conditions of 
subrefraction, superrefraction, and trapping as explained earlier. The term anomalous 
propagation or nonstandard propagation applies to the above listed conditions, but it is 
most often used when describing those conditions that lead to radar ranges less than or 
greater than the normal. 

Subrefractive Layers 

A subrefractive layer of the troposphere would cause the propagating energy to 
bend upward or away from the earth's surface, thereby leading to decreased detection 
ranges and shortened radio horizons. Altitude errors for height-finding radars will also 
become evident in a subrefractive environment. 

Subrefractive layers may be found at the earth's surface or aloft. In areas where 
the surface temperature is greater than 30 degrees Celsius, and relative humidities are less 
than 40 percent (i.e., large desert and steppe regions), solar heating will produce a very 
nearly homogeneous surface layer, often several hundreds of meters thick. Since this 
layer is unstable, the resultant convective processes tend to concentrate any available 
moisture near the top of the layer. This in turn creates a positive N gradient or 
subrefractive stratum aloft. This layer may retain its subrefractive nature into the early 
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evening hours, especially if a radiation inversion develops, trapping the water vapor 
between two stable layers. 

For areas with surface temperatures between 10 and 30 degrees Celsius and 
relative humidities above 60 percent, i.e., the western Mediterranean, Red Sea, 
Indonesian Southwest Pacific, etc., surface-based subrefractive layers may develop 
during the night and early morning hours. It is characteristically caused by advection of 
warm, moist air over a relatively cooler and drier surface. While the N gradient is 
generally more intense than that described above, the layer is often not as thick. Similar 
conditions may also be found in regions of warm frontal activity. 

Superrefractive Layers 

Superrefractive conditions are largely associated with temperature and humidity 
variations near the earth's surface. Inversions aloft, due to large-scale subsidence will 
lead to superrefractive layers aloft. Superrefractive layers will lead to an increase of 
radar detection ranges and extensions of the radio horizon. 

The effects of a superrefractive layer upon a surface-based system are directly 
related to its height above the earth's surface. For airborne systems, the effects of a 
superrefractive layer depend upon the position of the transmitter and receiver relative to 
the layer. Both of these factors are related to the electromagnetic wave's angle of layer 
penetration. The steeper the penetration angle, the less of an effect the layer will have 
upon propagation. 

Trapping Layers 

Trapping is an extension of superrefraction because the meteorological conditions 
for both are the same. While the usual concern is propagation beyond the normal 
horizon, trapping within the horizon also has an effect. Trapping can alter the normal 
lobe pattern caused by the interference of energy arriving at a point by the direct path and 
surface-reflected path. The relative phase between the direct and reflected paths may be 
changed as well as the amplitudes. The effect on the line-of-sight propagation is to 
reduce the angle of the lowest lobe, bringing it closer to the surface. 
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AREPS MENUS 

Navigation in the AREPS program is performed with the menu system. Menus 
may be static and located in bars across the top of a window or may be variable and 
activated from right clicking on an input control or the window's background. Menu 
items may be represented by text or by icons. A menu item may be selected either by 
highlighting it with an arrow key or by left mouse clicking it. 

F* AREPS - Advanced Refractive Effects Prediction System i@i 
File    Edit   View    Systams    Environments    Options    Windows    Help 

Figure 4-1: AREPS main menu. 

AREPS Main Menu 

The AREPS main menu, figure 4-1, is located across the top of the main window. 
Its items control all the AREPS functionality such as creating decision aids, editing data 
input, viewing toolbars, performing EM system database management functions, creating 
and displaying environmental data, setting program options, arranging the AREPS 
windows and obtaining help. 

File Menu 

¥4 AREPS - Advanced Refractive Effects F 
Edit    View    Systems    Envirc 

New Project Ctrl+N 
Open/Remove Project Ctrl+O 

Close Terrain 

Save Terrain 

Save Terrain £s. 

Open Database 

Save Database As. 

Print Terrain 

Print Setup 

1 3D Surface Radar 

IÜI 

The File menu, figure 4-2, is the starting point 
for an AREPS project. Projects may be created 
or previously created projects opened or 
removed with the File menu. 

The File menu serves as the Close, 
Save, and Print point for any active window. 
For example, if the currently active window is a 
terrain window, the File menu wording will 
change to Close Terrain, Save Terrain, and 
Print Terrain. Likewise, if the currently active 
window is a radar window, the File menu 
wording will change to Close Radar, Save 
Radar, and Print Radar. 

All of your EM system parameters are 
stored in the Microsoft Access database file 
format.   The File menu allows you create and 

Figure 4-2: File menu, 

manage numerous databases for your particular application.   For example, prior to the 
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deployment of a battle group, you may want to create a database of all the EM systems 
found within the battle group. You may then save this database on a floppy diskette for 
later use when the battle group is operating in theater. 

The File menu contains a listing of up to four of the last projects you had opened. 
To reopen one of these projects, either highlight its name with a navigation key and press 
the ENTER key or just click on its name. 

To close the AREPS program, select the Exit menu item. 

Edit Menu 

The Edit menu, figure 4-3, contains all 
the editing commands for all input fields or 
tabular forms. You may Cut, Delete, Copy, and 
Paste data with this menu. Any of these 
commands may also be undone with the Undo 
item. The menu items will be active or inactive, 
based upon which operation is possible. For 
example, the Insert terrain range and Remove 
terrain range menu items are active only when 
the tabular form in the terrain window has the 
focus. 

'3 - Advanced Refractive Effects Free 

E     -iew Systems Env/ironrt 

Undo Or'*Z 

Cut Ctrl.+X 

Copy Ctrl+C 

Paste Ctrl+V 
Delete 

Insert terrain range 
Remove terrain range 

Figure 4-3: Edit menu. 

View Menu 

advanced Refractive Effects Predii 

Systems    Environrm 

v Status Bar | 

* EnvironmentToolbar      I 

The View menu, figure 4-4, allows you to make visible or 
invisible, toolbars and status bars. The check mark 
indicates the particular item is visible. 

Figure 4-4: View menu. 

Systems Menu 

The Systems menu, figure 4-5, allows you to 
perform database management functions for your 
Platforms, EM systems, and Targets. You may 
create a New item, Open an item for editing, or 
Remove an item from the database. 

i Refractive Effects Prediction System 
Systems Environments    Options    Wi 

Open/Remove Platform *.        '■• 

NewRadar 
Open/Remove.B&der 1 

New Communications ■.. j 

Open/Remove Communications j 

New Target 
Open/Remove I&rget 

NewESM      .. 
Open/Remove £SM 

Figure 4-5: Systems menu. 
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Environments Menu 

iffects Prediction Svstem 

HI Options    Window's    Help 
|     New Environment              ► 1 import WMO Code 

Enter WMO Code Delete Environment Files 
My Own Terrain File Enter Profile 
Refractive Summary Evaporation Dud 

'-.'   1 Climatology 

•    1 Io Be Determined 

Figure 4-6: Environments menu. 

The Environments 
menu, figure 4-6, is the entry 
point for creating new 
environmental input files, 
deleting environmental input 
files, creating your own terrain 
files, or displaying the contents 
of an environmental file using 
the refractive summary display. 
Environmental and terrain files 
are ASCII text files and may 
also be created externally to the 
AREPS program. 

Currently, the only way to create a range and bearing dependent environmental 
file is to do it externally to the AREPS program. Refer to chapter 7 (The Environment) 
for the file conventions used in creating an environmental file externally to AREPS. 

Windows Menu 

Use the Windows menu, figure 4-7, to specify how you 
want the AREPS windows to appear on your screen. In addition 
to appearance options, a list of all the currently opened windows 
is maintained. The check mark indicates which window is 
currently active. If you have many windows open at the same 
time, you may also use the Close All menu item to close them 
all at once. 

Windows Help 
Tile Horizontally 

Tile Vertically 

Cascade 
Clu«=eM,| 

Figure 4-7: Windows menu. 

Help Menu 

Contents 
Getting Started 

- Qbtain Technical Support 
I UpöQtG Antro SOftWör© 

About AREPS 

Use the Help menu, figure 4-8, to access the on- 
line help with the Contents item. The on-line help is 
also a stand-alone Windows 95/NT help file. Since it is 
a stand-alone file, it may also be opened and viewed by 
double clicking on the areps.hlp file from the Windows 
95/NT Explorer window. 

The Getting Started item provides information 
about running AREPS. The Obtain Technical Support 
item provides instructions on how to contact the AREPS 

Figure 4-8: Help menu. support team for questions, trouble reports, and other 
customer service features. The Update AREPS 

Software item provides an automatic update of the AREPS software from our Internet 
homepage. In order to use this update feature, your computer must be actively connected 



38 

to an Internet Service Provider (ISP) that supports File Transfer Protocol (FPT). 
About AREPS item provides information on the current version of AREPS. 

The 

AREPS Popup Menus 

Change Units 

You may change the units of an input 
field by typing the first letter of the desired 
unit in the input field. For example, if the 
input field for Peak Power has the focus, 
typing the letter "W" will change the units to 
watts. You may also right click on the 
information label appearing adjacent to the 
field. For example, right clicking on the Peak 
Power label brings up the Change Units 
popup menu as illustrated in figure 4-9. 

Peak pow '- 
Kilowatts 

=^.=—- r— 

Pulse lent 

Compress 

Megawatts      S 

Decibels relative to a milliwatt llll - 

Decibels relative to a Watt. 

Receiver i Milliwatts 

Assumed L,. 
Watts 

4 

Figure 4-9: Change Units popup menu. 

J1500 

fcooo 

Mirr-—--—---—*-**™ ! 

•     Convert to 1500. Feet 

Ma)      Convert to 457.2 Meters       ■ 

Figure 4-10: Convert Units popup menu. 

Should you be using the option to 
also convert the entered value when the 
units change, the Change Units popup 
menu will include the converted value as 
illustrated in figure 4-10. 
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PROJECT AND EM SYSTEMS 

Projects are created/opened from the Files menu and EM systems are 
created/opened/removed from the Systems menu. When the New item is selected from 
either menu, an appropriate window opens so you may enter the necessary data. If the 
Open item is selected from either menu, an Open/Remove selection window opens. 

Open/Remove Window 

Open/Remove Radar 1MB 

£ AAW defense 
gAEW Radar 

When    the    Open/Remove 
(project or system type) item is 
selected from the Files/Systems 
menu, a dialog window, figure 5-1, 
opens offering you a choice of 
several command buttons. These are 
Open, Remove, Cancel, and Help. 
The title bar of the Open/Remove 
window will indicate what type of 
system you are working with. 

To open an existing project or 
system, point to and click on a name 
from the list and then click the Open 
button or just point to and double 
click on the name. To remove a 

system or systems, highlight (point to and click on the first name and while holding the 
mouse button down, drag the mouse to the last name) those you intend to remove, and 
click the Remove button. If more than one system is highlighted, you will receive a 
confirmation notice. If only one system is highlighted, you will not receive a 
confirmation notice. 

Open Remove       Cancel Help 

Figure 5-1: Open/Remove window. 

Clicking the Cancel button returns you to the main AREPS window where you 
may select another item from the AREPS menu. Clicking the Help button will display 
information about this window. 

In addition to the command 
buttons, three views of the 
Open/Remove window are available. 
You display these views by clicking 
on one of the three view icons in the 
Open/Remove toolbar. These views 
are small icons as shown in figure 5- 
1, large icons as shown in figure 5-2, 
and details as shown in figure 5-3. 

Open/Remove Radar BUB 

2      S      i 
SB!    AAW defense    AEW Radar 

Qpen        Remove I     Cancel     ; ■ Help 

Figure 5-2: Open/Remove window - large icon view. 
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Open/Remove Radar BUB! 

— n 
IMka 1    ~«-^ig|"?-l 

Radar name ID Label Frequency , 

| $ 2D Radar Labell 900 MHz    1 

1 £ AAW defense Label 2 200 MHz    || 

1 ÄAEW Radar 
j 
s 

Label 3 -400 MHz    | 

-     ■        mi 

]| 

; Open Remove Cancel Help 

Figure 5-3: Open/Remove window 
- details view. 

In the details view, a 
number of system parameters also 
show in the window. By clicking 
on the column title bar, the systems 
may be sorted on that particular 
parameter. For example, you may 
sort your system by name, by 
frequency, or (if a radar system) by 
identification label. Clicking on the 
column title a second time will sort 
the systems in the opposite order. 
For example, the first click will sort 
the system names in alphabetical 
order. The second click will sort 
the systems names in reverse 
alphabetical order. 

Project Window 

Each run of AREPS is considered a project. A project contains all the display, 
EM system, and environmental data necessary for AREPS to create your decision aid. 
All such input data and the resulting decision aid diagrams are saved within a subfolder 
of the project folder. The project window, figure 5-4, opens by selecting New Project or 

ÄProiectParameters- ** UNTITLED **   Element© 

Classification:   None 

TDecision Aids—   —I 

<T Radar detection only 
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C Radar and ESM 
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Save 

Cancel 
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^l    PI«itfoim'Siie 

"»]    Radar 

Antenna height (fQ MSI 

jH   .Target 

r|'   Receiver 
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rProject Geographic Area , —-  -:~-U 

Latitude J86^ ° |5~" * ]Ö~~,~: <r NV^SJ 

Longitude jÖ~° [Ö^'f"" f W. C E 

First bearing C True) 

Bearing increment (*) 

Number of bparirig*- 

Figure 5-4: Project window. 
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Open/Remove Project from the File menu. Refer to navigating the AREPS window for a 
general discussion of data input, editing, etc. After all input data are complete, you may 
click the Execute button to start the decision aid calculations. If the project has 
previously been executed, you may click the Display button to view the project. 

Figure 5-4 also illustrates an error checking convention used throughout AREPS. 
AREPS assigns limits to most input items. The limits are divided into two groups, a hard 
limit group and a soft limit group. Hard limits are limits you may not exceed and AREPS 
will not accept. Soft limits are those we consider to be out of the normal usage range but 
we will still allow you to enter. If you exceed a hard limit, the background color of the 
input value will turn to red (Minimum height in figure 5-4). If you exceed a soft limit, 
the background color of the input value will turn yellow (Latitude of figure 5-4). While 
you may move about a window with a limits violation, you will not be allowed to save a 
system or execute a project with a hard limit violation. A brief description of each input 
field or option item follows. 

Project Label 

The project label is any text you may wish to use to describe your project. This 
text is displayed at the top of each decision aid. You are limited to 72 characters. 

Classification 

AREPS allows you to label your data with four different classification labels. For 
example, label 1 may be "My eyes only." Label 0 is predefined as "None" and you may 
not change it. Label definitions are made from the Security Labels tab on the Options 
menu. It is your sole responsibility to adhere to the data security requirements dictated 
by higher authorities. This utility is strictly a labeling convenience feature and, as such, 
the AREPS developers assume no responsibility for unauthorized release of classified 
data or misuse of this feature. The project's classification is automatically determined 
from the highest classification of any of its system components (i.e., radar, platform, 
ESM receiver, etc.). The classification of your project will show on the decision aid 
display. 

Decision Aids 

Click on one of the option buttons to select a desired decision aid. The Radar 
detection only option shows radar detection probabilities or propagation loss with 
thresholds you select with the Display item from the Options menu. The ESM 
vulnerability only decision aid shows vulnerability and no vulnerability in two regions 
as two colors. The Radar and ESM option shows probabilities of detection and ESM 
vulnerability simultaneously. The Communications decision aid shows regions of 
communication and no communication. 
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Systems and Environment Grouping 

The systems and environment is a grouping of dropdown boxes that define the 
project's EM system database requirements. These dropdown menus are populated from 
the database by clicking on the arrow to the right of the dropdown menu. 

Platform/Site Name 

A platform or a site is a container for an emitter such as a radar or a radio. A 
platform is generally thought of as a container that moves, such as a ship, aircraft, or 
tank. A site is generally thought of as a container that is either fixed or semi-fixed in 
location such as a communications bunker or a surface-to-air missile emplacement. The 
platforms are initialized from the Systems menu. The collection of emitters on the 
platform is called the platform's suite. When a platform is selected from the dropdown 
menu, the emitter names within the suite are copied into the Radar/Communications 
drop-down menu for your selection. For additional information about the link between 
the platform's emitter suite and the Radar/Communications drop-down menu, see the 
Program Flow item on Options menu. 

Radar Name or Transmitter Name 

Depending upon which decision aid you have chosen, you may select the 
project's radar or UHF communications transmitter from this dropdown menu. The 
emitter name is shown on the decision aid. 

Antenna Height 

The antenna height is the height of the radar or radio antenna above a reference 
level. The reference level may be the local ground level or mean sea level. For example, 
a land-based system mounted on a truck may reference its antenna height to local ground 
level, an ocean-based system mounted on a ship may reference its antenna height to mean 
sea-level, and an airborne system may reference its antenna height to either. 

The height may be in either feet or meters. Antenna heights are normally entered 
along with the radar or communication system in the platform window. You may 
override any height associated with a platform, however, by clicking on the antenna 
height input field in the project window and entering a new height. If you do override the 
height specified on the platform, you are asked if you would like to have your new 
antenna height replace the antenna height currently in the database. 

The antenna height will be added to any terrain elevation at the starting range. 
However, the terrain elevation may not be known until the terrain file or DTED CD- 
ROM is read. If the combination of heights exceeds the maximum display height, you 
will receive an error notice. Return to the project window and adjust the maximum 
display height accordingly. 
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Target Name 

For radar decision aids, select your project's target from the Target Name 
dropdown menu. The target and radar you select for your project will determine the radar 
cross-section in square meters. The Target Name dropdown menu is gray and 
unavailable for the ESM vulnerability only and Communications decision aid displays. 
The target name is shown on the decision aid. 

Receiver Name (Communications or ESM) 

For ESM and communication decision aids, select the receiver's name from the 
Receive Name dropdown menu. Note, for communication systems, the receiver name 
may also be the same as the transmitter name, assuming you have a transceiver system. 
The receiver name is shown on the coverage diagram. 

Environment Name 

Choose the project's environment from the Environment Name dropdown menu. 
The environment created by the Environment menu options is stored in an ASCII text 
file rather than in the AREPS database. As such, its name may be any valid Windows 
file name up to 256 characters including spaces. To be included in the Environment 
Name dropdown menu, the environment file must reside in the AREPS environment 
folder. The environment name is shown on the coverage decision aid. 

Project Geographic Area Grouping 

Latitude and Longitude 

The latitude and longitude (entered in degrees, minutes, and seconds) is used to 
extract terrain data from the DTED CD-ROMs. Click on one of the option buttons 
adjacent to the seconds input field to select the north, south, east, and west quadrant. The 
latitude and longitude specified will remain until you change it or select a stationary site. 
A stationary site automatically updates the latitude and longitude. If you should happen 
to select a mobile platform after a stationary site, the site's latitude and longitude will 
remain. Please insure the project's location is what you want before proceeding. If you 
choose to leave the latitude and longitude input field blank, the project will assume no 
terrain. 

First Bearing 

AREPS can display decision aids in a 360-degree azimuth scan. The first true 
bearing is that bearing for the first decision aid. The bearing may be from 0 to 360 
degrees (0 and 360 are assumed to be the same bearing). It is not necessary to include 
leading zeros in the field. For example, 30 degrees and 030 degrees are equal. 
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Bearing Increment 

The bearing increment is the number of whole degrees between the first bearing 
and the next successive bearing for an azimuth display. The minimum value is 1 degree. 

Number of Bearings 

This is the total number of bearings desired for an azimuth display. For example, 
360 degrees of coverage will be generated if the number of bearing is 36 and the bearing 
increment is 10 degrees. The minimum number of bearings is 1. Care should be used in 
selecting the number of bearings to prevent generating more than 360 degrees of 
coverage. Exceeding 360 degrees of coverage will only reproduce previously generated 
decision aids and cause longer program execution times. 

For range dependent environments, you should have the environment fully 
specified at each project bearing. If an environment is not specified at a project bearing, 
a decision needs to be made about how to proceed. You may have the decision aid use 
the environment at the closest bearing, use a standard atmosphere environment, or skip 
the decision aid for the bearing. You may make this decision before the project starts by 
selecting which method you would like from the Environment tab on the Options menu. 
You may also have the project pause and ask you for your decision when or if the event 
occurs. 

AREPS 1.0 allows you to specify you own terrain along a single bearing. If you 
have requested more than one bearing and are also using your own terrain, you will 
receive a warning notice, the number of bearings will be automatically set to one, and the 
project will continue. 

Graphic Display Options Grouping 

Minimum Height 

Use this input field to set the minimum height for the decision aid. For shipboard 
systems, this should be set to 0 (mean sea level). For land-based systems, a different 
minimum may be used. For example, the lowest elevation on earth is the Dead Sea at 
1302 feet below sea level. For this geographical area, the minimum height would be set 
to -1302 feet. The units may be feet or meters and may be changed by right mouse 
clicking on the minimum height label. Units of minimum and maximum display height 
may not be mixed. 

You must have your environment specified from this minimum height to the 
maximum display height. If the first height specification is above this 
minimum height, a decision needs to be made about how to proceed. You 

may have AREPS extrapolate the environment downward from the first specified height 
to the minimum height using either a standard atmospheric gradient or using the gradient 
between the first and second height levels in the specification. You may make this 
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decision before the project starts by selecting which method you would like from the 
Environment item on the Options menu. 

Maximum Height 

Use this input field to set the maximum height for the decision aid. The units may 
be feet or meters and may be changed by right mouse clicking on the minimum height 
label. Units of minimum and maximum display height may not be mixed. 

The maximum height should be above the highest elevation of any terrain 
/y,       within the scope of the project. Since the terrain elevation may not be known 

/ # \    until the project starts executing, if your maximum height is below the terrain 
elevation, you will receive a warning notice. Should the terrain exceed the 

maximum height at the first range (range zero), you must return to the project window 
and adjust the maximum height accordingly. Should the event occur at further ranges, a 
decision needs to be made about how to proceed. You may have the decision aid stop at 
the range where the terrain exceeds the display height, skip the decision aid for the 
current bearing, or you may return to the project window and change the maximum 
height. You may make this decision before the project starts by selecting which method 
you would like from the Terrain tab on the Options menu. You may also have the 
project pause and ask you for your decision when or if the event occurs. 

Maximum Display Range 

Use this input field to set the maximum range for the decision aid. For range 
dependent environments, you should have the environment fully specified to the display 
range. If it is not, a decision needs to be made about how to proceed. You may have the 
decision aid stop at the range of the last environment specification or you may have the 
last specification extrapolated to the display range. In the latter case, your environment 
will be horizontally homogeneous (not range dependent) from the range of the last 
specified profile to the display range. You may make this decision before the project 
starts by selecting which method you would like from the Environment tab on the 
Options menu. You may also have the project pause and ask you for your decision when 
or if the event occurs. 

The units may be kilometers, nautical miles, or statute miles and may be changed 
by right mouse clicking on the maximum display range label. Attention should be paid to 
the input limits shown in the status bar's left panel as minimum ranges are different 
between units. 

Map Options 

If you desire, you may have a terrain map image placed at the lower right corner 
of the coverage display. As the mouse cursor moves over the map, the terrain elevation 
values are shown. If you specify your own terrain rather than using DIED terrain or 
choose not to use the DTED terrain, you may not have a terrain map display. 
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You may specify a Full map, a 360-degree terrain map centered on the 
selected latitude and longitude with a radius of the selected maximum 
display range. You may also specify a Wedge map, a wedge of the full 
map, bounded by the project bearings covered plus 5 degrees on either 
side, provided the terrain data are already available on the hard drive. 

The Wedge map and No map options may be used to reduce the 
time needed to generate displays and hard disk storage requirements, 
since they reduce the number of needed terrain files. 

Earth Surface Depiction 

Radar, ESM, and communications decision aids may be displayed upon one of 
three different earth presentations, either a flat, curved, or dual curved earth as 
illustrated in figure 5-5. 

Figure 5-5: Earth surface depictions. 

Use caution when selecting graphic height and range combinations with the 
curved earth depiction, as improperly selected values may make the display hard to 
interpret or misleading upon casual inspection. 

Command Buttons 

Execute 

Click this button to start the decision aid calculations. The project will be error 
checked and, if error free, saved. If an error occurs, you are returned to the error point 
and asked to correct the problem before you may continue. After the error checking is 
complete you are asked for a project name if it is a new project. You may use any valid 
Windows folder name up to 256 characters, including spaces. 

If you are using DTED terrain, the required DTED CD-ROMs will be requested, 
the terrain map will be created, and the terrain will be drawn. If you are using your own 
terrain, the terrain map will be skipped and the terrain will be drawn. AREPS 1.0 allows 
you to specify your own terrain along a single bearing. If you have requested more than 
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one bearing and are also using your own terrain, you will receive a warning notice, the 
number of bearings will be automatically set to one, and the project will continue. 

After the terrain is drawn, the propagation model will generate the decision aid for 
each bearing desired. Once all decision aids are completed, they will be displayed in 
sequence. Using toolbar buttons, you may Pause the program anywhere in this process 
to take advantage of many additional features. You may also choose where the project 
pauses prior to execution from the Program Flow tab on the Options menu. 

Display 

Click this button to redisplay previously computed decision aids. If any project 
data have changed from a previous run, it is necessary for you to click the Execute button 
to ensure the coverage decision aids are appropriate to the current input data. 

Save 

The action of this button is the same for all AREPS windows. Click this button to 
save the information in the current window for later use. If you are in a new "Untitled" 
window, you will be asked to provide a name. For the radar, ESM, target, and 
communications windows, you may name the system as you wish. You are limited to 48 
characters including spaces. These names are entered into the AREPS database. If this 
entry is a new project, the name may be any valid Windows folder name up to 256 
characters, including spaces. 

Should you desire to save the information in the current window under a different 
name for later use, select the Save As item from the File menu. 

Cancel 

The action of this button is the same for all AREPS windows. Click this button to 
ignore any changes made in the current window. The window will close. 

Project Initialization File 

When a project is saved, an initialization file is created. The file resides in the 
project's folder. The file is used to fill the data input points of the project the next time 
the project is opened. In addition, the project file may be electronically mailed to the 
AREPS support team to assist us in helping with your problems. Each line of the file is 
one input and the value is followed by a pound sign (#) and a comment as to what the 
input is. Since it is an ASCII text file, you are able to edit the file externally to AREPS, 
but we don't recommend it. Error checking is performed as the file is read, and any 
errors will be announced. The format of the file is illustrated in table 5-1. 
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Table 5-1: Project initialization file format. 

AREPS Version [1.0.0] AREPS Project file {A}   # AREPS version number 
Sample 3D Surface Radar   # Project label 
0 # Classification level 
0 # Display type: 0-Radar, 1-Esm, 2-Both, 3-Comm, 4-Raytrace 
ddg # Platform name 
3d radar # Radar or Comm transmitter 
medium jet     # Target (Not used if Display type is 1 -Esm or 3-Comm) 

# Esm or Comm receiver (Not used if Display type is 0-Radar) 
Surface duct.env        # Environment filename 
75 # Antenna height in m 
m # Antenna height units 
118800 # Latitude in seconds = 33°00'00"N 
424800 # Longitude in seconds = 118°00'00"W 
0 # First bearing in degrees 
10 # Increment bearing in degrees 
2 # Number of bearings 
0 # Minimum Height in ft 
5000 # Maximum Height in ft 
100 # Maximum range in nmi 
ft # Min Ht and Max Ht units 
nmi # Max Range units 
2 # Type of terrain map: 0-No map, 1-Wedge only, 2-Full circle 
0 # Type of plot: 0-Flat, 1-Curved, 2-Dual curved 
true # Use latitude and longitude 

Platform Window 

The Platform window, figure 5-6, opens by selecting New Platform or 
Open/Remove Platform from the Systems menu. 

Platform Type and Location Grouping 

A platform or a site is a container for an emitter such as a radar or a radio. A 
platform is generally thought of as a container that is mobile such as a ship, aircraft, or 
tank. A site is generally thought of as a container that is either fixed or semi-fixed in 
location such as a communications bunker or a surface-to-air missile emplacement. 

If the platform is mobile (i.e., ship, plane, tank, etc.), check this box. The 
platform's latitude and longitude input fields become unavailable. If the platform is 
stationary (i.e., a communications bunker, etc.), uncheck this box. The latitude and 
longitude input fields become available. When this platform is selected for a project, and 
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the platform is stationary, its location will automatically be copied to the project.  You 
have the option to override the location from the project window if you choose to do so. 

in Platform Parameters - "UNTITLED**   Element (D) mm 
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C Level 1 
C Level 2 
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Emitter Library 
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Platform's Emitter Suite 
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2D RADAR 

New Radar New Comm View Save Cancel! 

Figure 5-6: Platform window. 

Height Reference 

APM requires a reference level for antenna height considerations. The reference 
level may be the local ground level or mean sea level. For example, a land-based system 
mounted on a truck may use local ground level as the reference level, a shipborne system 
may use mean sea level as the reference level, and an airborne system may use either. As 
a convenience, the antenna height is copied from the platform database and placed in the 
project window so you may temporarily edit it. You may not change the reference level 
in the project window, however. 

Emitter Library 

The emitter library is a listing of all emitters in your current database. Use the list 
scroll bars to view all the emitters. To select an emitter, click on its name or use the 
navigation keys to position the cursor over its name and then press the ENTER key. 

Platform Emitter Suite 

The platform's emitter suite is a listing of all emitters currently on your platform. 
The first column shows the emitter name. The second column shows the height of the 
emitter's antenna. The third column shows the units of antenna height. When a platform 
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is selected from the Project window, the emitter names within the suite will be copied 
into the Radar/Communications dropdown menus for your selection. For additional 
information about the link between the platform's emitter suite and the 
Radar/Communications dropdown menu, see chapter 6, the Program Flow item on the 
Options menu. 

Command Buttons 

Add Emitter 

A listing of all emitters in your current database is shown in the emitter library 
list. To add a particular emitter to your platform's suite of emitters, highlight its name 
and then click the Add button. 

Remove Emitter 

A listing of all emitters in your current platform's suite is shown in the suite list. 
To remove a particular emitter from your platform's suite of emitters, highlight its name 
and then click the Remove button. 

New Radar 

Normally you add radars into your database by using the System menu. You may 
also add a radar to the database by selecting the New Radar button. After the radar has 
been added to the database and the radar system window is closed, its name will be added 
to the emitter library list and you may then add it to the platform's emitter suite. 

New Comm 

Normally you add communications systems into your database by using the 
System menu. You may also add a communications system to the database by selecting 
the New Comm button. After the communications system has been added to the database 
and the communications system window is closed, its name will be added to the emitter 
library list and you may then add it to the platform's emitter suite. 

View Emitter 

While creating your platform, you may want to examine the parameters for the 
emitters currently on your platform. By selecting the View button, a separate window for 
each system will open. You may use the Windows menu to tile the windows in various 
manners. You may also edit any of the system parameters from any of the system 
windows. If you edit a system, however, be sure to Save the system before closing its 
window. 
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Radar Window 

The radar window, figure 5-7, opens by selecting New Radar or Open/Remove 
Radar from the Systems menu. 
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Figure 5-7: Radar window. 

Radar Calculations Options 

Detection of a target requires the receiver output, which consists of signal and 
noise, be processed in such a way that true signal detection is of high probability and that 
false signal detection (due to noise or jamming) is of low probability. 

The probability of detection is determined by the amplitude distribution 
(envelope) of the signal plus the unwanted noise or jamming. To improve the probability 
of true signal detection, pulse integration (the adding of target return signals and noise 
from two or more successive transmit pulses) is often performed. The advantage of pulse 
integration is that the true signal often does not change very fast (within a 10th of a 
second or so) whereas noise, a random process, often changes from pulse to pulse. 
Therefore, using integration normally allows the true signal to grow in strength (giving a 
better probability of detection), whereas the noise typically decreases in strength (its 
average value is zero). 
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There are two types of radar signal integration: coherent and incoherent. Radar 
signals are said to be coherent when the relative phase of the signals have a known 
relationship even though they may be considerably separated in time. Coherent 
integration is the addition of coherent radar signals (signals in relative phase) prior to 
determining the detection envelope. Incoherent integration does not consider the signal's 
phase but examines only the amplitude of each individual pulse. Once the amplitude 
information is extracted for each pulse, the information is then summed. Coherent 
integration increases the probability of detection more rapidly than incoherent 
integration, but coherent integration is normally more expensive to implement. 

AREPS allows for the calculation of a detection threshold based upon coherent 
integration, incoherent integration, or no integration (simple). 

EM System Parameters 

Your Identification Label 

The identification label is an optional field for your own use in organizing your 
radar systems. This label shows in the Details view of the Open/Remove window. By 
clicking on the identification label column title bar, your radars will be sorted by this 
label, allowing you another way to quickly find a particular radar. You may use any 
label format you desire but the label is limited to 12 characters. 

Frequency 

Frequency is the rate of recurrence of an event in periodic motion. The frequency 
is defined as the speed of light propagating through the atmosphere, divided by the wave 
length of the transmitted energy. For radars and communications systems, this data input 
is the frequency of the transmitter. For a target, it is the frequency corresponding to the 
measured radar-cross section. For an ESM receiver, it is the upper and lower frequencies 
associated with a particular receiver band. 

The recommended limits for all frequencies are 100 to 20,000 MHz. The units 
may be MHz or GHz. While the parabolic equation technique of APM is capable of 
higher frequencies, we have set a hard upper limit of frequency to 57 GHz. This is 
because APM version 1.0 has only implemented the gaseous absorption model up to that 
frequency. 

Peak Power 

For a radar application, the peak power is the maximum instantaneous power 
generated in a single pulse by the transmitter. Do not include transmission line or other 
losses. Do not use average power. For a communication application, use the average 
power. 
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Pulse Length 

In nature, energy is typically transmitted in the form of a simple sine wave. A 
radar transmitter will generate, in short bursts or pulses, this sine wave and then vary (or 
modulate) its frequency or phase, thereby shaping the waveform. A shaped waveform 
will increase the information that may be obtained from the return echo. The pulse length 
is the length of time between the start and end of the pulse. Long pulse lengths have the 
advantage that large amounts of energy can be applied to a target in order to enhance its 
detectability. Long pulse lengths will lead to the longest range of detection and are, 
therefore, used in long-range search radars. Long pulses have the disadvantage that fine 
details within the return echo are lost, thereby reducing target resolution. For example, a 
long pulse length may be used to detect the presence of a harbor within a coastline but 
will be unable to detect a pier within the harbor. 

Compressed Pulse Length 

Many receivers perform sophisticated signal processing to aid in identifying a true 
target or gaining additional information about the target. One such technique is called 
pulse compression. By modulating a wave's frequency or phase, the echo may be 
compressed in time by the receiver. Pulse compression achieves the benefit of high 
target resolution that comes from using a short pulse length yet uses the energy of a long 
pulse, gaining longer range detectability. In addition, pulse compression also reduces the 
influence of clutter. AREPS version 1.0 does not consider surface clutter and, therefore, 
pulse compression is not a required input. When a future version of AREPS does 
consider surface clutter, the pulse compression input will be activated. 

Receiver Noise Figure 

The receiver noise figure (most accurately described as a system noise figure) is a 
measure of the receiver system's noise temperature. The temperature relates to thermal 
noise in the receiver circuit, non-thermal noise from the electronic components, and 
antenna noise from environmental sources. The noise figure is defined by the ratio (in 
decibels) of the system noise temperature in Kelvin to 290° Kelvin (the IEEE standard 
reference temperature). 

Assumed System Loss 

The system loss is the sum of all losses that affect the radar free-space range 
calculations. These include, but are not limited to, transmission line loss, beam shape (or 
antenna pattern) loss, filter mismatch loss, bandwidth correction factor loss, signal 
processing loss, collapsing loss, etc. 

Maximum Instrumented Range 

After the transmitter sends out a pulse, it turns off and allows the receiver to 
"listen" for an echo. It may happen that a pulse will travel to a target and back, only to 
arrive while the transmitter is in the process of sending out another pulse.   In such an 
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event, the pulse is not received and the target is not detected. It may also happen that the 
pulse will return at some time after the transmitter has sent out a second pulse. In that 
circumstance, the target will appear closer to the transmitter than it really is. Echo 
signals received after an interval exceeding the pulse repetition period are called 
"multiple-time-around" echoes or "radar ghosts." The range that a pulse can travel to the 
target and back in the time interval between pulses is known as the maximum 
instrumented range or the maximum unambiguous range. 

Pulse Rate 

The pulse rate is the number of pulses the transmitter generates each second. 

Probability of False Alarm 

Receivers are designed with a high enough detection threshold that most receiver 
noise will not exceed it. On occasion, however, noise will have sufficient power to 
exceed the threshold, resulting in a false alarm. A tolerable rate at which false alarms 
occur depends upon the nature of the radar application. False alarm probabilities for 
most practical radars are quite small, on the order of 1.0E-6 or smaller. 

Antenna Pattern 

The distribution of energy into space relative to the antenna's axis of symmetry is 
called the "antenna pattern," its "power pattern," or its "radiation intensity pattern." 
While the distribution of energy is in three dimensions, it is most commonly displayed as 
a series of two-dimensional planar patterns. The major concentration of energy is along 
the axis of symmetry and is known as the main beam or "lobe." The main beam width, 
both horizontally and vertically, is most commonly expressed in degrees and represents 
the half-power points in the pattern. The additional lobe structure of the antenna pattern 
outside the region of the main beam is called "sidelobes." Sidelobes cause problems in 
target detection because they allow energy from outside the desired direction to enter the 
system. This leads to false targets or increased susceptibility to radar jamming. 

For many radar applications, it is desirable to reduce the power output at higher 
beam elevation angles or, conversely, increase the power output for lower beam elevation 
angles. Height-finder radars commonly employ antennas that steer the transmitted 
energy upward in angle. While the power necessary to detect a target 200 miles away in 
the horizontal is desired, the same power directed upward at 30 degrees would detect a 
target at approximately 530,000 feet. Since targets are not expected at this height, the 
power of the transmitter is reduced as the elevation angle increases. In addition, there is a 
reduction in how long the receiver waits for a radar echo. This has the advantage of 
reducing the strain on the transmitter and allows for better utilization of the radar's time. 
For the HT-FINDER SPECIFIC antenna pattern you must specify, and for the USER 
DEFINED antenna pattern you may specify, the angle at which the power is reduced and 
the factor by which the power is reduced. For the other antenna types, the antenna 
pattern entries are not available. 
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Antenna Type 

The antenna type provides a description of the radiation pattern of the transmitter 
or radar antenna. The antenna types as used in AREPS are given in table 5-2. 

Table 5-2: Antenna types. 

OMNI Uniformly radiating in all directions 

SINX/X See Elevation angle for additional information 

CSC-SQ Cosecant-squared radiating pattern 

GAUSSIAN Gaussian radiating pattern 

HT-FINDER GENERIC Height-finder that vertically scans a SINX/X pattern 

HT-FINDER SPECIFIC Height finder with a radiating pattern defined by the 
radar itself like the AN/SPY-IB or the AN/SPS-48E 

USER DEFINED A radiating pattern you defined yourself 

Polarization 

Polarization is the orientation of the antenna's electric field, which may be parallel 
to the earth's surface (horizontal), or perpendicular to the earth's surface (vertical). The 
polarization may also be elliptical or circular. Elliptical polarization is the combination 
of two linearly polarized waves of the same frequency, traveling in the same direction, 
which are perpendicular to each other. The relative amplitude and phase relationships 
between the two may be of any value. If the two wave amplitudes are equal and they are 
90 degrees out of phase, the polarization is circular. For the target, the polarization 
corresponds to a measured radar-cross section. 

Hits Per Scan 

In order to detect a target, an acceptable signal-to-noise ratio must be obtained. 
One way to accomplish this is to apply more energy on the target. Applying more energy 
on the target may be accomplished by increasing the number of pulses striking the target 
as the radar beam scans over the target. For simple radars, the number of hits per scan is 
calculated from the antenna's horizontal beam width, the pulse repetition frequency, and 
the horizontal scan rate of the antenna. For other types of radars, the number of hits per 
scan must be specified explicitly. 
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Antenna Gain 

The ability of an antenna to concentrate energy into a particular pattern or be 
more sensitive to energy arriving from a specific direction is called antenna gain. The 
gain of the transmitting antenna is a function of the antenna's aperture (the physical area 
of the antenna face), any losses of energy from processes such as resistance and 
radiational heating, and the wavelength. As the aperture of the antenna increases, the 
wavelength of energy decreases and the antenna gain increases. Greater antenna gains, of 
course, mean better target detection. While most radars are fixed in size and, therefore, 
have fixed gains, it is possible to use the relative motion between the radar and the target 
to electronically increase the aperture of the radar, thereby improving the gain and 
resolution. These radars are called "synthetic aperture" radars (the motion of the radar is 
used to increase the gain) or "inverse synthetic aperture" radars (the motion of the target 
is used to increase the spatial resolution. 

Antenna Scan Rate 

The antenna scan rate is the transmitter's antenna rotational or horizontal turning 
rate. 

Horizontal Beam Width 

The horizontal beam width is the horizontal angular width between half-power 
points of the antenna's main beam. 

Vertical Beam Width 

The vertical beam width is the vertical width of the antenna's main beam. For 
SINX/X, GAUSS, and HT-FINDER, the beam width is the full angular width between 
half-power points. For CSC-SQ, the beam width is the angular region where the pattern 
is uniform and above which a cosecant-squared function is applied. 

Antenna Elevation Angle 

The antenna elevation angle is the boresight pointing angle for SINX/X and 
GAUSS antenna types. It is also the direction of the maximum radiated power. For the 
HT-FINDER (GENERIC) antennas, the elevation angle is the angle above which the 
SINX/X pattern is vertically scanned. The elevation angle is measured from the local 
horizontal and increases in an upward direction. For most surface-based systems, this 
angle will be zero. For many airborne radars, this angle will be slightly downward 
(negative elevation angle). 
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Communications Window 

«•CommunicationParameters - ** UNTITLED 

- Classification- 

■• Nnnp 

C' Level 1 

<~ Level 2 

0 Level 3 

FPolanzation^^i 

i' Horl'nnlal 

C'Vertical      ' 

OMNI ■•^1 Antenna type 

The communications window, figure 5-8, 
opens by selecting New Communications 
or Open/Remove Communications from 
the Systems menu. Refer to navigating the 
AREPS windows for a general discussion 
of data input, editing, etc. For a brief 
description of each input field or option 
item other than receiver sensitivity, see the 
corresponding term within the radar 
window discussion above. 

Receiver Sensitivity 

The receiver sensitivity is the 
measured or specified ESM or 
communication receiver's sensitivity in 
decibels above a milliwatt (dBm). For 
ESM receivers, each frequency range and 
polarization combination will have its own 
sensitivity. Sensitivity values are normally 

negative. A typical good ESM sensitivity for microwave frequencies is -80 dBm. The 
radar and ESM receiver parameters will determine the receiver sensitivity used for the 
project. If the radar and ESM receiver do not have the same polarization, the sensitivity 
will be reduced by 3 dB for horizontal or vertical polarization radar and circular 
polarization receiver, or by 15 dB for horizontal polarization radar and vertical 
polarization receiver (or vice versa). 

F Transmitter frequency (MHz) 

Transmitter power (kW) 

Transmitter antenna gain (dbi) 

i Vertical'beam width (deg) 

■Antenna.elevation angle (<leg).; 

I' Receiver sensitivity (dBm) 

Save iiiancell 

Figure 5-8: Communications window. 

ESM Window 

The ESM window, figure 5-9, opens by 
selecting New ESM or Open/Remove ESM 
from the Systems menu. For a brief description 
of each input field or option item, see the 
corresponding term within the Radar or 
Communications window discussion above. 

Target Window 

The target window, figure 5-10, opens by 
selecting New Target or Open/Remove Target 
from the Systems menu. For a brief description 
of each input field or option item other than radar 
cross-section   and    Swerling    case,    see   the 
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Figure 5-9: ESM window. 
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corresponding term within the Radar window 
discussion above. 

Radar Cross-Section 

StTargrt Parameters - ** UNTITLED *' 

- Classification- 
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\    C LevaM   \ 
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Cancel! 

Figure 5-10: Target window. 

A target's radar cross-section is a term 
used to describe the signal scattering efficiency 
of the target. It is a function of the target's 
shape, the materials it is made of, the angle at 
which it is viewed (which implies a range 
dependency), the radar frequency, and the 
polarization of the transmitting and receiving 
antennas. The units of radar cross-section are 
units of area. In early work, the common unit 
was the square foot, but currently the accepted 
unit is square meter. It also may be expressed in 
decibels relative to the standard. Thus, a target's radar cross-section may be expressed in 
decibels relative to 1 square meter. 

The most direct way to determine the radar cross-section is to illuminate the 
target, or a scale model of it, with a well-calibrated radar and measure the return signal. 
Other ways are by direct solution of Maxwell's equations for the boundary conditions 
appropriate to the object (usually impossible for all but the simplest shapes) or by some 
approximation technique based upon EM theory. 

For AREPS, you must specify the radar cross-section directly in addition to the 
associated frequency and polarization. For the purposes of AREPS, an air target is 
considered a "point source" target with a single cross-section. A ship is considered a 
"distributed target" and the radar cross-section (CT) may be approximated by 

0.5   r,1.5 cr = 52 f* D] 

where /is the frequency in MHz and D is the ship's full load displacement in kilotons. 
Because the radar cross-section is a function of so many variables, it should never be 
extrapolated, inferred, or "guessed" from the cross-section of another target. 

Swerling Case 

Most real targets exhibit fluctuations in the radar cross-section. These fluctuations 
must be considered when computing the signal-to-noise ratio. In 1960, Swerling 
proposed four models for these fluctuations in radar cross section. His Cases 1 and 2 
apply to a complex target consisting of many independent scattering surfaces, all of 
which are approximately the same size. His Cases 3 and 4 apply to a target that consists 
of one large reflecting surface with other small reflectors. For AREPS, only steady and 
Swerling Case 1 targets are considered. For Swerling Case 1, the fluctuation is negligible 
from pulse to pulse and uncorrelated from scan to scan. Case 1 may be typical of aircraft, 
while steady may be appropriate for ships. These selections will provide the most 
conservative value and will not produce an unreasonably high signal-to-noise ratio. 
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OPTIONS WINDOW 

AREPS uses many global (used universally throughout the program) options that 
you have control over. These options are selected or specified from the various tabs of 
the options window. The options window opens by selecting Options from the AREPS 
main menu. Once the options window is opened, you may move between tabs, by 
clicking on the tab title, without having to return to the main menu. While the options 
window is open, you will not have access to any other AREPS window. The options 
window must be closed before you may proceed with any other activity. 

Command Buttons 

Across the bottom of the options tabs are command buttons which control how 
the options are applied. These command buttons behave the same for each tab. 

OK Button 

Click this button to accept all the option changes you have made on all the tabs 
and return to the main AREPS menu. If you don't save your changes prior to clicking 
this button, the changes will only be effective for the current AREPS session and the 
options will revert back to their prior settings the next time you use AREPS. 

Save Button 

Click this button to accept the option changes you have made on the current tab 
only. The new options settings are written into the AREPS initialization file so they may 
be active the next time you start the AREPS program. You will remain in the options 
window for additional changes on other tabs. 

Cancel Button 

Click this button to ignore all options changes on all tabs and return to the main 
AREPS menu. 

Defaults Button 

Click this button to restore all the options on the current tab back to the AREPS 
default values. 

Reset Button 

Click this button to reset all the options on the current tab back to the values they 
had when the options window was opened. 
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Folders and Drives Tab 

The AREPS program uses a number of folders to help organize your data. The 
paths to these folders are established when you set up AREPS. You may change the 
folders after the initial setup from this tab, figure 6-1. To change the folder or drive, just 
type the new path in the input field. A discussion of each option follows. 

«. AREPS Options 

Save / Edit 

QUO 
Displays 

Falders and Drives!     Security Labels 

Teiuin |        Environment 

Program Flow     I        Attenuations 

CD-ROM drive 

Terrain 

Browse.. 

D:\areps\DTED Browse., 

System database D:\arert Browse. 

Projects p:\areps\Projects Browse.. 

Environments |D:\areps\Enviro Browse» 

Automode JD:\areps\AutoMode Browse.. 

OK    | Saw:   | i Defaults Reset iGIKcell 

Figure 6-1: Folders and drives tab. 

CD-ROM Drive 

This is the letter of your CD-ROM drive. As you install new hardware drives, the 
letter of your CD-ROM may change. You may update your CD-ROM drive letter by 
entering a new value. 

If you want to use a CD-ROM drive on another machine, the two machines must 
be networked. Refer to the Windows 95/NT user's manual for instructions on creating 
networks. Once you are on a network, you must properly map the drive before you may 
specify its name here. Once mapped, you may use the Browse command button to select 
the drive from the CD drive dropdown menu. Mapping the drive consists of two actions: 
sharing the CD drive on the server machine and mapping a shared CD drive on your 
machine. 
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► Sharing the CD drive. 

1. From the Windows 95/NT Explorer Window, 
click on the Network Neighborhood icon and 
note the network name of the machine with the 
CD drive. In this example, it is Bali as 
illustrated in figure 6-2. 

2. From the Windows 95/NTExplorer Window, 
right click on the CD icon. 

&S (F:) 

3. Select Properties from the popup menu. 

4. Left click on the Sharing tab, illustrated in 
figure 6-3. 

5. Select the Shared As option button. Note the 
name of the drive. For this example, it is F. 
You do not need to change it. You do not need 
to change any other options on this sharing tab. 

6. Click the OK command button.    When the 
properties windows closes, you will notice the 
CD icon now includes a small hand, indicating 
it is a shared asset.     :   <& ,r-, 

B-^ (F:) 
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Figure 6-2: Network neighborhood. 
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Figure 6-3: Asset sharing tab. 

►  Mapping the CD drive. 

1.   From the Windows 95/NT Explorer Window, click on the Map Drive icon 
and a Map Drive window, figure 6-4, will open. 

2. The Drive dropdown menu will show the 
next available drive letter on your machine. 
In this example, it is G. Accept this letter. 

3. In the Path dropdown menu, type the location 
of the CD drive using the Universal Naming 
Convention. The format of an UNC name is 
\\server\share. For our example, the UNC 
name is \\bali\f. Then click the OK command 
button. 

■ ?|x| 

.  Qnve: 09M» OK     | 

rßäv^: £1                          3-: 
ÜÜ31Ü 

;,\r Reconnect at logon';   -.^ 

> Cancel.- 
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Figure 6-4: Map drive window. 
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Terrain Folder 

This is the path to your DTED terrain folder. You may change it by entering a 
new path. Because hard disk access is usually much faster than CD-ROM disk access the 
data are optionally written (by default) to this folder for later use. As AREPS reads the 
terrain data from the DTED CDs, of course, this folder will grow in size as more data are 
required. 

You are cautioned to watch the amount of disk space available, as low disk space 
will not only affect the AREPS program but all your other programs. If time is not a 
concern, you may want to delete the files within the folder every so often and let AREPS 
reread the data as required. If free hard disk space is always a problem for you, you may 
choose to have AREPS read directly from the CDs without copying the data to the hard 
disk. To do this, select the Terrain tab from the Options menu. 

You may choose to create your own terrain file (or edit a DTED terrain file) in the 
terrain window. If the file is created in this fashion, the file will be saved in the 
environment folder, not the folder you specify here. When needed, it will be copied into 
the appropriate project's folder. 

System Database Folder 

By default, the EM system database resides in the AREPS main folder. You may 
choose however, to have your database elsewhere. For example, for security reasons, 
you may want your database to reside on a floppy diskette or a removable hard disk so 
you may store your database in a secure location when it is not being used. To change 
the database location, enter a new value. 

Projects Folder 

As you create projects, they are saved in projects folder. By default, this folder is 
called Projects and is a subfolder of the AREPS main folder. Each project will become 
its own subfolder of the project folder and will contain all the files (except for DTED 
terrain data) necessary for executing the project. To change the path to the projects 
folder, enter a new value. 

Environments Folder 

All the refractivity profiles you create through the environment window are kept 
in this folder. Your original WMO message data may be located on any disk or in any 
folder, however, including a network drive or folder. To change the path to your 
environment files, enter a new value. 
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Automode Folder 

The automode function is not implemented in version 1.0. In future versions, 
automode will be an automatic product generator designed for your convenience in 
providing AREPS support to other people, or for you in producing the same series of 
decision aids on a routine basis. 

Browse Command Button 

If you are unsure of the folder to enter for 
any of the above options, you may click on the 
Browse button adjacent to the folder name input 
field. A folder and drive selection window, figure 
6-5, will open allowing you to browse through 
your computer's folder and drive structure. You 
may browse disk drives to include the CD-ROM 
drive, any floppy or removable disk drive, or any 
network drive. Click the Ok button to accept 
your folder choice. Click the Cancel button to 
return to your previous input point without a 
folder choice. 
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Figure 6-5: Change folder window. 

Security Labels Tab 

AREPS allows you to label your data with four different classification labels. The 
label definitions are assigned on the Security Labels tab, figure 6-6. 

Save / Edit Displays I "Icium J II 
■■UP 
nviromnenl 

r Folders and Drives IT SecairHy Labels  T .   Program Flow - ■.]•     .Attenuations., 

Security label 1   Level 1 

Security label 2 [Level 2 

\ Security label 3  iLevel 3 

OK    | Save   J Di»faute| Reset -Cancel ■ 

Figure 6-6: Security Labels tab. 
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Label 0 is predefined as None and you may not change it. You may change the 
text for labels 1, 2, and 3, however. For example, label 1 may be "My eyes only." To 
change the text for a security label, enter a new value. 

It is your sole responsibility to adhere to the data security requirements dictated 
by higher authorities. This utility is strictly a convenience labeling feature and, as such, 
the AREPS developers assume no responsibility for unauthorized release of classified 
data or misuse of this feature. 

Program Flow Tab 

Many decisions need to be made concerning how AREPS flows, handles 
inadequate environmental data, and presents the EM database. Some of these decisions 
are made from this Program Flow tab, figure 6-7. 

* AREPS Options mi 
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|     OK    | Save ilFlefliitlil Reset Cancel 

Figure 6-7: Program Flow tab. 

Because of the multi-tasking feature of the Windows 95/NT operating system, 
you may have many AREPS projects active at any one time. These decisions are 
universal in that they apply to all the projects in the current AREPS session. 

Pause Program for Option Selection 

AREPS has numerous display features and options available. Many of these 
features and options are available from toolbars or right click popup menus. The 
Program Flow tab allows you to pause AREPS at various points to take advantage of 
these features and options. 
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Platform and Emitter Links 

To help organize your EM systems, AREPS allows you to create platforms 
containing certain emitters. When you select a platform from the platform dropdown 
menu on the project form prior to selecting an emitter, the emitter dropdown menu will 
automatically be filled with the emitters on that platform. However, you may want to 
assess an emitter that is not on your currently selected platform and, for this case, the 
desired emitter is not available. From the program flow tab, you may choose how you 
would like AREPS to fill the emitter dropdown menu. You may have the emitter 
dropdown menu filled from just those emitters on the platform; filled first from those 
emitters on the platform (these names will be in capital letters) and then all the remaining 
emitters in the database (these names will be in small letters); or ignore the platform and 
fill the menu with all the emitters in the database. 

As with the platforms, when you select an emitter before selecting a platform, the 
platform dropdown menu is filled with those platforms that hold your emitter. You may 
have the platform dropdown menu filled with just those platforms that hold your emitter; 
filled first with the platforms holding the emitter (these names will be in capital letters) 
and then all the remaining platforms in the database (these names will be in small letters); 
or ignore the emitter and fill the menu with all the platforms in the database. 

Attenuations Tab 

AREPS considers gaseous absorption in the calculation of propagation loss. 
Gaseous absorption is due primarily to atmospheric water vapor and oxygen. You may 
use this tab, figure 6-8, to choose how you would like AREPS to calculate the 
attenuation. 
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Figure 6-8: Attenuations tab. 
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You may choose not to consider gaseous absorption, to use meteorological 
observation data within your environmental file (AREPS automatically includes these 
data if you created your refractive profile from WMO observations), to enter a surface 
meteorological observation, or you may choose to directly enter a specific attenuation 
value. For the case of meteorological observations, you may enter surface temperature in 
Fahrenheit, Celsius, or Kelvin, and humidity as relative humidity, dew point temperature, 
dew point depression temperature, or absolute humidity. To change units and humidity 
types, right click on the input field's label for a popup units change menu. AREPS 
version 1.0 does not consider attenuation due to rain or fog. In addition, the gaseous 
absorption model is only implemented to a frequency of 57 GHz. 

While not an attenuation, the option to include troposcatter in the propagation 
calculations is also found on this tab. 

Save and Edit Tab 

AREPS allows you to save propagation data in a number of formats in addition to 
simply displaying the decision aid. These data may then be used in your own research or 
in any other manner you choose. This tab, figure 6-9, allows you to specify how and 
where to save the propagation data. In addition, two other save and editing options are 
available. 

MMrbwhMWg 
Folders and Drives Security Labels Program Flow. i Attenuations i 
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PREPS 
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AREPS 

AREPS 

j.r Save terrain In ASCII text format JJERRN 

RiRamovB all optional files 

Fj Convert the input.value when its units change j 

-OK     I Save i Dafauhsl ,' Reset P Cancel 

Figure 6-9: Save and edit tab. 
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APM Output Data Options 

Save in EREPS Binary Format 

For your own comparative studies or display purposes, you may want to use the 
propagation loss versus height and range data in the EREPS program. You may choose to 
have AREPS save these data in the project's folder in a temporary file readable by the 
EREPS program. By default, the file name is EREPSdddebf, where add represents the 
bearing degrees. However, you may choose a different prefix for the file name. 

If you substitute another prefix for EREPS, remember EREPS is a series of 
MS-DOS programs and, as such, will not recognize Windows 95/NT long file 
names. For this reason, you may want to use names of five characters of less 
since AREPS will append the dddebf to the file prefix you specify. 

The binary data file format consists of three parts. Part 1 consists of optional 
ASCII comments. EREPS 3.0 ignores all ASCII data up to the first end-of-file, eof, 
mark. The eof has an ASCII code of 26 and may be generated from a BASIC language 
by printing CHR$(26) to the file. The eof must be followed by a carriage return, cr, and 
line feed, If, combination. The cr has an ASCII code of 13, the If an ASCII code of 10, 
and they can be generated from BASIC by printing CHR$(13) and CHR$(10), 
respectively. 

Part 2 follows the eof cr If combination of the optional ASCII comments, and 
consists of 14 lines of ASCII data containing the EREPS Version Label, file title, EM 
system, range, and height parameters. Each line of data is terminated by a cr If 
combination. These 14 lines are given in table 6-1. 

Table 6-1: ASCII text comment lines. 

Comment Description ASCII character format 
EREPS Version Label EREPS 3.0 cr If 
Title up to 72 characters maximum cr If 
Frequency (MHz) real number cr If 
Polarization HORIZONTAL, VERTICAL, or CIRCULAR cr If 
Antenna height (m) real number cr If 
Antenna type OMNI, GAUSS, SINX/X, CSC-SQ, or HT-FIND cr If 
Vertical beamwidth (deg) real number cr If 
Elevation angle (deg) real number cr If 
Number of heights Integer cr If              note: must be > 1 
Minimum height (m) real number cr If       note: must be > 1 
Height increment (m) real number cr If       note: must be > 0 
Number of ranges Integer cr If               note: must be > 1 
Minimum range (m) real number cr If       note: must be > 0 
Range increment (m) real number cr If       note: must be > 0 
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Part 3 contains the binary data that follows the 14th cr If combination of the 
ASCII data. The binary data consist of an array of propagation loss values in decibels 
times 10, rounded to the nearest integer. This maintains loss values to the nearest tenth of 
a decibel. The size of the array is equal to the number of height elements times the 
number of range elements times 2 bytes. The order for loss array values corresponds to 
all heights, from minimum to maximum, at the minimum range, followed by all heights 
at the next range, etc. Each integer array value is written in MS-DOS format, i.e., 2 bytes 
long with the low byte first. When writing the loss data to a file in a BASIC language, 
each element is separated by a semicolon to suppress the carriage return and line feed. 

A sample Microsoft BASIC 7.1 program to create a binary file is illustrated by 
figure 6-10. 

OPEN filenames FOR OUTPUT AS #1 
FOR i = 1 TO NumComments NumComments   is   number   of 

PRINT #l,comment$(i) comment lines 
NEXT 
PRINT #1,CHR$(26) eofcrlf 
PRINT #1,"EREPS 3.0" Version Number cr If 
PRINT #1, Frequency Frequency cr If 
1 similar statements for other 
t variables described above 

PRINT #1, Rangelncrement Range Increment cr If 
FOR i = 1 TO NumRanges Number of range increments 

FOR j = 1 TO NumHeights Number of height increments 
n=CINT(PL(Lj)*10) PL(i j) = Propagation Loss at the 
PRINT #l,MKI$(n); ith range and jth height. 

Use ; to suppress cr If 
NEXT 

NEXT 
CLOSE #1 
END 

Figure 6-10: Sample MicrosoJ ft BASIC 7.1 program. 

The MKI$ function ensures the integer is written in the MS-DOS format. 

Save in AREPS Binary Format 

As the mouse cursor moves about the decision aid, information about the decision 
aid (propagation loss values, height, range, etc.) shows in the status bar panels and in the 
labeling portion of the decision aid.  In addition, the propagation loss versus range and 
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height displays also need this information. For rapid recall, this information is saved, by 
default, in the project's folder as a temporary binary format file. You may choose, 
however, not to save these temporary files if hard disk space is a concern for you. Be 
aware, if you choose not to save these files, options such as propagation loss versus range 
displays will not be available to you. We recommend you save these files. 

By default, the file name is AREPSdddbin, where ddd represents the bearing 
degrees. However, you may choose a different prefix for the file name. For example, 
you may choose to use "Jerry" instead of AREPS. You may use any valid Windows 
95/NT file name character including spaces. AREPS will append the dddbin onto the 
file name you specify. 

The AREPS binary file is used for rapid recall of propagation loss values and its 
use to you in other applications may be limited. Should you desire to use these 
propagation loss data for your own reasons however, table 6-2 describes the format of the 
binary file. In addition, we provide a sample Visual Basic program, illustrated in figure 
6-11, to read the file. 

Table 6-2: AREPS binary file format. 

Offset 
Size Type Variable name 

1 2 2-byte Integer XO - Minimum range element 
3 2 2-byte Integer XI - Maximum range element 
5 2 2-byte Integer YO - Minimum height element 
7 2 2-byte Integer Yl - Maximum height element 
9 4 4-byte Single Rngmin - Minimum range in meters 
13 4 4-byte Single Rnglnc - Range increment in meters 
17 4 4-byte Single Htmin - Minimum height in meters 
21 4 4-byte Single Htlnc - Height increment in meters 
25 S where S = 

(Xl-XO+1) * 
(Yl-YO+1) * 2 
bytes 

2-byte Single L(1,1),L(2,1),L(3,1),...,L(440,1), 
L(1,2),L(2,2),L(3,2),...- 
Propagation loss in centibels 
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This program reads the file and fills an integer array variable called LossArray. 
The array is dimensioned for the number of range (440) and height (384) screen pixels. 

Fills Lossarray(Rngs,Hts) As Integer ' Db values in picPlot Hts 
Type ApmBinDataType ' Used in AREPSxxx.BIN files before 

1 LossArray(*,*) 
X0 As Integer ' Range elements of Loss Array  Dimensions for 

* LossArray(X0 to XI, Y0 to Yl) 
XI As Integer 
Y0 As Integer ' Height element of LossArray 
Yl As Integer 
RngMin As Single ' Range in meters of LossArray at X0 
RngMax As Single ' Range in meters ofLossarray at XI 
HtMin As Single ' Height in meters of LossArray at Y0 
HtMax As Single ' Height in meters of LossArray at Yl 

End Type 

Dim ApmBinData as ApmBinDataType 
CH = FREEFILE 
Open FileName For Binary As #Ch 
Get #Ch, 1, ApmBinData 
ReDim LossArray(ApmBinData.XO To ApmBinData.Xl, ApmBinDataY0 To 

ApmBinData.Yl) As Integer 
Get #Ch, 25, LossArray 
Close #Ch 

Figure 6-11: Sample Visual Basic program to read AREPS binary file. 

Save in ASCII Text Format 

You may desire access to the propagation loss versus height and range data for 
use in your own evaluation program. Since many programs such as Microsoft Excel or 
The Math Works, Inc. MATLAB allow for import of ASCII text data, you may choose to 
have these data saved in the project's folder in an ASCII text file format. 

By default, the file name is AREPSdddtxt, where the ddd represents the bearing 
degrees. However, you may choose a different prefix for the file name. For example, 
you may choose to use "Jerry" instead of AREPS. You may use any valid Windows 
95/NT file name character including spaces. AREPS will append the ddd.txt onto the file 
name you specify. 

The file contains header information to identify the project. Each piece of header 
information is preceded by a # sign. Following the header information is the number of 
range and height steps.  These numbers are preceded by an @ sign and may be used as 
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counters for reading the data. Following the range and height step numbers are the loss 
data in centibels. The data are arranged such that there is one line of text for each range 
step. Within each line, the data are the loss values separated by a space. Each line of 
data is terminated with a carriage return and line feed character. An example of such a 
file is: 

# AREPS Version [1.0.0] APM loss values 
# Project parameters: 
# Project name: 3d surface radar 
# Emitter: 3D RADAR 
# Environment: Surface ductenv 
# Latitude: 118800 
# Longitude: 421200 
# Bearing: 090 
# Maximum range: (nmi) 50 
# Maximum height: (ft) 10000 

# System parameters 
# Frequency (MHz): 3000 
# Antenna height (m): 22.86 
# Antenna pattern: Height-finder (Specific) 
# Antenna polarization: Vertical 
# Antenna beamwidth (deg): 2 
# Antenna elevation angle (deg): 0.5 

# APM parameters 
# Miriimum height (m): 0 
# Maximum height (m): 3048 
# Maximum range (m): 92600 
# Gaseous absorption (dB/km): 0 
# Troposcatter not considered 

# Format of loss values is: 
# For each range step, loss values at each height step, cr, If 
# -1 indicates no APM calculations 
# 0 indicates no loss (ground) 
# xxxx indicates loss values in centibels 

@  Range steps: 440 
@  Height steps: 384 

-100000000000000000000000000000000000 
00000000000 3885 1537 1042 885 884 885 884 1127 -1 -1 -1 -1 -1-1 - 
1 _i .1 _i .1.1 -i -i -i -i -i -1 -i -1 -1 -l -l -l -l -l -l -l -l -l -1 -1 -1 -1 -1 -1 -1 -1 -1 - 
1 _i _i -i -i -i -i -i -1 -1 -1 -1 -1 -l -l -l -l -l -l -l -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 - 
1 _i -i _i -i -i -i -1 -1 -1 -1 -l -l -l -l -l -1 -l -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 -1 - 
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-1 -1 -1 
-1 -1 -1 

.1 _i _i -i -i -i -i 
-1 -1 -1 -1 -1 -1 -1 

-1 -1 -1 
-1 -1 -1 

-1 -1 -1 •1 -1 -1 -1 -1 -1 -1 -1-1-1 
-1 -1 -1 ■1-1-1-1-1-1-1 1-1-1 

1-1-1 
1-1-1 

er If 

-1 -1 -1 
-1 -1 -1 
-1-1-1 

-1 -1 -1 -1 -1 -1 -1 
-1 -1 -1 -1 -1 -1 -1 
-1 -1 -1 -1 -1 -1 -1 ■ 

Save in Bitmap Image Format 

A bitmap image of the graphics is saved in the project's folder each time the 
project is executed. This image is just the portion of the decision aid inside the graphic 
axes. You may not prevent the saving of this image. The image name is APMdddbmp, 
where ddd represents the bearing degrees. 

You may choose to save the entire decision aid image to include the terrain map 
and all labels. The image may then be imported into a briefing package or printed for 
distribution. Remember, these files are bitmap images that will consume large amounts 
of hard disk space. 

By default, the file name is AREPSdddbmp, where the ddd represents the bearing 
degrees. However, you may choose a different prefix for the file name. For example, 
you may choose to use "Jerry" instead of AREPS. You may use any valid Windows 
95/NT file name character including spaces. AREPS will append the dddbmp onto the 
file name you specify. 

Save Terrain in ASCII Text Format 

You may desire access to the terrain data for use in your own evaluation program. 
Rather than creating a program yourself to read the DTED CD-ROMs, you may have 
AREPS save the terrain's height and range data (one file for each project bearing) in the 
project's folder as an optional ASCII text file. By default, the file name is 
TERRNdddter, where the ddd represents the bearing in whole degrees relative to true 
north. You may choose to use a name prefix other than TERRN, however. You may use 
any valid Windows95/NT file name character including spaces. AREPS will append the 
ddd and the .TER extension onto the file name you specify. For example, if you specify 
terrain. 000, the file name will be terrain. OOOddd. TER. 

Remove All Optional Files 

By default, this option is set to true and is used to conserve hard disk space. 
When AREPS executes a project, the optional files discussed above may be created and 
placed into the project's folder. An example of such an optional file is the bitmap image 
of a coverage decision aid (AREPSdddBMP, where ddd represents the bearing in whole 
degrees relative to true north). 
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As an example, you may want a project to save the decision aid images at 
bearings 000 degrees and 010 degrees so you can use them in a Microsoft PowerPoint 
presentation. The next time you execute the project, you may want the decision aid 
images at bearings 180 degrees and 190 degrees. By default, all the optional files from 
the previous execution are removed; that is, the image files associated with 000 and 010 
decision aid are removed. 

Removing optional files has no effect on a project's ability to display a previous 
execution. 

Convert Values When Units Change 

You may change the units of any input field by right clicking the mouse cursor on 
the label for the field. For example, to change the units of frequency right click on the 
word "frequency." If values are in a tabular form like the radar cross-section of a target, 
the units may be changed by right clicking on the label at the top of the column. By 
default, changing units will not affect the number within the input field. By checking this 
option, all numeric values will be converted to the new units when the units change. 

When values are converted, they may be rounded and precision may be lost. 
Converting the value again could compound the rounding error.   Therefore, 
converting back to the original units may not convert the value back to its 

original value. USE THE CONVERT UTILITY WITH CARE! 

Displays Tab 

AREPS tactical decision aids may be displayed in a variety of formats. You may 
choose the aid's display characteristics from this tab, figure 6-12. 

i~inix' 
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-Coverage display .... L,.' - ;.   ■ ... 

i^Show probability of detection (%) 
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§100 «10 910 

C Show propagation lost (dB) 
Hin (dB)    Ine (dB)     «Levels 

I      IV*L~     I*"     K-=^ 
P Show height reference lines 

-Curved Earth Display Attribiites^r 

! r Fit display to screen (may lose 
: ''visual resolution); " 

• r Allow display to scroll (may not' 
!   •" see entire display at once) 

Program Flow , 

Terrain 

Attenuations ■ 

Environment.' 

pLoss versus range/height display-—-rH 
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Min (dB)    liax(db) 

ISO 1160 

For slgnal-to-noise (db) scales/use, 

I      Max (dB)   Min (dB)      '. .'V..;,'"! 

OK Save Defaults! Reset | Cancel 

Figure 6-12: Displays tab. 
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Coverage Display 

The height versus range coverage display may be referenced to radar probability 
of detection (or ESM/Communications threshold) or to propagation loss. You may 
specify the limit of this reference, the increment of the reference, and how many 
increments you want. For example, you may choose propagation loss as your reference. 
You then may select 100 dB as your minimum propagation loss threshold value, 5 dB 
intervals, and 9 intervals. On your display, you will see 10 boxes on the color bar labeled 
0 to 100 dB, 100 to 105 dB, 105 to 110 dB, etc. As another example, you may have a 
radar project and choose radar probability of detection as your reference. You may then 
choose 100 percent as the limit, 20 percent as the interval, and 2 intervals. On the 
display, you will see two boxes on the color bar labeled 1 to .8 and .8 to .6. 

To aid you in visualizing the decision aid, you may choose to have height 
reference lines on the display. 

Loss Versus Range and Height Display 

The loss versus range and the loss versus height display may be referenced to 
propagation loss or to signal-to-noise. You may specify the upper and lower limit of this 
reference. 

In addition to the reference, you may also choose to superimpose radar probability 
of detection, ESM intercept, or communications threshold lines. For ESM only or 
communications displays, threshold lines will not display when using the signal-to-noise 
reference. For radar probability of detection, you may choose the maximum threshold, 
the interval of the threshold, and how many intervals you want. For example, you may 
choose 100 percent as the maximum probability of detection, 20 percent as the interval, 
and 2 intervals. On the display, you will see three colored dashed lines corresponding to 
100, 80, and 60 percent probability of detection. 

Curved Earth Display Attributes 

You may choose the maximum height and range for your coverage decision aid in 
addition the type of surface depiction. These two options affect the two curved earth 
depictions and not the flat earth depiction. Because you are free to choose any height, 
range, and depiction combination, your selection could result in a great amount of scale 
distortion. Scale distortion makes the display hard to interpret or misleading upon casual 
inspection. To relieve some of this distortion, you may choose to have the display 
expand in the vertical dimension. 

Expanding the vertical dimension, however, means you may not be able to see the 
entire display on the screen at one time. You would then have to use the vertical scroll 
bar at the right margin of the display to view the display. Using these options, you may 
force the entire display to appear within the window, or you may allow the display to 
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scale itself in the vertical. The advantage of having the entire display on the screen at one 
time is in capturing the screen to an external briefing package such as Microsoft 
PowerPoint.   The disadvantage of course is the scale distortion. 

Terrain Tab 

AREPS allows for many terrain options, selectable from the terrain tab as 
illustrated in figure 6-13. 

Folders ami Drives I    Security Labels  ,.1 •   Program Flow,   T . ~ .Attenuations 

l-in|x 

Save / Hit 3 Displays Tarraie Xi j. Environment • 

'  QRecreWlerrafnmap with each run 

T'Save map heights as ASCII, text   ■- 

".':, F.Copy DTED data to hard disk 
Qtiverwim) DTED data on hard disk 

F Search for data If not on trard disk 

• \~' Interpolate between DTED data boles 

Fj If terrain not on CD;' create.empty tile 
r":-Rescan CD to update empty files 

F Assume empty flies are water   " 

["/if CD is missing, assume water • 

P. Ask me for missing CD-ROMs 

C' Use my terrain file, not DTED I 

C Use no t> rrain' ;.•■ ->- 

,: Vlf terrain is higher than display height .„.—..    „-.,.,   .'" — 

':.:.]■: ..^ For the current bearing, stop when/if ft.ocniis.    '-:,.,: 
.]'("Return to project vvindow so I may change the display" 

.'. C Ask me to decide when/if it occurs 

! Browse.: 

lOK iSavil DefauHsl Reset LCancel 

Figure 6-13: Terrain tab. 

Which Terrain Data to Use 

AREPS, as the default, uses digital terrain elevation data from NIMA. In addition 
to DTED terrain data, AREPS is capable of using terrain data you have specified 
yourself. You may use the terrain window to enter your own data and save it in a format 
usable by AREPS. Since these terrain data are stored in and read from an ASCII text file, 
you may also choose to create your own terrain data file external to the AREPS program 
using an ASCII text editor such as Notepad. Be sure to follow the specifications of an 
AREPS terrain file when making your own file in this fashion. Please understand, if you 
use your own terrain data, you will not see a terrain map image on the decision aid. You 
may also choose not to use terrain data. If your assessment is for a path entirely over 
water, you may want to choose this latter option. 
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Use DTED Level... 

DTED are a uniform matrix of terrain elevation values, providing basic 
quantitative data for systems that require terrain elevation, slope, and/or gross surface 
roughness information. DTED data are provided in level 0, level 1, and level 2 formats. 
Level 0 spacing is 30 arc seconds in horizontal resolution (approximately 1 kilometer). 
DTED level 0 data are unlimited distribution and may be obtained directly from NIMA's 
public Internet homepage. Level 1 spacing is 3 arc seconds in horizontal resolution 
(approximately 100 meters). Level 2 spacing is 1 arc seconds in horizontal resolution 
(approximately 30 meters). Level 1 and 2 data are limited distribution. For this reason, 
DTED data are not and may not be distributed with AREPS. If you have a connection to 
the Secure Internet Protocol Router Network (SIPRNET), you may download the DTED 
level 1 and 2 data directly from NIMA's SIPRNET homepage. In addition, NIMA 
provides terrain data in other formats such as raster graphics. AREPS will accept DTED 
level 0,1, and 2 coverage. 

Other DTED Options 

If you elect to use the DTED data, you have a number of additional options to 
choose from. These are: 

Recreate Terrain Map with Each Run 

When a project is first executed, if you choose to have a terrain map, the map 
image is created from the data on the DTED CD-ROMs. The image is saved in the 
project's folder in a temporary graphic bitmap format file with the name terrain 
map.bmp. If the project is re-executed and this image exists, it is shown directly without 
recreating it from the DTED terrain data. You may, however, have changed the latitude 
and longitude between the first execution and the next and, thus, the map image will be 
out of date. You may choose to have the map image recreated every time the project is 
executed. 

Save Map Heights as ASCII Text 

When a project is first executed, if you choose to have a terrain map, the map 
image is created from the data on the DTED CD-ROMs. If you want these data for your 
own use external to AREPS, you may choose to have these height and range data saved 
in the project's folder in a temporary ASCII format file. The file name is fixed as terrain 
map.dat. Please understand this may be a very large file. 

Copy DTED Data to Hard Disk 

Because hard disk access is usually much faster than CD-ROM disk access, the 
data are written (by default) to the terrain folder for later use, as AREPS reads the terrain 
data from the DTED CD-ROMs. Of course, this folder will grow in size as more data are 
required. If free hard disk space is always a problem for you, you may choose to have 
AREPS read directly from the CDs without copying the data to the hard disk. 
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You are cautioned to watch the amount of disk space available as low 
disk space will not only affect the AREPS program but all your other 
programs. If time is not a concern, you may want to delete the files within the 
terrain folder every so often and let AREPS reread the data as required. 

Overwrite DTED Data on Hard Disk 

When the project requires DTED terrain data, it will first look in the terrain folder 
before looking elsewhere. If the proper terrain file is found, its data are used. In the 
course of time, you may obtain updates to the DTED CD-ROMs. If the terrain files are 
already in the folder, the new CD-ROMs will never be looked at. You may choose to 
have AREPS read the new CD-ROMs and overwrite the old data with the new. 

Search for Data if not on Hard Disk 

When the project requires DTED terrain data, it will first look in the terrain folder 
before looking elsewhere. If the data are found, they are used. If the data are not found, 
you may choose to have AREPS automatically search the CD-ROM. If the data are 
found, they are used. If the data are not found, AREPS will assume the terrain heights to 
be zero. 

Interpolate Between DTED Data Holes 

While the DTED CD-ROM may contain a terrain file for a particular geographical 
location, a specific latitude and longitude within the file may have missing height data. 
You may choose to have AREPS interpolate between height data present in order to 
provide a height for the missing location. Please understand interpolation may not 
necessarily be the correct procedure to provide missing information. As the terrain 
profile draws on the decision aid, you may examine the data to insure you feel 
comfortable with the interpolation. In cases where missing data is assumed to be water, 
heights will be zero, and no interpolation will occur. 

If Terrain not on CD, Create Empty File 

In some cases, the DTED CD-ROM may not contain a file for a particular 
geographical location. You may examine the map on the CD-ROM liner notes to see 
which locations are missing. If the file is missing from the CD, an empty file is written to 
the terrain folder on your hard disk as a placeholder. The empty file will be filled with 
heights of zero. Having the empty file present saves AREPS time by not having to look 
for a file already determined to be missing and also allows AREPS to skip asking you to 
enter the proper CD-ROM. 

Rescan CD to Update Empty Files 

The DTED CD-ROM may not contain a file for a particular geographical 
location. You may examine the map on the CD-ROM liner notes to see which locations 
are missing. If a missing file is encountered as AREPS is copying the data from the CD- 
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ROM to the hard disk, an empty file is written on the hard disk as a placeholder. The 
empty file will be filled with heights of zero. In the course of time, you may obtain 
updates to the DTED CD-ROM and previously missing files may now be present. You 
may have AREPS reread the CD-ROM to replace the empty placeholder files with files 
containing actual elevation data. 

If CD is Missing, Assume Water 

For whatever reason, you may decline to provide the DTED CD-ROM when 
requested, or you may choose to have AREPS just ignore any DTED data. If the CD- 
ROM is not provided, an empty file is not created. Since AREPS requires a surface 
elevation, an elevation of zero is used. You may choose to have AREPS assume this zero 
elevation means the surface is water. If so, the terrain map will be colored blue at these 
zero heights. If water is not assumed, the terrain map will be colored black at these zero 
heights. As the mouse cursor moves over the terrain map, assumed water will show a 
height of zero and no assumed water will show a "no height data" message in the label 
area of the decision aid. In cases where the surface is assumed to be water, heights will 
be zero and no interpolation will occur. 

Assume Empty Files are Water 

If a terrain file should be on a DTED CD-ROM but for some reason is not, 
AREPS will write an empty file to the terrain folder on your hard disk as a placeholder. 
The empty file will be filled with heights of zero. In most cases, if the file is missing from 
the CD-ROM, it is because the entire file's geographical area is over water. However, 
this is not always true. You may examine the map on the CD-ROM liner notes to see 
which missing locations are actually over water. You may choose to have AREPS 
assume an empty file represents water. If so, the terrain map will be colored blue at these 
zero heights. If water is not assumed, the terrain map will be colored black at these zero 
heights. As the mouse cursor moves over the terrain map, assumed water will show a 
height of zero and no assumed water will show a "no height data" message in the label 
area of the decision aid. In cases where missing data are assumed to be water, heights 
will be zero and no interpolation will occur. 

Ask Me for Missing CD-ROMs 

If you choose to use DTED terrain data, the project will first look in the terrain 
folder for the data. If they are not found, it will, optionally, look for a CD-ROM. You 
may choose not to have AREPS prompt you to enter the required CD-ROMs. You may 
want to do this if you do not have the CD-ROMs in the first place. If you elect not to be 
asked, terrain heights will be zero. Refer to the missing CD option for additional 
information about terrain heights of zero. 

If Terrain is Higher Than Display Height 

If you use DTED terrain data or your own terrain data, the maximum display 
height should be above the highest elevation of any terrain within the scope of the 
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project. Since the terrain elevation is not known until the project starts executing, a 
decision needs to be made about how to proceed, if your maximum display height is 
below the terrain elevation. You may have the decision aid stop at the range where the 
terrain exceeds the display height or you may return to the project window and change 
the maximum height. You may also have the project pause and ask you for your decision 
when or if the event occurs. 

Environment Tab 

The environment tab, figure 6-14, provides options when your environmental file 
does not meet AREPS' needs for the decision aid. 

- [  Folders and Drives']'." Security. Labels    I .." Program Flow,  , T       Attenuations 
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Figure 6-14: Environment tab. 

Lack of Environment Data in Range 

For range dependent environments, you should have the environment fully 
specified to the display range. If it is not, a decision needs to be made about how to 
proceed. You may have the decision aid stop at the range of the last environment 
specification or you may have the last specification extrapolated to the display range. In 
the case of the latter, your environment will be horizontally homogeneous (not range 
dependent) from the range of the last specified profile to the display range. 
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Lack of Environment Data in Bearing 

For bearing dependent environments, you should have the environment fully 
specified at each project bearing. If an environment is not specified at a project bearing, 
a decision needs to be made about how to proceed. You may have the decision aid use 
the environment at the closest bearing, use a standard atmosphere environment, or return 
to the project window so you may either change environment files or edit the current 
environment file (external to AREPS) to include the necessary bearing information. You 
may also have the project pause and ask you for your decision when or if the event 
occurs. 

Lack of Environment Data in Height 

You must have your environment specified from the minimum display height to 
the maximum display height. If the first height specification is above this minimum 
height, a decision needs to be made about how to proceed. For example, your project's 
minimum height is 1000 feet below mean sea level and you are evaluating a system in the 
area of the Dead Sea. The radiosonde station elevation is 730 feet below mean sea level. 
For this case, you are missing the environment data for the heights between -730 feet and 
-1000 feet. To provide these data, AREPS must extrapolate from the radiosonde station 
elevation downward. The extrapolation techniques may either use a standard 
atmospheric gradient or use the gradient between the first (WMO surface group - 
00XXX) and second height (WMO first significant level group - 11XXX) levels in the 
specification. 

For station elevations above mean sea level and, if necessary, the environmental 
file creation routines within the environment window will automatically extrapolate the 
sounding to 0 meters (mean sea level). The extrapolation technique you choose here is 
used. 



Chapter 7: The Environment 81 

THE ENVIRONMENT 

Environment Window 

The environment window, figure 7-1, opens by selecting an input method from 
the AREPS menu. Across the top of the environment window is a toolbar with standard 
Microsoft icons, illustrated and described in table 7-1. Below the toolbar is a tab control 
that you may use to select how you will create the environment file. 

r> ■* U| - |»i liml «- ^1 
[           Evaporation Duct                          Climatology To be determined 

['        mport WMO Code         \          Enter WVO Coda Enter Profil? 

Figure 7-1: Environment window. 

Table 7-1: Environment window toolbar icons. 

Toolbar icon Action 
The New toolbar button clears all the tabs of previously 
entered data so you may create a new environment file 
without having to leave and reenter the environment 
window. 

The Open toolbar button opens a file containing an 
environmental observation. To function correctly, the 
file's contents must be radiosonde data in standard World 
Meteorological Organization (WMO) TEMP, TEMP 
SHIP, or TEMP MOBILE format. 

The Save toolbar button or the Save or Save As items 
from the AREPS file menu will create an environmental 
input file readable by AREPS. In addition to the height 
and M-unit profile, all data used in creating the profile are 
also saved within the file. Once saved, you are returned 
to the AREPS main menu. 

ol   it I 0£h\ fl^l     Perform editing functions such as undo, cut, copy, and 
L_*J t, ,„1 fcm—J PHI     paste. 

. a" I J.SS J Insert or delete levels within a profile. 
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As an aside, an environmental file may be created using any text editor program 
such as Notepad or by using any of the environmental input methods within the EREPS 
"RAYS" program. Any file created with these methods must follow certain conventions 
as discussed under the environmental file format section. The EREPS program complies 
with these conventions. Once created, the environmental file must be copied to the 
environment folder of AREPS in order to be included in the project's environment 
dropdown menu. 

AREPS requires an environmental specification at all heights, ranges, and 
bearings of the project. In some cases, the specification may not be sufficient for the 
display characteristics you select. For these cases, you may choose how you would like 
AREPS to handle the lack of data. You make these choices on the Environment tab 
from the Options window. 

Common Input Fields 

Common to all tabs except the climatology tab are a number of input fields. 
These are: 

Environmental Label 

The label helps identify the environmental input. You are limited to 16 characters 
including spaces. If you are using either the Import WMO Code or Enter WMO Code 
tabs, a label for your environmental file will be automatically created from the WMO 
date/time code group. Since the month does not occur within the code, the month from 
the current computer time will be used. You may edit or delete this label as you wish. 

WMO Station Type 

If WMO code is entered by reading the data from a file or pasting from the 
clipboard, the data header UUBB (ship), TTBB (fixed location land), or IIBB (mobile 
location land) will determine which type of radiosonde station is being used. Once the 
station type is determined, you may not change it on any of the tabs. If you are using the 
Enter WMO Code tab, you may select the appropriate option button to alter the tab form 
to account for the differences between land and ship WMO code formats. If you are 
using the Enter Profile tab, you must specify the station type by selecting the appropriate 
option button. 

A If a land station is selected at any point, you will have access to the 
Evaporation Duct tab. However, you will receive a warning about appending 
an evaporation duct onto a land station profile.  Normally, you should only 

consider this when the station is located at the coast and the meteorological conditions are 
such that the land station reflects the conditions over the water. 
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Station Elevation 

If the radiosonde launch height is provided, it may be entered into the station 
elevation input field. For example, if the data were obtained from a radiosonde launched 
from the flight deck of an aircraft carrier, the flight deck height would be used for the 
station elevation. If necessary, a zero height level will be extrapolated using the M-unit 
gradient between the first two profile levels. 

Profile Legend 

The profile legend describes the current state of the environment and your inputs. 
If a valid height versus M-unit profile exists, the legend will read "Profile OK." If not, 
the legend will read "No profile." If an individual input value is unacceptable (i.e., a 
negative Kelvin temperature), its input field's background color will show red. If an 
individual input value is within bounds but not recommended (i.e., an evaporation duct 
height greater than 40 meters), its input field's background color will show yellow. 

Import WMO Code Tab 

If WMO code data are available within a file or are available upon the Windows 
clipboard, select this tab as illustrated in figure 7-2. 
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Figure 7-2: Import WMO Code tab. 
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If the data are in a file, you may open and read its contents directly using the 
Open toolbar button. Alternatively, you may drag and drop the file name from the 
Explorer window into this tab. The file may be located on any drive (network, your own 
hard drive, or a floppy diskette). If the data are available upon the Windows clipboard, 
you may paste them into the tab by using the Paste toolbar button, the AREPS edit menu, 
the right mouse click menu, or the standard Windows keystroke commands. As an 
example of this technique of data import, access the SIPRNET or Internet homepage of 
an organization that provides the local upper air observation in WMO format. While still 
in your Internet browser, highlight the WMO text and Copy it onto the clipboard using 
the browser's or standard Windows commands. Then left click in the import data text box 
and perform the Paste procedure. 

The contents of the data may include text other than standard WMO code text. It 
is not necessary to edit the data to eliminate extraneous text prior to opening it with the 
AREPS program. Standard WMO code conventions are observed when parsing data. 
For example, if the text "UUBB", "TTBB", or "IIBB" is not found within the data, the 
data will not be processed. 

Error checking is performed as the data are processed. If an error is found, it will 
be highlighted in the data input field. You may then use the editing toolbar buttons or the 
standard Windows editing shortcut keys (found on the right mouse button click menu) to 
correct any errors. 

Once the data have been processed, you may select any of the other tabs to view 
them. Viewing the data prior to saving the profile is not necessary. Viewing the 
refractive condition descriptions on the Enter Profile tab, however, would alert you to 
possible errors in the processed WMO code. For example, poorly ventilated radiosondes 
will often show the top of a superrefractive, subrefractive, or trapping layer to be at a 
pressure of 1000 millibars. 

Once WMO code is processed from a file or the clipboard, you may edit the data 
within any field within any tab. 

& 

You must be cautioned in the use of these data for several reasons. Since the 
data are most often obtained from a radiosonde launched over a land mass, 
the changing synoptic meteorological conditions must be evaluated to ensure 
the sounding is appropriate for the area and time of operation. For example, 

you should reject an early evening sea-breeze sounding if nighttime land-breeze 
conditions are present. Second, the actual data within the sounding should be 
investigated. Often digits can be transposed whether during the recording of data or 
during radio transmission. While AREPS does some gross error checking of the data, it 
is highly recommended that the data be examined and evaluated for meteorological 
consistency and accuracy. 
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Enter WMO Code Tab 

If WMO code is available from a source other than a file or upon the Windows 
clipboard, select this tab as illustrated in figure 7-3. 
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Figure 7-3: Enter WMO Code tab. 

Input error checking is performed as data are entered. The editing toolbar buttons, 
the AREPS edit menu, or the right mouse click menu will work for any field within this 
tab. The remove or insert level toolbar buttons will not function from this tab. 

The WMO code tabular form will accept an unlimited number of significant level 
groups. In using radiosondes to measure the vertical profiles of temperature and 
humidity, the absolute accuracy of the data is not as important for refractivity assessment 
as accurate measurement of the gradients. These necessary gradients are all found within 
the significant level portion of the WMO radiosonde report (IIBB, TTBB, or UUBB). 
For this reason, the mandatory levels of the radiosonde report (IIAA, TTAA, or UUAA) 
should not be necessary for refractivity assessment since any mandatory level that is also 
significant will appear within the TTBB, UUBB, or IIBB section of the report. Thus, 
AREPS does not consider the mandatory sections because these data are not needed. 
Should you feel it absolutely necessary to include the mandatory level data, you may 
insert them into the appropriate place within the significant level order. 

While header input boxes are include for completeness, it is not necessary to 
provide this information. 
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Enter Profile Tab 

If heights and refractivity values are known, or if pressure, temperature, and 
humidity values are known, you may use this entry method tab as illustrated in figure 7-4. 
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Figure 7-4: Enter Profile tab. 

The insert and remove level toolbar buttons only work within this tab. Inserting a 
level will open a new level above the current cursor location. The level to be deleted is 
shown by the current cursor location. The Undo, Cut, Copy, and Paste toolbar buttons do 
not work within the tabular form but will work for other input fields. 

By default, the profile tabular form is set to pressure, temperature, and humidity. 
If you have data in height and refractivity or modified refractivity, you may select the 
appropriate option button to change the columns on the tabular form. Once data have 
been entered into the form by either method, you may not change data types until you 
either delete all the entered levels with the remove level toolbar button, open a new 
environment with the New toolbar button, or save the profile and reopen the environment 
window. 

As data are entered in the profile tabular form, the profile will be created. Once a 
level has sufficient data, a description of the refractive condition between that level and 
the previous level will be displayed in the rightmost column of the tabular form. These 
conditions are Sub (subrefraction), Neutral (zero M-unit gradient), Normal (normal 
refraction), Super (superrefraction), and Trap (trapping). 
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The first column of the profile tabular form contains pressure or height values 
depending upon the profile type selected. The pressure values must be decreasing in 
height. The heights must either increase or remain the same. If the two adjacent heights 
are equal, the corresponding N/M-unit value in column two of the tabular form must also 
be equal. The units of pressure may be hectoPascals, millibars, or inches of Mercury. 
The units of height may be feet or meters. You may change the units by right clicking on 
the column label. 

By default, changing units will not affect the number within the input field. Thus, 
just changing units will give you a completely different profile. By selecting the 
Convert values when units change option (found on the Save/Edit tab of the Options 
menu), however, all numeric values within the column will be converted to the new units 
and the profile should remain the same. 

When values are converted, they may be rounded and precision may be lost. 
Converting the value again could compound the rounding error. Therefore, 
converting back to the original units may not convert the value back to its 
original value. USE THE CONVERT UTILITY WITH CARE! 

The second column of the profile tabular form contains temperature or 
refractivity/modified refractivity values depending upon the profile type selected. The 
units of temperature may be Fahrenheit, Celsius, or Kelvin. The units of refractivity may 
be N/M-units. Again, you may change units by right clicking on the column label. 

The third column of the profile tabular form contains humidity values or a 
refractive summary statement depending upon the profile type selected. Humidity may 
be entered in three forms: relative humidity (%), dewpoint temperature (F, C, or K), or 
dewpoint depression temperature (F, C, or K). 

Note that while all temperatures are either English (F) or metric (C or K), the 
concept of dewpoint depression units is different from the air or dewpoint temperature 
units. The dewpoint depression is the difference in degrees between the air temperature 
and the dewpoint. Therefore, in any dewpoint depression unit conversion between the 
English (F) and metric (C or F) system, the constant of 32 is not used. That is, 1 Celsius 
degree equals 1.8 Fahrenheit degree while 1 degree Celsius equals 33.8 degrees 
Fahrenheit. 

Evaporation Duct Tab 

You may use this tab, illustrated in figure 7-5, to create an evaporation duct 
profile by either entering a value for surface temperature, humidity, sea-surface 
temperature, and wind speed, or by entering an evaporation duct height and a stability 
parameter in the appropriate input fields. 

If you enter a ship radiosonde from any of the three other entry tabs, a neutral 
profile (air and sea surface temperature are equal) evaporation duct will be automatically 
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calculated and merged with the upper-air data from the radiosonde. For this calculation, 
the surface level of the radiosonde is assumed to occur at an altitude of 6 meters (or the 
non-zero station elevation if entered). In either case, a surface (sea-surface) M-unit value 
will be calculated for the required evaporation duct height and the evaporation duct and 
upper-air profiles will be merged at the launch height. To prevent appending the 
evaporation duct profile, uncheck the option Append duct to radiosonde checkbox. 
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Figure 7-5: Evaporation Duct tab. 

If a land station radiosonde is entered, you will have access to the Evaporation 
Duct tab but you will also receive a warning about appending an evaporation duct profile 
onto the bottom of a land station profile. We allow you this option in case the land 
station is along the coast and you feel its data are representative of those over the water. 

Surface Observation Input Fields 

Air Temperature 

The surface temperature of the air is best measured with a hand-held 
psychrometer at any location above 6 meters (20 feet). Be careful to minimize any ship- 
induced effects such as heating from exhaust vents or radiating surfaces. The units may 
be F, C, or K. 
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Humidity 

The surface humidity may be entered in three forms: relative humidity (%), 
dewpoint temperature (F, C, or K), or dewpoint depression temperature (F, C, or K). To 
change the humidity type and units, right click on the label. The humidity is best 
measured at the same location with the air temperature. 

Sea Surface Temperature 

The temperature at the sea surface is best measured with an accurate thermometer 
and a small bucket lowered into undisturbed water. Satisfactory measurements are also 
obtainable by using the surface temperature from an expendable bathythermograph 
(XBT) if the XBT is not launched into the wake. 

V 
Injection water temperature measurements are very inaccurate for the purpose 
here and should be avoided if another temperature source is available. 

Surface Wind Speed 

The true wind speed at the sea surface is best measured at the location of the air 
temperature and humidity measurements. The units may be knots or meter per second. 

Evaporation Duct Input Fields 

Evaporation Duct Height 

If a profile has been previously entered from any of the other tabs (except 
climatology), the surface air temperature and humidity input fields will be disabled. If 
you have independent information saying the evaporation duct height calculated is 
wrong, you may correct it by one of two methods. You may return to the Enter Profile 
tab and edit the surface temperature and humidity values in the profile tabular form, or 
you may click on the evaporation duct height input field to enable the surface observation 
values. You may then enter a new temperature or humidity. Lacking a surface 
observation, you may enter the duct height directly along with one of the two stability 
parameters (Monin-Obukhov length or Richardson number). 

Monin-Obukhov Length 

In 1954, Monin and Obukhov proposed a boundary layer similarity theory. In this 
theory, a relationship between two mechanical systems exists in that a proportional 
alteration of units of length, mass, and time measured in one system go identically into 
those in the other system. In particular, this implies constant ratios of forces in the two 
systems. The Monin-Obukhov length is a scaling parameter applied in height calculation 
functions. The length depends on both the shear stress of the wind upon the surface and 
the heat flux between the surface (ground or water) and the air. 
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Richardson Number 

The Richardson number is a non-dimensional number arising in the study of 
shearing flows of stratified fluid. In Richardson's original interpretation, this is a 
characteristic ratio of work done against gravitational stability to energy transferred from 
mean to turbulent motion. 

Evaporation Duct Profile 

If the environment has been entered from any of the other tabs (except 
climatology), this tabular form displays the merger of the evaporation duct profile and the 
upper-air profile. If an evaporation duct profile has been created from this tab by 
entering surface observations or the height and stability parameter directly, this tabular 
form displays only the evaporation duct profile. This tabular form is for display only. 
You may not edit any numbers within it. 

Climatology Tab 

GTE Sylvania, under contract to the Department of Defense, conducted a large- 
scale analysis of approximately 3 million worldwide radiosonde soundings from 921 
observing stations. Numerous statistics of tropospheric ducts and super-refractive layers 
were compiled. Using the Climatology tab, illustrated in figure 7-6, you may construct 
an M-unit profile based upon the statistics of the survey. 
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Figure 7-6: Climatology tab. 
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The 921 stations are shown as dots on the world map. As the mouse cursor 
moves about the map, its latitude, longitude, and Marsden square location are shown just 
above the map. Clicking on the map will fill the station name dropdown menu with the 
names of all the observing stations within the Marsden square. 

Select a station name from the name dropdown menu, a month of interest from 
the month dropdown menu, and a profile type from the profile type dropdown menu. The 
profile types may be standard atmosphere, surface-based duct, elevated duct, and a 
combination of surface-based and elevated ducts. As the profiles are created, the percent 
occurrence of such a profile shows in the right status bar panel. 

Please note the profile you select may occur only a very small percentage of 
the time. For these cases, you must ensure the ultimate user of the decision 
aid understands the likelihood of the environment. 

Refractive Summary Window 

The refractive summary window, illustrated in figure 7-7, shows the existing 
refractive conditions for the location and time of the environmental data entered. The 
summary shows refractivity (JV-units) and modified refractivity (M-units) as a function of 
altitude. The presence and vertical extent of any ducts show as shaded areas on a vertical 
bar to the right of the refractivity profiles. The trapping layer within this shaded area is 
colored a deeper red to distinguish the layer from the resulting duct. The profile lines are 
color-coded according to the refractive conditions within each layer. 
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Figure 7-7: Refractive summary window. 
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In addition to the environmental files created with the AREPS program, this 
summary window will also accept files (range dependent or range independent) you may 
create external to AREPS, assuming the proper file conventions are followed. 

You may use the refractive summary to assess the reliability of the environmental 
data. Rapid fluctuations in refractivity or unusually sharp gradients in refractivity, both 
of which may be caused by environmental input errors or improper environmental 
assessment methods, will become obvious by inspecting the profiles. In addition, the 
profiles may be inspected to ensure meteorological consistency. For example, if a Foehn 
condition is known to exist, there should be an indication of a surface-based duct. The 
evaporation duct height should be inspected. Any evaporation duct height greater than 40 
meters should immediately be suspect. 

World Meteorological Organization (WMO) Code 

The World Meteorological Organization defines a meteorological message as a 
message comprising a single meteorological bulletin. AREPS uses the TEMP, TEMP 
SHIP, or TEMP MOBILE message formats. The message is composed of five-character 
figure groups divided into two parts labeled XXAA and XXBB, where XX is replaced 
with TT for fixed land stations, II for mobile land stations, and UU for ship stations. The 
XXAA section reports data for mandatory isobaric surfaces. The mandatory levels are 
isobaric surfaces of 1000, 925, 850, 700, 500, 400, 300, 250, 200, 150, and 100 millibars 
(hectopascals). Section XXBB reports data for significant levels with respect to pressure, 
temperature, and humidity. The AREPS program uses the XXBB portion of the WMO 
message. 

In general, a significant level is defined as a level at which temperature and/or 
relative humidity data are sufficiently important, or unusual, to warrant the attention of a 
forecaster (such as cloud bases or icing strata) or to allow for precise plotting of the 
radiosonde observation. The criteria for determining significant levels for international 
exchange are based on the premise that significant level data alone shall make it possible 
to reconstruct the air temperature and relative humidity curves. These criteria are: 

1. For temperature at pressures of 300 millibars or greater, the temperature 
between two adjacent levels should not differ more than 1 degree Celsius from that 
obtained by linear interpolation between the two selected levels. 

2. For relative humidity at all pressures, the relative humidity between two 
adjacent levels should not differ more than 10 percent from that obtained by linear 
interpolation between the two selected levels. 

3. Surface data. 

4. Bases of clouds and icing strata. 
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5. The highest and lowest temperature on the plotted curve from the surface up to 
and including the terminating level. 

6. The highest and lowest humidity on the plotted curve from the surface up to 
and including the terminating level. 

7. The boundary levels of a stratum whose temperature and/or humidity is 
missing or doubtful. 

8. The lower boundary of a stratum of more than 50 millibars in extent for which 
humidity is missing, provided the humidity values continue to be missing for the 
remainder of the ascent. 

9. Termination of the ascent. 

10. Whenever a series of relatively thin strata (approximately 100 meters thick) 
having different lapse rates occur adjacent to one another, data for only the lowermost 
and uppermost of such levels will be transmitted. 

Five-Character Figure Groups 

Station Identification Group 

The WMO system of index numbers for identifying observing stations consists of 
two parts: a block number and a station number. When these two numbers are combined, 
the resulting group provides a unique number for each station. Block numbers" are 
allocated to countries or geographic areas by the WMO. Each block number identifies 
1000 station numbers assigned by the specific country. The first digit of the station 
number is a north/south indicator with smallest digits to the south and largest digits to the 
north of the block. The last two digits are an east/west indicator with the smallest digits 
to the east and largest digits to the west of the block. The format of the group is Iliii 
where: 

II        = Block number 
Iii        = Station number 

Date and Time group 

This group reports the date and time of the observation. The format of the group 
is YYGGI where: 

YY     =        day of month (+50 if winds are reported in knots) 
GG     =        nearest whole hour (Greenwich Mean Time) 
I =        hundreds of millibars relative to last wind surface 
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Latitude Group 

This group reports the latitude of the observing station. The format of this figure 
group is 99LLL where: 

99       =        indicator for sea station. 
LLL    =        latitude, degrees, and tenths. 

Longitude Group 

This group reports the longitude of the observing station. The format of this 
group is QLLLL where: 

Q        = quadrant of globe. 1=NE, 3=SE, 5=SW, 7=NW. The north/south 
line is 0 degrees latitude and the east/west dividing line is 0 
degrees longitude. 

LLLL =        longitude, degrees, and tenths 

Marsden Square Group 

As a way of grouping meteorological observations for climatology purposes, the 
entire world is divided into 10-degree by 10-degree squares called Marsden squares. A 
map of these Marsden squares may be found in the Surface Duct Summary program of 
EREPS. This WMO code group defines the Marsden square of the observing station. 
The format of this group is MMMUU where: 

MMM =        Marsden square number for ship location. 
U        = Units digit of latitude. 
U        = Units digit of longitude. 

Station Elevation Group 

For mobile land stations, the elevation of the reporting station is given together 
with the elevation units and the accuracy of the elevation. The format of this group is 
hohohohoim where: 

hohohoho   =     Station elevation 
im =    Units and accuracy of station elevation. 

The reported units and accuracy of the station elevation are defined in the WMO code 
table 1845 and illustrated in table 7-2. 
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Table 7-2: WMO code table 1845. 

Code figure Units used Confidence factor 
1 meters Excellent (within 3 meters) 
2 meters Good (within 10 meters) 
3 meters Fair (within 20 meters) 
4 meters Poor (more than 20 meters) 
5 feet Excellent (within 10 feet) 
6 feet Good (within 30 feet) 
7 feet Fair (within 60 feet) 
8 Feet Poor (more than 60 feet) 

Significant Pressure Groups 

This group reports the pressure for a significant (or surface) level. The format of 
this figure group is 00PPP where: 

00       = indicator for surface data (99 if land station). 
PPP    = extrapolated surface pressure in whole millibars (hectopascals), 

hundreds, tens, and units, i.e., 1013.2 mb = 013 or 987.2 mb = 987. 

All remaining pressure groups are significant levels. The format of these figure 
groups is XXPPP where: 

XX     = indicator for significant level. Significant levels are consecutively 
numbered 11,22,33, etc., and are repeated after 99. 

PPP     =        pressure in whole millibars (hectopascals), hundreds, tens, and 
units, i.e., 1004.2 mb = 004 or 457.2 mb = 457. 

When a stratum of missing data occurs and observed data are available below and 
above the missing stratum, a set of data is inserted to represent the missing stratum. For 
example, if a missing stratum occurs following the second significant level, the coding 
would be 33///, with the solidi (///) serving as place holders. 

Significant Temperature Groups 

These groups report the temperature and dewpoint depression temperature for a 
significant (or surface) level. The format of this figure group is TTTDD where: 

TT      = air temperature in whole degrees Celsius. 
T        = approximate tenths value, even for positive temperatures and odd 

for negative temperatures. 
DD     =        depression of dewpoint temperature with respect to water. 
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Subtract the dewpoint depression from the air temperature to obtain the dewpoint 
temperature. The reported numbers are from WMO code table 102 and illustrated in 
table 7-3. 

Table 7-3: WMO code table 102 

00 = 0.0 c 50 = 5.0 C 
01= 0.1 c 51-55 are not used 
02 = 0.2 C 56 = 6.0 C 
. .  . 57 = 7.0 C 
.  .  . ... 

.  .  . 98 = 48.0 C 
49 = 4.9 C 99 = 49.0 C or more 

All remaining temperature groups are associated with significant levels. The 
format of these figure groups is same as above. If only the dewpoint temperature 
depression is missing, the group is reported as TTT//, with the solidi (//) serving as 
placeholders. If the temperature is also missing, the group is reported as ///// with the 
corresponding pressure group also reported as XXIII. When entering temperature groups, 
just enter the // for the dewpoint depression only, i.e., skip the whole level for which the 
pressure group is XXIII and the temperature group is /////. 

Environmental File Format 

AREPS is fully capable of accounting for variations in vertical refractivity data 
that may vary in range and bearing. The difficulty is no ready source of range and 
bearing dependent refractivity data exists and the normal data availability will be a single 
radiosonde. Should range and bearing refractivity data be available, you may construct a 
range dependent environmental input file based on two or more profiles using a text 
editor, such as Notepad. For all numerical information within the file, commas as place 
separators are not allowed. For example, a representation of height as "7,234.00" is not 
allowed. The correct representation of the height is "7234.00." Commas may, however, 
be used to separate columns of numbers. 

Bearing Dependency 

In reality, an environmental file would normally only apply to a limited sector of 
bearings. However, if you have bearing varying refractivity data, the environmental file 
may contain it and AREPS will consider it. 
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Radio-refractivity (Meteorological) Field Restrictions 

A refractivity field is defined as a collection of M-unit versus height profiles that 
describe the atmosphere's refractive structure in three dimensions. ARPES places certain 
restrictions upon these profiles. These restrictions are: 

1. A profile is defined as couplets of height (feet or meters) and refractivity (N- 
units) or modified refractivity (M-units). The first numbered data point within a profile 
must correspond to a height of zero (mean sea level), even for profiles used over terrain 
paths. The environment window accounts for this requirement with its station elevation 
input. The maximum number of couplets for AREPS is unlimited. 

2. Within each profile, each numbered data point must correspond to a height 
greater than or equal to the previous height. If two adjacent heights are equal, the N or 
M-units value must also be equal. 

3. For range dependent files, the field may consist of an unlimited number of 
vertical piece-wise linear profiles at multiple arbitrary ranges. The range to the first 
profile must be zero. 

4. For range dependent files, each profile must contain the same number of 
vertical data points and be specified such that each numbered data point corresponds to 
like-numbered points (i.e., features) in other profiles. Therefore, you must inspect all the 
individual profiles and identify common features between them. 

File Key Words and Symbols 

The file contains a number of key words and symbols (keywords are case 
insensitive) which describe the data. These key words and symbols are: 

# - A line beginning with a # is a comment and is ignored by AREPS. 

@feet or @ft - signifies all heights are in units of feet. 

@meters or @m - signifies all heights are in units of meters. If the @feet is not 
present, meters are assumed unless specified otherwise within the @height keyword. 

@height - signifies the units for all values of height. Following this keyword is 
the unit keyword. The unit keyword may be ft, feet, m, or meters. If the unit keyword is 
not present, an error will be announced. An example is @height m. 

@nm, @nmi, @km, @sm, @kilometers, @nautical miles, @statute miles - 
signifies all ranges are in the unit of nautical miles, kilometers, or statute miles. If this 
keyword is not present, kilometers are assumed unless specified otherwise within the 
@range keyword. 
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@range - signifies a range from zero to the profile that follows. Following this 
keyword is the actual range value. Following the range value is a range unit keyword. 
The unit keyword may be kilometers, km, or k; nautical miles, nm, nmi, or n; statute 
miles, sm, or s. If the unit keyword is not present, kilometers are assumed. Some 
examples are @range 39 sm, @RANGE 52, and @range 100 nautical miles. 

@station - signifies the elevation (above or below mean sea level) of the station 
making the observation. Following this keyword is the actual height value. Following 
the height value is a height unit keyword. The unit keyword may be meters, feet, m or ft. 
If the unit keyword is not present, meters are assumed. Some examples are @station 20, 
@station 5280 feet, @station 15 m. 

@ref - signifies the type of refractivity values in the profile. Following this 
keyword is either an M (for M-units) or N (for N-units). If this refractivity keyword is 
not present, M-units are assumed. 

@tair or @air - signifies the surface air temperature. Following this keyword is 
the actual air temperature value. Following the air temperature value is the air 
temperature unit keyword. The unit keyword may be f, Fahrenheit; c or Celsius; and k or 
Kelvin. If the unit keyword is not present, Celsius is assumed. Some examples are @tair 
15.2 C and @air 32 f. 

@humid - signifies a surface humidity. Following this keyword is a keyword for 
the type of surface humidity. The humidity type may be abs (for absolute humidity), rel 
(for relative humidity), dewpt (for dewpoint temperature) and dewdep (for dewpoint 
depression temperature). Following the humidity type keyword is the actual humidity 
value. Following the humidity value is the humidity value unit keyword. For absolute 
humidity, the units are grams per cubic meter, for relative humidity the units are percent, 
for dewpoint and dewpoint depression temperature, the units may be either f, Fahrenheit, 
c, Celsius, k, or Kelvin. If the unit keyword is not present, the dewpoint or dewpoint 
depression temperature units are assumed to be Celsius. Some examples are @abs 8.3; 
@dewpt 12.6 C; @rel 86. 

@abshum - signifies a surface absolute humidity. Following the keyword is the 
value for surface absolute humidity. The units of absolute humidity are grams per cubic 
meter. The units need not be specified. 

@label - signifies a label for the AREPS program. 

@bearing - signifies all input values following this keyword apply to a specific 
bearing until another @bearing keyword is encountered. This keyword need not be used 
if there are data for only one bearing within the environmental file. Following the 
@bearing keyword is the actual bearing value. The units of bearing are degrees True. 
Some examples are @bearing 020, @bearing 40, @bearing 0, and @bearing 360. The 
bearings of 0 and 360 are assumed to be the same. If a bearing value is not present, an 
error will be announced.    When an @bearing keyword is encountered within the 
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environmental files, any previous keywords will be ignored. For example, if the keyword 
@height feet were to precede the @bearing, it will be ignored, and if no additional height 
unit keyword were encountered, all heights following the @bearing keyword will be 
assumed to be in meters (the default units of height). For this reason, if you intend to use 
a bearing dependent environmental file, you should ensure the @bearing keyword 
appears first in the keyword order. 

File Units 

Units may be mixed or changed anywhere between profiles but not within any 
single profile. The units apply to all following data until the units are changed again or 
an @bearing keyword in encountered. Blank lines, spaces, data deliminators (i.e., a 
comma or spaces separating height from M-unit values), and any characters following the 
M-unit or N-unit value are ignored. 

It is possible to make an error in the keyword and still have the program 
accept the data. Erroneous results will occur that MAY NOT BE 
OBVIOUS. Ensure keywords are used properly. 

The following is a sample of a file that contains data for six profiles. These 
profiles were measured from an aircraft flying a saw-tooth pattern from San Diego, CA, 
to Guadelupe Isle, Mexico. Note that there is one @feet keyword, indicating that all the 
height values within all the profiles are feet. Note there is no @bearing keyword. This 
indicates a non-bearing dependent environment. If you would like to use these profiles as 
a demonstration of AREPS' ability to include range dependent environmental effects, 
they are available within the on-line help. Copy these profiles onto the clipboard and 
them paste them into a new text file opened with Notepad. Save the new file with a 
.ENV extension. Copy or move the file into AREPS' environment folder. Select this 
environmental file from the environment dropdown menu in the project window. 

# range dependent environmental input data for AREPS 
@label San Diego to Guadelupe Isle 
@feet 
@range 0 run 
0.0, 337.000 1st layer-normal gradient 
540, 358.44 2nd layer - trapping gradient 
803.407, 324.736 3rd layer - normal gradient 
1217.17, 334.888 4th layer - trapping gradient 
1231.0, 334.494 5th layer - subrefractive gradient 
3500.0, 447.400 

@range 39 nm 
0.0, 337.000 1st layer-normal gradient 
540, 358.44 2nd layer - trapping gradient 
803.407, 324.736 3rd layer - normal gradient 
1217.17, 334.888 4th layer - trapping gradient 
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5th layer - subrefractive gradient 

1st layer - normal gradient 
2nd layer - trapping gradient 
3rd layer - normal gradient 
4th layer - trapping gradient 
5th layer - normal gradient 

1st layer - normal gradient 
2nd layer - trapping gradient 
3rd layer - normal gradient 
4th layer - trapping gradient 
5th layer - normal gradient 

1st layer - normal gradient 
2nd layer - trapping gradient 
3rd layer - subrefractive gradient 
4th layer - superrefractive gradient 
5th layer - normal gradient 

1st layer - normal gradient 
2nd layer - superrefractive gradient 
3rd layer - subrefractive gradient 
4th layer - trapping layer 
5th layer - subrefractive gradient 

How to Construct a Range Dependent Environmental File 

Constructing a range dependent environmental input file consists of four steps. 
These are preparing the data, mapping the evaporation duct portion of the profiles if they 
exist, mapping the upper-air portion of the profiles, and merging the profiles into one file. 
Each of these steps involves a number of sub-steps. It is highly recommended you study 
the techniques of these steps and their sub-steps prior to making an operational input file. 
Be aware that these steps describe the technique of mapping two or more M-unit versus 
height profiles together. You must ensure any mapping decisions you make during these 

1231.0, 334.494 
3500.0, 447.400 

@range 85.5 nm 
0.0, 337.169 
740, 365.34 
1080.63, 343.702 
1490.61, 356.039 
1652.63, 351.889 
3500.0, 430.919 

@range 125. nm 
0.0, 335.819 
1190, 382.84 
1574.55, 357.962 
1889.38, 371.111 
2096.94, 371.011 
3500.0, 430.957 

@range 160. nm 
0.0, 333.676 
1145.0, 378.220 
2140.0, 370.715 
2584.38, 398.294 
2923.08, 404.423 
3500.0, 429.802 

@range 193. nm 
0.0, 331.056 
1420.0, 382.920 
2387.5, 383.544 
2718.44, 410.029 
2892.62, 399.773 
3500.0, 430.849 
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steps are consistent with the true thermodynamical and hydrological layering of the 
atmosphere. 

The mapping technique may be applied to as many profiles as you have, provided 
they are in a line of bearing and that they are mapped in order. That is, profile 1 and 
profile 2 are mapped, profile 3 is mapped into the combination of profile 1 and 2's 
mapping, and so forth in range. Prior to taking the steps, you may want to review the 
considerations for range dependent environments and the definitions used in this 
description. For bearing dependent environmental files, the procedure for each bearing is 
that described here. The only other requirement is to precede the mapped profiles with 
the @bearing keyword within the final operational input file. 

► Step 1:   Preparing the Data 

Preparing the data consists of three sub-steps or operations: gathering the data, 
evaluating the data, and reducing the data. Each operation is described below. 

Gathering the Profile Data 

Prior to creating a range dependent environmental input file for AREPS, you must 
make a number of judgments about the profile data available. If you are able to answer 
yes to all the following questions, proceed with the construction. If not, you should not 
attempt to make a range dependent input file as erroneous displays will lead to invalid 
tactical decisions. 

1. Are the profiles in a rough line-of-bearing toward the threat bearing? 

2. Are all the profiles from the same observation period? 

3. If the profiles are not within the same observation period, have the 
meteorological conditions remained sufficiently constant to warrant using 
persistence? 

4. Are all the profiles contained within the same air mass (no fronts between 
the profiles)? 

Once you are comfortable with the representativeness of the environmental data, 
start the AREPS program. Then create and save the two (or more) environmental profile 
files using the WMO (or other) input method. Exit (or minimize) the AREPS program 
and open each file using the Windows Notepad program. Delete all lines except for the 
height and M-unit data and lines that begin with an @ sign. Also delete the pressure, 
temperature, and humidity data if these data exists. Retain the refractive description 
information for the time being. While not a requirement, it is a good idea to print these 
files to paper for reference. In addition, you should produce and print a refractive 
summary for each file.  Figure 7-8 is an example of two such processed files. 
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pfoHte l.btf - Notepad 
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|File One 
Slabel 2BJun96 - 2200Z 
jdheight meters 
dränge 0 kilometers 

.08 374.49 Calc euap 

.14 363.54 Calc euap 

.22 362.55 Calc euap 

.37 361.57 Calc euap 

.61 360.61 Calc euap 
1.00 359.66 Calc euap 
1.65 358.75 Calc euap 
2.72 357.89 Calc euap 
4.48 357.12 Calc euap 
6.00 356.74 Trap 

17.18 341.35 Normal 
1091.59 443.92 Normal 
1910.49 552.11 Super 
2044.78 555.90 Sub 
2128.38 589.49 Normal 
2846.28 681.72 Normal 
3366.59 741.04 Normal 
3655.54 774.70 Normal 
3890.70 796.71 Normal 
4392.21 863.68 Normal 
4538.49 884.73 Normal 
5288.29 990.69 Normal 
6023.27 1091.27 Normal 
6906.71 1217.22 Normal 

W^^m^m^^^^^m 

~ 

Ü profile 2.W - Notepad 

File    £dit   Search   Help 

File Two 
Slabel 20Jun96 - 2205Z 
dheight meters 
dränge 6 kilometers 

00 
.14 
.22 
.37 
.61 

1.00 
1.65 
2.72 
4.48 
6.08 

248.05 
1585.46 
1685.72 
1869.10 
2353.43 
2538.66 
2795.18 
2806.49 
3069.79 
4679.15 
5050.36 

374.49 
363.54 
362.55 
361.57 
360.61 
359.66 
358.75 
357.89 
357.12 
356.74 
342.44 
500.50 
510.85 
532.65 
597.63 
621.72 
648.67 
650.92 
686.05 
912.14 
963.86 

Calc euap 
Calc euap 
Calc euap 
Calc euap 
Calc euap 
Calc euap 
Calc euap 
Calc euap 
Calc euap 
Trap 
Trap 
Normal 
Normal 
Normal 
Normal 
Normal 
Sub 
Normal 
Normal 
Normal 
Normal 

Figure 7-8: Two processed environmental files. 

Evaluating the Profile Data 

In using a radiosonde to measure the vertical profiles of temperature and 
humidity, the absolute accuracy of the data is not as important for refractivity assessment 
as accurate measurements of the gradients. Sensor lag tends to reduce the gradients and 
increase the altitude at which gradient changes occur. The lag errors are not too serious 
at normal radiosonde ascension rates but can be very significant at launch. Often the 
radiosonde is prepared in a heated or air-conditioned space and is released without 
allowing for the proper acclimatization of the sensors. In other cases, the radiosonde may 
be exposed to direct sunlight and radiating surfaces, such as being left sitting on the 
ship's deck for several minutes prior to launch. 

Another factor that often contributes to spurious gradients is using psychrometric 
measurements for the surface level of the sounding. The psychrometer measurements are 
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more accurate than the radiosonde's. In addition, the psychrometer is not usually co- 
located with the radiosonde. That is, the psychrometer is carried to the best position for 
measurements while the radiosonde is likely to be in fixed position subject to the heat 
island effects of the ship. 

It has been shown that within the error range of the radiosonde's sensors, an error 
of ±9.1 iV-units at each reporting level may occur within conditions typical for the 
northern Indian Ocean. Psychrometric error may lead to ±1.3 JV-units per observation 
within the same environment. Compounding this sensor error with poor acclimatization 
or measurement techniques could lead to extremely abnormal low-level refractive 
gradients in radiosonde data over the open ocean and, ultimately, to dramatic inaccuracies 
in the quality of the AREPS assessment products. 

During the evening over land, formation of a temperature inversion in contact 
with the ground is common, as is an accumulation of water vapor near the surface leading 
to a decrease of humidity with altitude. This inversion often results in superrefractive 
conditions. During the daytime, a super-adiabatic layer quickly develops upward which 
in turn produces mechanical mixing, thereby restoring the refractive conditions back to 
normal. Over the open ocean there is much less variability since the sea-surface 
temperature may only change by a few tenths of a degree Celsius from night to day. 

By plotting the values on a thermodynamic diagram such as the Department of 
Defense Weather Plotting Chart (DOD-WPC) 9-16-1, "USAF SKEW-T, log p Diagram," 
the nighttime conditions of surface temperature inversion with trapping conditions are 
evident. Should you receive this sounding during the daytime hours, it appears to be 
directly opposite to the meteorologically plausible behavior of the marine boundary layer. 
As the AREPS operator, you must either rationalize the refractive conditions observed 
with an appropriate meteorological condition or must suspect instrument error due to 
improper pre-launch procedures. 

Even without displaying the radiosonde sounding on a thermodynamic diagram, 
you may also take warning by inspecting the height of the anomalous refractive 
condition. Characteristically, the top of the anomalous trapping, sub-refractive, or super- 
refractive layer is always at a pressure of 1000 millibars when the surface pressure 
exceeds 1000 millibars. For surface pressures less than 1000 millibars, the anomalous 
refractive conditions tops are at the top of the super-adiabatic layer. 

AREPS does not try to correct for instrument errors. Prior to using a profile 
created from WMO code, you should examine the profile and correct for this anomalous 
condition if you feel it is erroneous. The best time to make these corrections is while you 
are creating the profile in the environmental window. You may do it after the fact, 
however, by using the following example. Table 7-4 is an example of such a profile 
measured from a U.S. Navy ship in the Mediterranean Sea. No evaporation duct is 
appended. The station elevation is 9 meters, so AREPS extrapolates a surface M-unit 
value based upon the M-unit gradient in the first measured layer. 
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Table 7-4: Mediterranean Sea observation. 

@label 23M87 - 2300Z 
@height meters 
@range 0 kilometers 

# Ht(m)    M-units P(mb) Ta(C )  Rh(%)  Layer 
.0      373.8 Extrapolated 

9.0      369.7 1009.0 25.6 77.2 Trap 
88.0      333.6 1000.0 25.2 44.3 Super 

212.0      301.4 986.0 26.4 32.0 Normal 
1502.0      480.0 850.0 19.0 10.2 Normal 
2601.0      626.8 746.0 8.8 24.8 Normal 
3125.0      701.0 700.0 5.8 35.7 Normal 

AREPS labels the refractive layers such that the label applies to the layer above 
the label. That is, the trapping layer's bottom is at 9 meters (but extrapolated to the 
surface), and the top is at 88 meters. Likewise, the superrefractive layer's bottom is at 88 
meters, and its top is at 212 meters. Based upon your expertise, you determine the 1000- 
millibar level superrefractive layer is in error but believe the surface trapping layer is 
truly present and extends from the surface to 212 meters. It is necessary, therefore, to 
remove the superrefractive layer. Since the M-unit value reaches its minimum at 212 
meters, no adjustments in the profile's M-units values are necessary and the 9 and 88- 
meter levels are simply deleted. 

If you determine some other condition existed, the M-unit values in the affected 
layers would have to be adjusted. For example, the surface trapping layer may also be 
believed not to exist. A new surface M-unit value is now determined by interpolation 
using the normal refractive gradient within the layer between 212 and 1502 meters. This 
extrapolated surface M-unit value is illustrated by the equation in figure 7-8. 

272 
480 

4SD  (Mt 
Mt - — 

301  1502 
Mb)(zt 

o 
Zs) 

1502 212 

Figure 7-8: M-unit extrapolation. 

where Ms is the desired M-unit value at the surface, Mt is the M-unit value at the top of 

the normal layer, Mb is the M-unit value at the bottom of the normal layer, Zg is the 

desired surface height, zt is the normal layer's top height, and Zb is the normal layer's 
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bottom height. The two resultant profiles for these considered scenarios are illustrated in 
table 7-5. 

Table 7-5: Two possible M-vmit extrapolation results. 

Case 1: Trapping Layer Realistic Case 2: Trapping Layer Not Realistic 
@label 23M87 - 2300Z 
@height meters 
@range 0 kilometers 

@label 23M87 - 2300Z 
@height meters 
@range 0 kilometers 

.0   373.8    Extrapolated 
212.0   301.4    Trap 

1502.0   480.0    Normal 
2601.0   626.8    Normal 
3125.0   701.0    Normal 

.0   272.0   Extrapolated 
1502.0   480.0    Normal 
2601.0   626.8    Normal 
3125.0   701.0    Normal 

In addition to instrument errors, a number of other errors may arise from the use 
of WMO code. Prior to the use of any WMO data within AREPS, it is highly 
recommended the data are examined with the summary display and the results evaluated 
for meteorological consistency and accuracy. 

Reducing the Profile Data 

Sometimes it is desirable to reduce the number of profile levels prior to starting 
the level mapping. You have heard the old adage that "more is better." In modified 
refractive profiles, this may not always be true. Reducing the number of levels within a 
profile is done for a number of reasons. Among these are to reduce the number of 
possible sensor errors, to decrease the run time of the propagation model, and to make the 
mapping process easier. 

To examine the data for possible level reduction, produce the summary height 
versus M-unit display. Looking at the refractive condition labels within the profile, lay a 
straight edge along the points labeled as "Normal." If you can draw a straight line 
between levels such that a level is only a few M-units displaced from the line, you may 
remove the level and only keep the levels at the line's endpoints. A graphical example of 
reducing the number of profile levels is shown in table 7-6. 
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Table 7-6: Profile data reduction example. 

File 1 - Before level Blue Line Profile File 1 - After Level 
Reduction Red Line Straight Edge Reduction 

@label 20Jun96 - 2200Z 
@height meters 

n @label 20Jun96 - 2200Z 
@height meters 

o 
1-^ t 

@range 0 kilometers 
8 . o 
CO 

1 @range 0 kilometers 

.00   374.49 f .00     374.49 

.14   363.54 j .14     363.54 

.22   362.55 8 . / .22     362.55 

.37   361.57 
o 

/ .37     361.57 
.61    360.61 / 

.61      360.61 
1.00   359.66 8 . I 1.00     359.66 
1.65   358.75 1 1.65     358.75 
2.72   357.89 I 1 2.72     357.89 
4.48   357.12 18 . 1 4.48     357.12 
6.00   356.74   Trap 

O 
CO j 6.00     356.74   Trap 

17.18   341.35   Normal I 17.18     341.35   Normal 
1091.59   443.92   Normal 8 . J 1910.49     552.11    Super 
1910.49   552.11    Super o 

CM 7 2044.78     555.90   Sub 
2044.78    555.90    Sub j 2128.38      589.49   Normal 
2128.38    589.49   Normal 8 . 1 6906.71    1217.22   Normal 
2846.28    681.72   Normal 

o j 
3366.59   741.04   Normal j 
3655.54    774.70   Normal 
3890.70   796.71   Normal 

L 
.b.         m         ca        o        Ki 

4392.21    863.68   Normal O          O          O          Q          Q o       O        o       o       O 

4538.49   884.73   Normal M-units 

5288.29   990.69   Normal 
6023.27 1091.27   Normal 
6906.71  1217.22   Normal 

For radar frequencies below about 3000 MHz, the evaporation duct has little 
effect. For this case, you may want to just ignore the evaporation duct portion of the 
profile. This will make the mapping of profiles much easier since it reduces the number 
of levels that need to be mapped and also avoids some of the assumptions that need to be 
made about how the evaporation duct varies in range. After this step has been taken, you 
will treat the profile as an upper-air mapping case. 

Remembering that radiosonde conditions may lead to inaccuracies, prior to 
adjusting any Af-unit values within the profile, you should have already 
evaluated the representativeness of the gradients for realistic meteorological 
conditions. 
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When AREPS appends an evaporation duct to the profile, each level within the 
appended portion contains the "Calculated evap..." comment. This is true even if the 
levels are higher in elevation than the actual evaporation duct height itself. 

Prior to deleting any levels, you must first evaluate the levels to determine how 
you will proceed. There are two cases to consider depending on the station elevation: (a) 
the station elevation is zero, and (b), the station elevation is not zero. To determine 
which case to take, examine the height of the first non-evaporation duct level. If the 
station elevation was zero, AREPS makes an assumption that the station elevation is at 6 
meters when appending the evaporation duct, and you should take case a. If however, the 
height of the first level is not 6 meters, then you should take case b. 

Case a: Station elevation is 0 meters. 

For this case, you simply need to delete the evaporation duct levels inserted by 
AREPS and replace the height of 6 meters with a height of 0 meters, keeping the M-unit 
values unchanged as illustrated in table 7-7. 

Table 7-7: Two profiles - before and after evaporation duct removal. 

Before Evaporation Duct Removal After Evaporation Duct Removal 
@label 20Jun96 - 2200Z @label 20Jun96 - 2200Z 
@height meters @height meters 
@range 0 kilometers @range 0 kilometers 

.00 374.49 Calculated evap 0.00     356.74   Trap 

.14 363.54 Calculated evap 17.18     341.35   Normal 

.22 362.55 Calculated evap 1910.49     552.11    Super 

.37 361.57 Calculated evap 2044.78     555.90   Sub 

.61 360.61 Calculated evap 2128.38     589.49   Normal 
1.00 359.66 Calculated evap 6906.71    1217.22   Normal 
1.65 358.75 Calculated evap 
2.72 357.89 Calculated evap 
4.48 357.12 Calculated evap 
6.00 356.74 Trap 

17.18 341.35 Normal 
1091.59 443.92 Normal 
1910.49 552.11 Super 
2044.78 555.90 Sub 
2128.38 589.49 Normal 
2846.28 681.72 Normal 
3366.59 741.04 Normal 
3655.54 774.70 Normal 
3890.70 796.71 Normal 
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Table 7-7 (cont): Two profiles - before and after evaporation duct removal. 

Before Evaporation Duct Removal 
4392.21 
4538.49 
5288.29 
6023.27 
6906.71 

863.68 
884.73 
990.69 

1091.27 
1217.22 

Normal 
Normal 
Normal 
Normal 
Normal 

After Evaporation Duct Removal 

Case b: Station elevation is not zero. 

For this case, we must insert a 0 height level and extrapolate a surface M-unit 
value. The station elevation for this example is 55 feet. Surface conditions are such that 
a 15.34-meter evaporation duct is formed. Remember, the evaporation duct height may 
be found by looking for the level with the minimum M-unit value among the levels with 
the "Calculated evap..." comment. The first level above the evaporation duct shows a 
trapping condition. We've determined from evaluating the profile that a surface-based 
ducting condition exists so this trapping condition is representative of the true 
meteorological conditions. Therefore, we will use the trapping gradient between 17.00 
meters and 33.94 meters to extrapolate a surface M-unit value. This is illustrated by the 
equation in figure 7-9. 

344.35 
344.35 (Mt 

Ms  = Mt -     
374.44 

359.37   33.94      0.0 
Mb)(zt -   zs) 

33.94 17.0 

Figure 7-9: M-unit extrapolation. 

where Ms is the desired M-unit value at the surface, Mt is the M-unit value at the top of 

the trapping layer, Mb is the M-unit value at the bottom of the trapping layer, Zg is the 

desired surface height, zt is the trapping layer's top height, and Zb is the trapping layer's 
bottom height. Deleting all the evaporation duct levels and inserting the extrapolated 
surface value now produces the profile illustrated in table 7-8. 

Table 7-8: Two profiles - before and after evaporation duct removal. 

Before Evaporation Duct Removal After Evaporation Duct Removal 
@labell8M96-2200Z 
@height meters 
@range 0 kilometers 

.00   374.49   Calculated evap 

@labell8Jul96-2200Z 
@height meters 
@range 0 kilometers 

.00   374.44   Extrapolated 
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Table 7-8 (Cont): Two profiles - before and after evaporation duct removal. 

Before Evaporation Duct Removal After Evaporation Duct Removal 
.14 366.81 Calculated evap 17.00 359.37 Trap 
.22 365.83 Calculated evap 33.94 344.35 Normal 
.37 364.85 Calculated evap 1108.35 446.56 Normal 
.61 363.89 Calculated evap 1927.25 554.75 Super 

1.00 362.94 Calculated evap 2061.55 558.53 Sub 
1.65 362.03 Calculated evap 2145.14 592.12 Normal 
2.72 361.17 Calculated evap 2863.04 684.35 Normal 
4.48 360.40 Calculated evap 3383.36 743.67 Normal 
7.39 359.78 Calculated evap 3672.30 777.33 Normal 

12.18 359.41 Calculated evap 3907.47 799.34 Normal 
15.34 359.36 Calculated evap 
17.00 359.37 Trap 
33.94 344.35 Normal 

1108.35 446.56 Normal 
1927.25 554.75 Super 
2061.55 558.53 Sub 
2145.14 592.12 Normal 
2863.04 684.35 Normal 
3383.36 743.67 Normal 
3672.30 777.33 Normal 
3907.47 799.34 Normal 

For the remainder of the examples* we will use the non-reduced profiles so you 
may better see the mapping technique. 

► Step 2:   Mapping the Evaporation Duct Portion of the Profile 
(if an evaporation duct exists) 

Mapping the evaporation duct consists of four cases, depending upon the 
relationship between land and sea sounding and station elevation. These four cases are 
described below. 

Case a: Both profiles are over water and the station elevations are both zero. 

The profiles will have the same number of points up to a height of 6 meters. For 
this discussion, the profile with data closest to your location is referred to as the number 1 
file. The profile with data furthest from your location is referred to as the number 2 file. 
The file created as the result of this case is referred to as the number 3 file. The two 
profiles obtained during step one are used for illustration purposes. 
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Copy the levels (from 0 to 6 meters) from file 1 onto the clipboard and paste them 
into a new file (number 3) opened with Notepad. Copy the same levels from file 2 onto 
the clipboard and paste them into file 3, keeping a few blank lines between them and the 
lines from the first paste. Table 7-9 shows a graphic of the M-unit profile, the levels of 
files 1 and 2, and the resultant file 3. 

Table 7-9: Equal evaporation duct profiles merged in one file. 

M-unit / Height Profile File 1 - Evap Duct File 2 - Evap Duct File 3 - Merged 
.00   374.49 
.14   363.54 

00   374 49 00 374.49 
1 .14   363.54 .14 363.54 

.22   362.55 .22   362.55 .22 362.55 
vo - 

.37   361.57 .37   361.57 .37 361.57 
<h 

.61    360.61 .61    360.61 .61 360.61 
t • 1.00   359.66 1.00   359.66 1.00 359.66 

5 1 1.65   358.75 1.65   358.75 1.65 358.75 

0) 

1 2.72   357.89 2.72   357.89 2.72 357.89 
♦ 4.48   357.12 4.48   357.12 4.48 357.12 

(N   - 1 6.00   356.74 6.00   356.74 6.00 

.00 

356.74 

374.49 
T—    " .14 

.22 

.37 

.61 
1.00 

363.54 
362.55 
361.57 
360.61 
359.66 

o 4 
G 
C a 

)       O)       to       CO        CO i     co     en     -J      -»i 
i      o     en      o      Oi 

M-units 1.65 
2.72 
4.48 
6.00 

358.75 
357.89 
357.12 
356.74 

Case b: Both profiles are over water and one of the station elevations is not zero. 

Assume for this example, that the first profile (file 1 in case a above) has a station 
elevation of 0 meters. Assume our second profile (file 2) is taken from a radiosonde 
sounding with a station elevation of 10 meters. These two files are given in table 7-10. 
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Table 7-10: Two evaporation duct profiles from stations with differing elevations. 

File 1 - Evap Duct Portion 
0-meter station elevation 

File 2 - Evap Duct Portion 
10-meter station elevation 

.00  374.49   Calculated evap 

.14  363.54  Calculated evap 

.22  362.55   Calculated evap 

.37  361.57  Calculated evap 

.61   360.61   Calculated evap 
1.00  359.66  Calculated evap 
1.65   358.75   Calculated evap 
2.72  357.89  Calculated evap 
4.48  357.12  Calculated evap 
6.00  356.74  Trap 

.00  374.49 Calculated evap 

.14  365.60 Calculated evap 

.22   364.62 Calculated evap 

.37  363.64 Calculated evap 

.61   362.68 Calculated evap 
1.00  361.73 Calculated evap 
1.65  360.82 Calculated evap 
2.72  359.96 Calculated evap 
4.48  359.19 Calculated evap 
7.39  358.57 Calculated evap 

10.00  358.31 Trap 

The second profile contains 11 levels while the first contains only 10. 
Remembering that each profile must contain the same number of levels; it's necessary to 
add one level to the first profile. We must also remember that similar features from one 
profile must map to a similar feature on the other profile. Since the important feature 
here is the top of the evaporation duct, we want to keep the evaporation duct tops 
matched between profiles (that is, profile l's 6-meter level will map to profile 2's IO- 
meter level). Thus, we need to insert a level (less than or equal to 6 meters) into profile 
1, which will map to the 7.39-meter level in profile 2. The easiest way to do this is to 
assume that the 7.39-meter level will also map to 6-meter level of profile 1. 

In file 1, insert a line just prior to the 6-meter level that will map to the 7.39-meter 
level of file 2. Since AREPS allows for two levels having the same M-unit value and we 
are mapping to the 6-meter level, use the 6-meter M-unit value for the inserted level. 
Table 7-10 illustrates the mapping graphically and also shows the new levels within file 
1. The inserted level is so labeled. 
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Table 7-10: Mapping of two evaporation duct profiles. 

Graphical Mapping of Two 
Evaporation Duct Profiles (File 1 and 2) 

^ 

o   - 

CO   ■ 

s 

> 1 < 

co ■ 

«3 
x <* ■ ■* • 

CM   ■ CN   ' 
■ \ 

\ \ Y \ 
 5* 

o  ■ -t—V—i—* 1—o— -i 1*—-r    1 
CO CO 

o 
Cd 

Cfl 

CO cn 
tfi 

CO cn 
o 

CO CO CO 
CD -^ ^ 
cn      o      cn 

M-units M-units 

File 1 - result of the mapping 

.00 374.49 Calculated evap 

.14 363.54 Calculated evap 

.22 362.55 Calculated evap 

.37 361.57 Calculated evap 

.61 360.61 Calculated evap 
1.00 359.66 Calculated evap 
1.65 358.75 Calculated evap 
2.72 357.89 Calculated evap 
4.48 357.12 Calculated evap 
6.00 356.74 Inserted 
6.00 356.74 Trap 

Combining files 1 and 2 together using the techniques of case a gives the results 
as shown in table 7-12. 

Table 7-12: Equal evaporation duct profiles merged in one file. 

File 1 - Evap Duct File 2 - Evap Duct File 3 ■ • Merged 
.00   374.49 .00  374.49 .00 374.49 
.14   363.54 .14  365.60 .14 363.54 
.22   362.55 .22  364.62 .22 362.55 
.37   361.57 .37  363.64 .37 361.57 
.61    360.61 .61   362.68 .61 360.61 

1.00   359.66 1.00  361.73 1.00 359.66 
1.65    358.75 1.65   360.82 1.65 358.75 
2.72   357.89 2.72  359.96 2.72 357.89 
4.48    357.12 4.48   359.19 4.48 357.12 
6.00    356.74 7.39   358.57 6.00 356.74 
6.00   356.74 10.00  358.31 6.00 356.74 

.00 374.49 

.14 365.60 

.22 364.62 

.37 363.64 

.61 362.68 
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Table 7-12 (Cont): Equal evaporation duct profiles merged in one file. 

File 1 - Evap Duct File 2 - Evap Duct File 3 - Merged 
1.00   361.73 
1.65   360.82 
2.72   359.96 
4.48   359.19 
7.39   358.57 

10.00   358.31 

Case c: Both profiles are over water and neither of the station elevations is zero. 

For this example, the first profile is created from an ocean station radiosonde with 
a station elevation of 40 meters. The surface conditions were such that a 15.34-meter 
evaporation duct height was calculated. The second profile was from an ocean station 
radiosonde with a station elevation of 55 meters. The surface conditions were such that a 
20.99-meter evaporation duct was calculated. These two profiles are shown in the table 
7-13. Remember, to determine the evaporation duct height within a profile, look for the 
minimum M-unit value among the levels which have the "Calculated evap..." comment. 
As a visualization aid, the two evaporation duct heights have been underlined in the table. 

Table 7-13: Two evaporation duct profiles from stations with nonzero station elevations. 

Profile 1 - Evap Duct Portion 
.00 374.49 Calculated evap 
.14 369.18 Calculated evap 
.22 368.19 Calculated evap 
.37 367.22 Calculated evap 
.61 366.25 Calculated evap 

1.00 365.30 Calculated evap 
1.65 364.39 Calculated evap 
2.72 363.53 Calculated evap 
4.48 362.76 Calculated evap 
7.39 362.15 Calculated evap 
12.18 361.77 Calculated evap 
15.34 361.72 Calculated evap 
20.09 361.80 Calculated evap 
33.12 362.50 Calculated evap 
40.00 363.02 Normal 

Profile 2 - Evap Duct Portion 
.00 374.49 Calculated evap 
.14 366.87 Calculated evap 
.22 365.52 Calculated evap 
.37 364.17 Calculated evap 
.61 362.84 Calculated evap 

1.00 361.53 Calculated evap 
1.65 360.25 Calculated evap 
2.72 359.02 Calculated evap 
4.48 357.89 Calculated evap 
7.39 356.90 Calculated evap 

12.18 356.16 Calculated evap 
20.09 355.82 Calculated evap 
20.99 355.81 Calculated evap 
33.12 356.15 Calculated evap 
54.60 357.58 Calculated evap 
55.00 357.61 Normal 
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Since the important feature is the top of the evaporation duct, we want to keep the 
evaporation ducts' tops matched between profiles (that is, profile l's 15.34-meter level 
will map to profile 2's 20.99-meter level). In addition, note the second profile contains 
13 levels up to and including the evaporation duct height, while the first profile contains 
only 12. Remembering that each profile must contain the same number of levels, it will 
be necessary to add one level to the first profile. Thus we need to insert a level (less than 
or equal to 15.34 meters) into the profile 1 that will map to the extra level in profile 2. 
The easiest way to do this is to assume that the evaporation duct height for profile 1 will 
also map to the extra level in profile 2. Figure 7-10 is a graphical display of this mapping 
and table 7-14 presents the resultant profiles. Note that two levels may have the same 
height as long as they also have the same M-unit value. In the figure, don't be confused 
with the different height scales. The important idea is to match level numbers. 

E 

i ° 
Evap duct height 

15.34 meters 

o 
CD 

Evap duct height 
.99 meters 

■ffcatfa*' 

M-units 

U     (J    U     ( 
O)   o>   en   c 
U     f>    O)     ( 

M-units 

-*-—i—1+- 
u   u   u   u 
^J     -*l     ~N!     ~J 
o   ro   *.   05 

Figure 7-10: Graphical mapping of two evaporation duct profiles. 
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Table 7-14: Mapped evaporation duct profiles from stations with nonzero elevations. 

Profile 1 - Mapped Profile 2 
.00 374.49 Calculated evap .00 374.49 Calculated evap 
.14 369.18 Calculated evap .14 366.87 Calculated evap 
.22 368.19 Calculated evap .22 365.52 Calculated evap 
.37 367.22 Calculated evap .37 364.17 Calculated evap 
.61 366.25 Calculated evap .61 362.84 Calculated evap 

1.00 365.30 Calculated evap 1.00 361.53 Calculated evap 
1.65 364.39 Calculated evap 1.65 360.25 Calculated evap 
2.72 363.53 Calculated evap 2.72 359.02 Calculated evap 
4.48 362.76 Calculated evap 4.48 357.89 Calculated evap 
7.39 362.15 Calculated evap 7.39 356.90 Calculated evap 
12.18 361.77 Calculated evap 12.18 356.16 Calculated evap 
15.34 361.72 Inserted 20.09 355.82 Calculated evap 
15.34 361.72 Calculated evap 20.99 355.81 Calculated evap 

duct). 
Case d:   One profile is over water and the other is over land (no evaporation 

For this example, the first profile will be the same used in case c. The surface 
conditions were such that a 15.34-meter evaporation duct height was calculated. The 
second profile is from a land station radiosonde with no evaporation duct. For the 
ocean/land case, the station elevations are immaterial as AREPS starts each profile at a 
height of zero no matter the station elevation. These two profiles are shown in the table 
7-15. 

Table 7-15: Evaporation duct and land station profiles. 

Profile 1 - Evap Duct Portion 
.00 374.49 Calculated evap 
.14 369.18 Calculated evap 
.22 368.19 Calculated evap 
.37 367.22 Calculated evap 
.61 366.25 Calculated evap 

1.00 365.30 Calculated evap 
1.65 364.39 Calculated evap 
2.72 363.53 Calculated evap 
4.48 362.76 Calculated evap 
7.39 362.15 Calculated evap 
12.18 361.77 Calculated evap 
15.34 361.72 Calculated evap 
20.09 361.80 Calculated evap 
33.12 362.50 Calculated evap 
40.00 363.02 Normal 

Profile 2 - Land Station 
.00   363.02  Normal 

40.00   374.49  Normal 
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Keeping in mind the need to map features between profiles, we must map the top 
of the evaporation duct in profile 1 to some feature in profile 2. The most logical 
mapping is to connect the evaporation duct height to the ground (level one of the land 
profile). For this case however, one more consideration should be made - how far away 
from the coast are the two profiles? If the land station is located within a few hundred 
meters from the water's edge, we may want to assume the evaporation duct height will 
map directly to the ground level. 

If, however, the land station is many kilometers inland, this assumption is not 
desirable. For the far inland situation, it will be necessary to reproduce the ocean profile 
and the land profile, placing the duplicate ocean profile at a range a few hundred meters 
offshore and the duplicate land profile at a range corresponding to the beach. We will 
ultimately produce 4 profile range dependent file. (Placing of profiles at various ranges 
is described in step 4 of the mapping procedure). The levels from profile 1 to its 
duplicate at the beach (profile 2) would map directly. The levels from the duplicate land 
profile (profile3) to the inland profile (profile 4) would map directly, and the levels 
between the duplicates (profile 2 and 3) would map as shown in figure 7-11. 

Ocean station reproduced 
just off the beach 

Land station reproduced 
at the beach 

I 

M-units M-units 

Figure 7-11: Ocean and land station graphical mapping. 
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Keeping with the requirement for each profile to contain the same number of 
levels, the land profiles (both the land profile and its duplicate) must have levels inserted 
using the same convention as the other evaporation duct cases. The four profiles would 
now appear as listed in table 7-16. 

Table 7-16: Mapped evaporation duct profile to land profile. 

Ocean Profile Duplicate ocean profile Duplicate land profile at Land Profile 
just off the beach the beach 

.14 369.18 .14 369.18 .00    363.02 .00 363.02 

.22 368.19 .22 368.19 .00    363.02 .00 363.02 

.37 367.22 .37 367.22 .00    363.02 .00 363.02 

.61 366.25 .61 366.25 .00    363.02 .00 363.02 
1.00 365.30 1.00 365.30 .00    363.02 .00 363.02 
1.65 364.39 1.65 364.39 .00    363.02 .00 363.02 
2.72 363.53 2.72 363.53 .00    363.02 .00 363.02 
4.48 362.76 4.48 362.76 .00    363.02 .00 363.02 
7.39 362.15 7.39 362.15 .00    363.02 .00 363.02 
12.18 361.77 12.18 361.77 .00    363.02 .00 363.02 
15.34 361.72 15.34 361.72 .00    363.02 .00 363.02 

► Step 3: Mapping the Upper-air Portion of the Profile 

For this step, we must consider two possible cases. In case a, is at least one 
profile is over water with an evaporation duct. In case b, there is no evaporation duct or 
the evaporation duct was previously mapped using the techniques of step 2. 

Case a: One profile is over water with an evaporation duct. 

Prior to taking this step, it's assumed you have mapped the profiles should one or 
both contain an evaporation duct. If you haven't, please complete step 2. For the 
examples of upper-air cases a and b, we will assume level one of each profile is either a 
zero height or is the first level above the evaporation duct height. 

As our first profile, we will use the one used in case d for the evaporation duct, 
that is, one created from an ocean station radiosonde with a station elevation of 40 
meters. The surface conditions were such that a 15.34-meter evaporation duct height was 
calculated. The second profile is from a land station radiosonde with no evaporation 
duct. For the ocean/land case, the station elevations are immaterial as AREPS starts each 
profile at a height of zero no matter the station elevation. These two profiles are given in 
the table 7-17. The evaporation duct level is underlined for reference. 
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Table 7-17: Ocean and land station M-unit profiles. 

Profile 1 - Ocean Station Profile 2 - Land Station 
.00 374.49  Calculated evap .00   374.49  Normal 
.14 369.18  Calculated evap 40.00   363.02  Normal 
.22 368.19  Calculated evap 
.37 367.22   Calculated evap 
.61 366.25   Calculated evap 

1.00 365.30   Calculated evap 
1.65 364.39  Calculated evap 
2.72 363.53   Calculated evap 
4.48 362.76  Calculated evap 
7.39 362.15  Calculated evap 
12.18 361.77  Calculated evap 
15.34 361.72  Calculated evan 
20.09 361.80  Calculated evap 
33.12 362.50  Calculated evap 
40.00 363.02  Normal 

Having previously mapped the evaporation duct portion of the ocean profile, we 
now turn our attention to the portion of the profile above the evaporation duct height. 
The 40-meter level in each profile should be mapped together. What remains to be done 
is to insert levels that will map to the ocean profile's 20.09-meter and 33.12-meter levels 
into the land profile. The easiest way to do this is to assume the inserted level heights are 
the same. Using the interpolation equation shown in figure 7-12, we can calculate the 
needed M-unit values. 

(Ma-MbVHw-Hb) 

Ha-Hb 
\40.00     0.00   ' 

368.73 374.49 

\40.00     0.00 

Figure 7-12: M-unit interpolation. 

Here Mw is the M-unit wanted, Ma is the M-unit above the inserted level, Mb is the M- 

unit below the inserted level, Hw is the height of the inserted level, Ha is the height 

above the inserted level, and Hb is the height below the inserted level. 

Similarly, we interpolate for an M-unit value at a height of 33.12 meters. 
Inserting these two levels into the land profile produces the mapped profiles given in 
table 7-18. 
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Table 7-18: Mapped ocean station evaporation duct and upper-air profile to land station. 

Ocean profile Duplicate Ocean Profile Duplicate Land Profile Land profile 
Just Off the Beach at the Beach 

.14 369.18 .14 369.18 .00 363.02 .00 363.02 

.22 368.19 .22 368.19 .00 363.02 .00 363.02 

.37 367.22 .37 367.22 .00 363.02 .00 363.02 

.61 366.25 .61 366.25 .00 363.02 .00 363.02 
1.00 365.30 1.00 365.30 .00 363.02 .00 363.02 
1.65 364.39 1.65 364.39 .00 363.02 .00 363.02 
2.72 363.53 2.72 363.53 .00 363.02 .00 363.02 
4.48 362.76 4.48 362.76 .00 363.02 .00 363.02 
7.39 362.15 7.39 362.15 .00 363.02 .00 363.02 

12.18 361.77 12.18 361.77 .00 363.02 .00 363.02 
15.34 361.72 15.34 361.72 .00 363.02 .00 363.02 
20.09 361.80 20.09 361.80 20.09 368.73 20.09 368.73 
33.12 362.50 33.12 362.50 33.12 364.99 33.12 364.99 
40.00 363.02 40.00 363.02 40.00 374.49 40.00 374.49 

Graphically, the mapped levels now appear as shown in figure 7-13. 

M-units M-units 

Figure 7-13: Graphical mapped ocean station evaporation duct 
and upper-air profile to land station. 

E 

i 
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Case b: No evaporation duct or the evaporation duct has been previously 
mapped. 

The profiles of step 1 (gathering the input data) are used to demonstrate how to 
map two upper-air radiosonde profiles. You can see from these profiles, figures 7-14 and 
7-15, that an evaporation duct exists in each. Thus, we will assume that the 0- and 6- 
meter levels have been mapped in step 2 (and not displayed here), so we need only 
consider levels higher than 6 meters in height. 

Of prime importance is that similar anomalous refraction features be mapped 
between profiles and the mapped profiles ultimately contain the same number of levels. 
The purpose of saving the refraction description during step 1 is to aid you in determining 
what anomalous features are similar. 

Profile 1 Summary of Profile 1 
@label20Jun96-2200Z 8 

O f 
@height meters 1 
@range 0 kilometers 8 . 1 

.00      374.49    Calculated evap to J 
6.00      356.74   Trap j 
17.18      341.35   Normal 8 . o 1 

1091.59     443.92   Normal i 
1910.49     552.11    Super 8 . 

■= s I 
2044.78     555.90   Sub 
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1   8 . 
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2128.38     589.49   Normal f 
2846.28     681.72   Normal (O j 
3366.59     741.04   Normal J 
3655.54     774.70   Normal 8 . o t 
3890.70     796.71    Normal 
4392.21      863.68   Normal 8 . 

O j 
4538.49      884.73    Normal j 
5288.29     990.69   Normal 
6023.27    1091.27   Normal 
6906.71    1217.22   Normal 
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Figure 7-14: Profile 1 with graphical summary. 
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Profile 2 Summary of Profile 2 
@label20Jun96-2205Z 
@height meters 

H o 
to 

@range 0 kilometers 
.00   356.83    Calculated evap 8 . o 

V) / 
6.00   349.55   Trap 7 

248.05   342.44   Trap 8 / 
1585.46   500.50   Normal o / 
1685.72   510.85   Normal j^ / 
1869.10   532.65   Normal 
2353.43    597.63   Normal 
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2538.66   621.72   Normal I 
2795.18   648.67   Sub 8 . 

O / 
2806.49   650.92   Normal I 
3069.79   686.05   Normal I 
4679.15   912.14   Normal 8 . o I 
5050.36   963.86   Normal l 
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Figure 7-15: Profile 2 with graphical summary. 

Starting at the lowest elevation in profile 1, we look for any super-refractive, sub- 
refractive, or trapping layers. AREPS labels the layers such that the label applies to the 
bottom of the layer. That is, the super-refractive layer in profile 1 has a top at 2044.78 
meters and a bottom at 1091.59 meters. We examine profile 2 to see if there may be any 
corresponding super-refractive layer at or near these elevations. In this case there is not. 
You must now determine what is the most likely demise of this super-refractive layer. 
Figure 7-16 illustrates three possible scenarios: the layer remains level with range, the 
layer slopes upward with range, and the layer slopes downward with range. As you 
might expect, there are many more possibilities than just these three. Therefore, it is up 
to you to determine which is meteorologically most likely to occur. Once you have 
decided how you will map the level, use M-unit interpolation to insert the necessary 
point(s) into profile 2. For the interpolation algorithm, refer to mapping the upper-air 
radiosonde, case a. 
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Figure 7-16: Possible super-refractive layer geometries. 

Once the lowest anomalous feature of profile 1 has been mapped into profile 2, 
you will repeat the procedure and map the lowest anomalous feature of profile 2 into 
profile 1. For this example, the anomalous feature in profile 2 is the trapping layer with 
its top at 248.05 meters. Again, the figure 7-17 offers several mapping possibilities. 
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Figure 7-17: Possible trapping layer geometries. 

After mapping the lowest anomalous feature of profile 2 into profile 1, the process 
is repeated with the next highest anomalous feature. 

Once all the anomalous feature levels have been mapped between profiles, you 
will then go back to the lowest normal level in profile le and start the process over again, 
mapping all the normal levels upward until you have reached the top of the highest 
profile. The mapping may be from one existing level on one profile to an existing level 
on the other profile or you may insert new levels into the profiles using interpolation to 
determine the necessary M-unit value. Bear in mind that you must ultimately end up with 
equal numbers of levels in each profile. Figure 7-18 illustrates one possible mapping of 
these two profiles. In the illustration, note that there is only one feature that exists and 
maps directly between both profiles. It's the sub-refractive layer. Note also that no 
additional levels were inserted using the interpolation technique. Rather, we elected to 
map the super-refractive layer to an existing level in profile 2. It is a very good idea to 
keep the number of levels in the profiles to the absolute minimum as increasing the 
number of levels will not add any accuracy to the propagation model calculations but will 
cause the models to run more slowly. 
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Figure 7-18: Possible trapping layer geometries. 

The final profiles will now contain the level values given in table 7-19. The 
levels in bold text are those inserted during the mapping to ensure both profiles ultimately 
contain the same number of levels. 

Table 7-19: Mapped upper-air profiles between two stations. 

Profile 1 Profile 2 
.00 374.49   Calculated evap .00 356.83   Calculated evap 

6.00 356.74   Trap 6.00 349.55   Trap 
17.18 341.35  Normal 248.05 342.44   Trap 

1091.59 443.92  Normal 248.05 342.44  Inserted 
1910.49 552.11   Super 1585.46 500.50  Normal 
2044.78 555.90  Sub 1585.46 500.50   Inserted 
2128.38 589.49 Normal 1685.10 510.85  Normal 
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Table 7-19 (Cont): Mapped upper-air profiles between two stations. 

Profile 1 Profile 2 
2846.28 681.72 Normal 1869.10 532.65  Normal 
3366.59 741.04  Normal 2353.43 597.63  Normal 
3655.54 774.70  Normal 2538.66 621.72  Normal 
3890.70 796.71   Inserted 2795.18 648.67  Sub 
3890.70 796.71   Normal 2806.49 650.92  Normal 
4392.21 863.68  Normal 3069.79 686.05  Normal 
4538.49 884.73  Normal 3069.79 686.05  Inserted 
5288.29 990.69  Normal 4679.15 912.14  Normal 
6023.27 1091.27  Normal 5050.36 963.86  Inserted 
6906.71 1217.22 5050.36 963.86 

► Step 4:   Merging the Profiles into One File 

Once all the profiles have been mapped, it is time to combine the individual 
profiles you have been editing in the Notepad windows and insert the necessary 
keywording. Figure 7-19 illustrates the two Notepad windows containing the mapped 
profiles we were mapping in the upper-air case b. 
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Figure 7-19: Notepad windows for the mapped file 1 and file 2. 
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► To combine the two files. 

Steps  Comments 
Open a new Notepad window. 

Assuming profile 1 is closest to the transmitter, copy the 
contents of file 1 onto the clipboard and then paste them 
into file 3. 

Copy the @range line and the height versus M-unit lines of 
file 2 onto the clipboard and then paste them into file 3. 
Keep a few blank lines between the pastes. 

Replace the 0 in the @range 0 kilometers line associated 
with file 2, with the distance between profiles. 

While not necessary, you may delete the layer's refractive 
description labels. 

Save file 3 with any name you wish into the AREPS 
environment folder, but use an .ENV extension. 

To  use this range dependent environmental input file,  select it from the 
environments dropdown menu in the AREPS project window. 
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TERRAIN 

As the default, AREPS uses digital terrain elevation data from the National 
Imagery and Mapping Agency (NIMA). The normal distribution of DTED data is via 
CD-ROMs. In addition to DTED terrain data, AREPS is capable of using terrain data 
you specify yourself. You may use the terrain window to enter your own data and save it 
in a format usable by AREPS. Since these terrain data are stored in and read from an 
ASCII text file, you may also choose to create your own terrain data file externally to the 
AREPS program using an ASCII text editor such as Notepad. Be sure to follow the 
specifications of an AREPS terrain file when making your own file in this fashion. 

AREPS allows for a number of options in the consideration and management of 
the terrain data. For a detailed discussion of these options, refer to chapter 6 (Options 
window). 

DTED Terrain Data 

Digital Terrain Elevation Data are a uniform matrix of terrain elevation values, 
providing basic quantitative data for systems that require terrain elevation, slope, and/or 
gross surface roughness information. 

NIMA maintains a general help desk that serves as a primary entry point for 
questions about products or services and as the primary customer advocate. The general 
help desk is available 24 hours a day. The general help desk address is: 

NIMA General Help Desk (L-52) 
3200 South Second Street 
St. Louis, MO 63118-3399 

Contact telephone numbers are: 
DSN 490-1236 
Toll free 1-800-455-0899 
Commercial (314) 260-1236 
Fax (314) 260-1128 
DSN fax 490-1128 

NIMA provides their DTED data in level 0, level 1, and level 2 formats. Level 0 
spacing is 30 arc seconds in horizontal resolution (approximately 1 kilometer). DTED 
level 0 data is unlimited distribution and may be obtained directly from NIMA's public 
Internet homepage. DTED level 1 spacing is 3 arc seconds in horizontal resolution 
(approximately 100 meters). Level 2 post spacing is 1 arc seconds in horizontal 
resolution (approximately 30 meters). Level 1 and 2 data are limited distribution. For 
this reason, DTED data are not and may not be distributed with AREPS. If you have a 
connection to the Secure Internet Protocol Router Network (SIPRNET), you may 
download the DTED level 1 and 2 data directly from NIMA's SIPRNET homepage. In 
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addition, NIMA provides terrain data in other formats such as raster graphics. AREPS 
will accept DTED level 0,1, and 2 coverage only. You may choose your DTED level by 
selecting the Terrain tab from the Options menu. 

DTED Folder Structure 

When AREPS uses DTED data from a 
CD-ROM, they are copied to the hard disk in the 
same folder structure as on the CD-ROM itself. 
Should you obtain your DTED data by 
downloading from the NIMA Internet or 
SIPRNET homepages, it is important you 
recognize this folder structure as you will need to 
reproduce it yourself and copy your downloaded 
data into it. Under the DTED folder, illustrated 
in figure 8-1, are subfolders named E003, E004, 
W114, etc. (note 3 digits), where the W and E 
represent west and east and the 003, 004, and 114 
represent the whole degrees of longitude. Within 
each of these subfolders, the file naming 
convention is N32.DTX, S15.DTX, etc., where 
the N and S represent north and south and the 32 
and 15 represent whole degrees of latitude. The 
file extension of .DTX represents the DTED 
level, where .DT0 is level 0 data, .DTI is level 1 
data, and .DT2 is level 2 data. 
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Figure 8-1: DTED folder structure. 

Terrain CD-ROM File Manager Window 

a. Terrain File Manager 

Please insert any needed terrain CD into CD drive 
■and then select a command button. "•'::•'- 

Read CD Ignore CDs Cancel ■ 

Need 2 terrain CDs. They are... 
DTED139 
DTED138 

Figure 8-2: Terrain File Manager window. 

When a project is executed, its 
terrain data requirements are 
examined. If you are using the 
DTED CD-ROMs for your terrain 
data and the data do not already exist 
in your terrain folder, a terrain file 
manager window, figure 8-2, will 
open. The total number of CD-ROM 
disks the project requires and a 
listing of these disks shows in the 
window. The CD-ROM number is 
that assigned by NIMA. Insert one 
of the CD-ROMs into the CD drive 
drawer  and  click  the  Read   CD 
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command button. The order in which you insert disks is not important. You may also 
click the Cancel command button, in which case you will be returned to the project 
window, or you may click the Ignore CDs command button and the project will continue 
to execute but without considering terrain effects. 

My Own Terrain 

AREPS is capable of using terrain data you specify yourself. You may use the 
terrain window, figure 8-3, to enter your own terrain data and save them in a format 
usable by AREPS. In addition, you may use this window to edit a terrain file created 
from DTED data. 

mixj 
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Open Insprt Range j      Deletp Range Cancel 

Figure 8-3: Terrain window. 

Center Location 

The center location is the latitude and longitude of the first terrain point. Click on 
one of the option buttons adjacent to the seconds input field to select the north, south, 
east, and west quadrant. 

Bearing from Center 

The bearing is the azimuth along which the terrain height data applies. The 
bearing is in whole degrees relative to true north. AREPS 1.0 allows you to specify your 
own terrain along a single bearing. If you have requested more than one bearing and are 
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also using your own terrain, you will receive a warning notice, the number of bearings 
will be automatically set to one, and the project will continue. 

Terrain Range and Height 

The first column of the terrain tabular form contains range values. The values 
must be increasing in range. The units of range may be feet, yards, meters, nautical 
miles, statute miles, kilometers, and kiloyards. To change the units of the column, right 
click on the column label. The value of the first range must be zero. 

The second column of the terrain tabular form contains height values. The units 
of height may be feet or meters. To change the units of the column, right click on the 
column label. 

Surface Type 

Before you continue, for frequencies above 100 MHz, please understand that 
surface types have minimal influence upon propagation, and for the vast 
majority of cases, you need not be concerned with a surface type. In addition, 

AREPS assumes a perfect conducting surface for horizontally polarized antennas and any 
specified surface type is ignored. 

Should you be concerned about surface types for vertically polarized antennas, 
however, AREPS uses the surface conditions as defined by the International 
Telecommunication Union, International Radio Consultative Committee (CCIR). These 
conditions are broken into seven categories based upon surface characteristics. For your 
convenience, we have provided plain language descriptors that fall within the seven 
categories. These descriptors are given in table 8-1. 

Table 8-1: Surface type descriptors. 
Sea water Fresh water Sandy loam Marsh 

Plowed fields Very moist soil Medium dry ground Sandy soil 
Rocky soil Medium sized towns Very dry ground Granite mountains 

Industrial areas New ice Old ice Self-defined 

You may select one of these descriptors from the surface type dropdown menu. 
Based upon the surface descriptor you have selected and the frequency of the project's 
transmitter, a proper calculation of surface conductivity and permittivity is made. 

If you select one of the plain language descriptors, the permittivity and 
conductivity columns of the tabular form will be filled with the word Compute, the 
background color of these columns will change to green, and you will not have access to 
these columns. If you select Self-defined from the menu, you must specifically enter a 
surface permittivity and conductivity value. 
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^^ A surface type must be associated with the first range. If you are using 
Hilly DTED terrain data and the terrain elevation at the first range is zero, sea- 
*Wr water is assumed for the entire path, even if nonzero terrain elevations are 

subsequently encountered. If the elevation at the first range is not zero, medium dry 
ground is assumed for the entire path, even if zero elevations are subsequently 
encountered. Please understand this assumption is made because no data exists on the 
DTED CD-ROM to say what the surface type is for any elevation. 

If you are using DTED data and don't want this assumption, you must specify the 
surface type yourself. 

► To specify a surface type with DTED data. 

Steps Comment  
1 Execute the project to have AREPS read the DTED data and 

create the terrain files. By default, terrain files are not saved 
so you must choose to save them by selecting the Save 
Terrain in ASCII text format item from the Save/Edit tab 
on the Options menu. 

2 After the terrain files are created for all project bearings, open 
each file individually in the terrain window, select a different 
surface type for the first (and any other) range, then save the 
file. 

3 Re-execute the project. 

Surface Electrical Characteristics 

The fourth and fifth columns of the terrain tabular form contain the surface 
electrical characteristics expressed as permittivity and conductivity. 

The electrical characteristics of any medium may be expressed by three 
parameters. The first parameter is the permeability, the rate of diffusion of a substance 
such as a gas or water through a porous material. The second parameter is the 
permittivity, the ratio of the electric flux density produced by an electric field in a 
medium to that produced in a vacuum by the same field. The third parameter is the 
conductivity, a measure of how a particular substance conducts electricity. They jointly 
influence wave propagation. The permeability of the ground can normally be regarded as 
equal to free-space permeability so for most propagation considerations, we are only 
concerned with permittivity and conductivity. 

The effective values of the constants of the ground are determined by the nature 
of the soil, by the soils moisture content and temperature, by the frequency, by the 
general geological structure of the ground, and by the effective depth of penetration and 
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lateral spread of the waves. While it has been established by numerous measurements 
that the values of the electrical characteristics vary with the nature of the soil, it is seems 
probable that the variation may be due not so much by the chemical composition of the 
soil as its ability to absorb and retain moisture. The moisture content of a particular soil 
may, however, vary considerably from one site to another, due to differences in the 
general geological formations that provide better drainage in one case than another. 

Typical values of conductivity and permittivity for different ground types are 
generally determined by laboratory measurements of a particular homogeneous soil type. 
In nature, however, the surface and sub-surface are rarely homogeneous, but rather 
consist of two or more layers of different thickness and different conductivity and 
permittivity. AREPS version 1.0 considers only values for a homogeneous surface. 

Command Buttons 

Across the bottom of the terrain window are command buttons. You may use 
these command buttons to perform various functions. 

Open 

The Open command button allows you to open a terrain file for editing. The 
Windows 95/NT Explorer window opens allowing you to browse your entire folder 
structure for the desired file. The terrain file may be one you previously created yourself 
or it may be a file created by AREPS while reading data from a DTED CD-ROM. 

Save 

The Save command button saves the data from the terrain tabular form into an 
ASCII text file readable by AREPS. You may name the file as you wish but you are 
limited to 48 characters. The file will be saved in the environment directory. AREPS will 
append the .TER extension onto the file name you specify. For example, if you specify 
MyTerrain.ter, the file name will be MyTerrain.ter.ter. 

Insert and Delete Range 

The Insert Range command button allows you to open a blank range input point 
prior to the current cursor location. You may then enter a new range, height, and surface 
condition. The Delete Range command button removes the range at the current cursor 
location. As ranges are inserted and deleted, proper input limits show in the status bar's 
left panel. 

Cancel 

The Cancel command button ignores all your entries and editing actions and 
closes the Terrain window. 
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Terrain File Format 

The following describes the considerations, structure and restrictions on creating 
your own terrain file. 

Terrain File Name 

Terrain files are created in three ways and the naming conventions are slightly 
different for each. 

1. You may desire access to the terrain data for use in your own evaluation 
program. Rather than creating a program yourself to read the DTED CD-ROMs, you 
may have AREPS save the terrain's height and range data (one file for each project 
bearing) in the project's folder as an optional ASCII text file. By default, the file name is 
TERRNddd. TER, where the ddd represents the bearing in whole degrees relative to true 
north. You may choose to use a name prefix other than TERRN, however. You may use 
any valid Windows95/NT file name character including spaces. AREPS will append the 
ddd and the .TER extension onto the file name you specify. For example, if you specify 
terrain.000, the file name will be terrain.OOOdddTER. 

2. You may create your own file (or edit a DTED CD-ROM file) in the terrain 
window. There is no default name. AREPS will append the .TER extension onto the file 
name you specify. For example, if you specify MyTerrainJer, the file name will be 
MyTerrain. ter. ter. 

3. You may create your own terrain file external to the AREPS program. When 
doing so, be sure to follow the proper file conventions. Of course, you may name the file 
as you choose using any valid Windows95/NT file name character including spaces. 
AREPS will not modify your file's name. 

Terrain File Considerations 

AREPS 1.0 allows you to specify your own terrain along a single bearing. If you 
have requested more than one bearing and are also using your own terrain, you will 
receive a warning notice, the number of bearings will be automatically set to one, and the 
project will continue. 

When using your own terrain, the terrain map in the lower right corner of the 
decision aid does not make sense. Therefore, if you use your own terrain, the terrain map 
option will automatically be set to "No map." 

The terrain file may be created independently of any particular project so the 
maximum terrain range may not coincide with the maximum display range. In this case, 
you may choose to continue the display, have the display range automatically adjusted to 
the maximum terrain range, or cancel the display. If you choose to continue the display, 
please understand any propagation loss or probability of detection/ESM intercepts 
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beyond your maximum display range may or may not be in error based upon your 
refractive conditions. 

Terrain File Restrictions 

A terrain profile is defined as couplets of range and height. The maximum 
number of couplets for AREPS is unlimited. The height and range values need not be 
separated by a comma or other delimiter but must be separated by at least one space. 
Any characters beyond the height value are ignored. The value of the first range must be 
zero. 

Key Words and Symbols 

The terrain file contains a number of key words and symbols (keywords are case 
insenitive) which describe the data. These key words and symbols are: 

# - A line beginning with a # is a comment and is ignored by AREPS. In additon, 
blank lines are ignored by AREPS. 

©latitude - signifies the latitude of the terrain location. Following this keyword 
is the latitude value in the format DD MM SS H where DD is whole degrees, MM is 
whole minutes, SS is whole seconds, and H is the hemisphere either N for north or S for 
south. The minutes and seconds need not be present and DD may be a single character (5 
vice 05). As AREPS version 1.0 allows terrain along a single bearing, the latitude 
keyword is used only for display purposes in the terrain window. 

@longitude - signifies the longitude of the terrain location. Following this 
keyword is the longitude value in the format DDD MM SS H, where DDD is whole 
degrees, MM is whole minutes, SS is whole seconds, and H is the hemisphere, either W 
for west or E for east. The minutes and seconds need not be present and DDD may be 
either one or two characters (5 vice 005 or 20 vice 020). As AREPS version 1.0 allows 
terrain along a single bearing, the longitude keyword is used only for display purposes in 
the terrain window. 

@bearing - signifies the azimuth along which the terrain height data applies. 
Following this keyword is the bearing value in the format DDD, where DDD is whole 
degrees relative to true north. DDD may be one, two, or three characters (5 vice 005 or 
20 vice 020). Any characters beyond the DDD are ignored. As AREPS version 1.0 
allows terrain along a single bearing, the bearing keyword is used only for display 
purposes in the terrain window. 

@height - signifies the units for all values of height. If the @height keyword is 
not present, meters are assumed. Following this keyword is the unit keyword. The unit 
keyword may be ft or m. If the unit keyword is not present, meters are assumed. This 
keyword must appear before any height value. 
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@range - signifies the units for values of range. If the @range keyword is not 
present, meters are assumed. Following this keyword is the range unit keyword. The 
unit keyword may be yd, kyd; m, km; run or nmi; or sm. If the unit keyword is not 
present, meters are assumed. Some examples are @range sm, @RANGE yd, and 
@range nmi. 

@ground - signifies the surface type. When the @ground keyword is used, the 
surface type applies at the range immediately following the keyword. It is not necessary 
to have a surface type specified for every range. Once a surface type is specified, it is 
assumed constant for all following ranges until it is specified again. If the @ground 
keyword is not present, seawater is assumed. Following this keyword is the surface type 
keyword. The surface type keywords (spelling but not case sensitive) are specified in 
table 8-1. If the surface type keyword is Self-defined, it must be followed by two values, 
the first for the surface permittivity and the second for surface conductivity. These two 
values need not be separated by a comma or other delimiter but must be separated by at 
least one space. If these two values are not present, an error is announced. 

Figure 8-4 illustrates a small portion of a sample terrain file. 

# AREPS Version [1.0.0] terrain profile 
©Latitude 44 30 00 N 
©Longitude 014 00 00 E 
©Bearing 010 (°T) 
©Range km 
©Height m 
©ground Self-defined 50 2 

0.000     25.00 
0.100     78.00 
0.200    145.00 

©ground Industrial areas 
0.300   200.00 
0.400    140.00 
0.501      80.00 
0.601      43.00 
0.701     43.00 
0.801       0.00 
0.901      92.00 

Figure 8-4: Sample terrain file format. 
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DECISION AIDS 

Coverage Display Window 

Coverage decision aids of radar detection, ESM intercept, or communications are 
shown in the coverage display window, illustrated in figure 9-1. Various pieces of 
information show on the right side of the decision aid. Some of this information is 
project dependent, such as radar name, target name, environment file name, etc. Other 
information shows as the mouse cursor is moved about the display. This information 
includes height, range, latitude, longitude, bearing, propagation loss, etc. 

SI AEEPS - Coastal detea 

Figure 9-1: Coverage display window. 
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Figure 9-2: Display options pop-up 
menu. 

Selecting the options button from the 
toolbar or right clicking anywhere within the 
coverage display will open a display options 
pop-up menu, illustrated in figure 9-2. If 
you select the options button, you are asked 
for the desired height or range.  If you right 
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click the mouse, the display will be for the height and range associated with the mouse 
cursor's location. You may open as many of these loss displays as you wish. 

Cp 
In order to calculate propagation loss in the extended optics region, a 

loss at the top of the parabolic equation region is needed for all ranges. 
Thus, the extended optics region is calculated after the decision aid has 
reached its final range.   You will notice this "two pass" calculation as a 

blank area in the upper right corner of the decision aid.   Once the extended optics 
calculations are made, the total image of the decision aid is shown. 

Display Window Toolbar 

Across the top of the display window is a toolbar, figure 9-3, with buttons to 
control the azimuth display of the decision aid. 

S AREPS - 3D Surface Radar ■BB 
annum»! Options I Back       Next.:jv,PnrI^XeLricBl   Speei 

Figure 9-3: Display window toolbar. 

With these buttons, you may pause or continue the azimuth display, single step 
through the decision aids either backward or forward, print a single aid, cancel the 
display, or change the speed with which the aids are shown. In addition, the options 
button provides access to propagation loss or signal-to-noise displays in range or height. 

Display Window Color Bar 

For coverage decision aids, beneath the diagram is a color bar legend for the type 
of data being displayed. For radar only displays, figure 9-4, the colors represent either 
probabilities of detection, figure 9-4, or propagation loss, figure 9-5, depending upon the 
option you choose. 

Radar Pdl 
1        .9 .8 .7 £ .5 .4 .3 2 .1 

Figure 9-4: Radar probability of detection color bar. 

110      115      120      125      130      135      140      145 

Figure 9-5: Radar propagation loss color bar. 
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For simultaneous radar and ESM displays, the colors represent greater than 90% 
and greater then 50% probability of detection and a binary (yes or no) ESM intercept as 
illustrated in figure 9-6. 

Radar Pd fl I   ESM Detection M 
1       .9       .5 Yes No 

Figure 9-6: Radar and ESM color bar. 

For the ESM only and communications displays, the colors represent either ESM 
intercept or communications, yes or no as illustrated in figure 9-7. 

Communications 
Yes No 

Figure 9-7: ESM and communications color bar. 

Any area of the coverage diagram that is colored white indicates an area for which 
no propagation calculations were made. 

Coverage Display Options 

Coverage display options may be selected from the Display tab of the Options 
menu. The height versus range coverage display may be referenced to probability of 
detection or to propagation loss. You may specify the limit of this reference, the 
increment of the reference, and how may increments you want. For example, you may 
choose propagation loss as your reference. You then may select 100 dB as your 
minimum propagation loss threshold value, 5 dB intervals, and 9 intervals. On your 
display, you will see 10 boxes on the color bar labeled 0 to 100 dB, 100 to 105 dB, 105 to 
110 dB, etc. As another example, you may choose probability of detection as your 
reference. You may then choose 100 percent as the limit, 20 percent as the interval, and 
2 intervals. On the display, you will see 2 boxes on the color bar labeled 1 to .8 and .8 to 
.6. 

To aid you in visualizing the decision aid, you may choose to have height 
reference lines drawn on the display. 

Loss Versus Range Display Window 

Rather than a height versus range coverage display, propagation loss or signal-to- 
noise ratios may be shown in a decibel versus range display, illustrated in figure 9-8. 
This display is for a constant height. Unlike the coverage display, the contours of electric 
field strength are represented by horizontal lines. For an EM system to function, the 
propagation loss must not exceed the threshold, whereas the signal-to-noise ratio must 
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exceed the threshold. From the Displays tab on the Options menu, you may specify the 
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Figure 9-8: Propagation loss versus range display window, 

propagation loss or signal-to-noise limits and if you want to display threshold lines. 

As the mouse cursor moves over the display, a crosshair cursor follows the mouse 
and rides along the propagation loss curve. The range and loss values, both at the mouse 
position and the crosshair position are shown. An options pop-up menu (shown in figure 
9-8) is available by right clicking anywhere on the display. If you select Display Data, a 
scrollable window will open so you may view the propagation loss values along the 
curve. This data window is illustrated in figure 9-10. 
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Figure 9-10: Propagation loss versus range display with open data window. 
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Loss Versus Height Display Window 
Rather than a height versus range coverage display, propagation loss or signal-to- 

noise ratios may be shown in a decibel versus height display, illustrated in figure 9-11. 
This display is for a constant range. Contours of electric field strength are represented by 
vertical lines. 
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Figure 9-11: Propagation loss versus height display window. 

For an EM system to function, the propagation loss must not exceed the 
threshold, whereas the signal-to-noise ratio must exceed the threshold. You may specify 
the propagation loss or signal-to-noise limits and if you want to display threshold lines 
from the Displays tab on the Options menu. 

As the mouse cursor moves over the display, a crosshair cursor follows the mouse 
and rides along the propagation loss curve. The height and loss values, both at the mouse 
position and the crosshair position are shown. An options pop-up menu is available by 
right clicking anywhere on the display. 

Loss Versus Range and Height Options 

The loss versus range and the loss versus height display may be referenced to 
propagation loss or to signal-to-noise. You may specify the upper and lower limit of this 
reference. In addition to the reference, you may also choose to superimpose radar 
probability of detection, ESM intercept, or communications threshold lines. For ESM 
only or communications displays, threshold lines will not display when using the signal- 
to-noise reference. For radar probability of detection, you may choose the maximum 
threshold, the interval of the threshold, and how many intervals you want. For example, 
you may choose 100 percent as the maximum probability of detection, 20 percent as the 
interval, and 2 intervals. On the display, you will see three colored dashed lines 
corresponding to 100 percent, 80 percent, and 60 percent probability of detection. 
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TACTICAL APPLICATIONS 

Strike and Electronic Counter Measures Considerations 

One tactic employed by an attack aircraft in penetrating an enemy target's 
defenses is to fly as low as possible to remain "beneath" the radar coverage. This may be 
a valid tactic during nonducting conditions. For surface-based ducting conditions, 
however, the enemy is given a greater detection range capability for targets flying within 
the duct than for targets at higher altitudes. Knowledge of the existence and height of a 
surface-based duct would enable the strike group or aircraft commander to select the 
optimum altitude for penetration. This would be just above the top of the duct. 

In a manner similar to that described for the strike case, an ECM aircraft may 
adjust its position to maximize the effectiveness of its jammers by using the coverage 
display. By flying within a duct, the aircraft will be more easily detected but, at the same 
time, its jamming effectiveness will be greatly enhanced and its standoff range will be 
greatly extended. 

While it may be possible to avoid detection by flying down an interference null, 
the changing height versus range profile would be more difficult to fly and, if the aircraft 
were off course or the null pattern changed somewhat, due to the target ship's roll for 
example, detection would occur. In addition, ship or land targets would usually be 
defended by several radars operating at different frequencies. The constructive 
interference pattern for one radar would most likely fill in the destructive interference 
pattern of the second radar, thereby increasing the likelihood that this maneuver will be 
unsuccessful. 

The decision aid for standard atmospheric conditions, figure 10-1, shows that a 
strike aircraft flying just above the terrain should not be detected until it is within 18 
nautical miles of the defending radar. Should the aircraft be making its ingress at an 
altitude of 6000 feet, the detection probabilities rapidly increase at ranges beginning at 72 
nautical miles from the defending radar. For this standard atmosphere case and 
neglecting other tactical considerations such as surface-to-air missile threats, the 
optimum strike altitude is as close to the terrain as the aircraft can safely fly. An ECM 
jamming aircraft however would have an optimum altitude of 6000 feet as this will 
provide the greatest standoff range coupled with the greatest jamming effectiveness. 
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Figure 10-1: Coverage display for standard atmosphere. 

Using the same principles under a surface-based ducting environment, illustrated 
in figure 10-2, if the strike aircraft is flying just above the terrain, the probabilities of 
detection greatly increase beginning at a range of 80 nautical miles from the defending 
radar. 
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Figure 10-2: Coverage display for a surface-based duct atmosphere. 
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Note also, should the strike aircraft be making its ingress at an altitude of 6000 
feet, the detection probabilities rapidly increase at ranges over 90 nautical miles from the 
defending radar. Thus, for a surface-based ducting environment, the optimum strike 
altitude is neither low nor high but just above the duct's top, an altitude of approximately 
1000 feet. While a jamming aircraft will have success at high altitudes, its greatest 
jamming effectiveness is at altitudes closest to the terrain. 

Early Warning Aircraft Stationing Considerations 

By using the coverage decision aid, the optimum altitude for early warning 
aircraft can be determined, which will minimize the effects of radar "holes" or "shadow 
zones" created by elevated ducts or terrain features. It should be remembered that 
although the duct acts like a waveguide for the energy, this waveguide does not have 
rigid and impenetrable boundaries, except for the earth's surface in the case of surface- 
based ducts. Therefore, energy is continually "leaking" from the duct into the hole. In 
addition, surface-reflected energy may propagate into this hole. While the energy level 
within a radar hole may be insufficient for radar detection, it may be sufficient for ESM 
intercept. 

The coverage decision aid, figure 10-3, illustrates the principles discussed above. 
For this case, there is an elevated duct between 19,000 and 20,000 feet. The aircraft is 
flying within the duct. Extended ranges for high probability of detection can be seen 
within the duct. 

100 150 
RANGE nmi 

Figure 10-3: Early warning aircraft within an elevated duct. 
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The radar hole is evident above the duct. In addition, you can see energy leaking 
upward from the duct, defining a down-range boundary for the hole, and you can see 
surface-reflected energy reaching the atmosphere above the duct and beyond the down- 
range hole boundary. Note that for this case, the hole starts at 64 nautical miles from the 
transmitter. 

Tactically, flying within an elevated duct is not desirable, as the aircraft will 
experience the greatest area of reduced coverage. While it's true the extended ranges 
within the duct do exist, the likelihood of the target also being within the duct cannot be 
counted on. In addition, an ESM intercept aircraft could tactically exploit these extended 
ranges by stationing himself at ranges beyond radar detection but still within ESM 
intercept ranges. 

Now consider the AEW aircraft ascending to an altitude of 25,000 feet, illustrated 
in figure 10-4. While the radar hole is still present, it starts 95 nautical miles from the 
transmitter. The higher the transmitter is above the duct, the farther in range the hole will 
begin. Also notice that extended ranges within the duct are not present. Here again, 
there is a tactical tradeoff, i.e., no extended ranges but better overall coverage. 
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Figure 10-4: Early warning aircraft above an elevated duct. 
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In figure 10-5, the early warning aircraft positions itself at an altitude of 15,000 
feet. Notice that since the transmitter is now below the elevated duct, there are no 
anomalous propagation effects from the duct, i.e., no extended ranges and no radar hole. 
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RANGE nmi 

200 250 

Figure 10-5: Early warning aircraft below an elevated duct. 

Thus, as a rule-of-thumb, the positioning of an early warning aircraft in relation to 
the elevated duct is to fly as high above the duct as possible or fly anywhere below the 
duct, consistent with other mission objectives including radar/communication horizon, 
fuel usage, height assignments by traffic control, etc. 

While not a part of the tactical application, figure 10-5 illustrates a limitation of 
the current APM propagation model. Any area of the display that is colored white 
indicates an area for which no propagation calculations were made. In this case, it is for 
high angles. A conscious decision was made to ignore these high angles due to computer 
execution time and memory considerations when employing the parabolic equation 
model. This limitation should not be a hindrance to tactical applications, however, as 
refractive effects are negligible above a few degrees from the horizontal. This limitation 
of the advanced propagation model will be overcome in a future version of APM with the 
inclusion of the airborne parabolic equation model. No detection of a high-flying target 
will be a tactical problem when the target is outside the antenna pattern of the transmitter. 
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Electronic Surveillance Measures (ESM) 

Oftentimes it is advantageous to know not only the detection ranges of threat 
targets but your own vulnerability to ESM intercept by an enemy. For example, you are 
concerned about detecting a low-flying anti-radiation missile (ARM) but, at the same 
time, you are concerned about providing the missile's seeker with extended detection 
range. Likewise, when creating an emissions control plan, for example, a task force, it is 
of great value to know which systems are most vulnerable to intercept. A tradeoff study 
of emitters can be made to determine placement and use of emitters to defend your 
position yet remain undetected for as long as possible. These considerations can be made 
with the radar/ESM vulnerability display. 

The tactical situation could also be applied in a reverse sense. For example, you 
may be airborne, trying to approach a heavily defended area, giving as little advance 
notice as possible. You do this by not radiating an EM system except for your downward 
looking terrain following radar. Using the radar/ESM vulnerability display, you will be 
able to assess the effects of diffraction over terrain features. While the main beam of the 
radar is pointed toward the ground, energy is still being radiated outward through the 
sidelobes. The sidelobe energy could be diffracted forward over steep terrain to an ESM 
receiver at the defended area, thereby giving unsuspected advanced notice of your arrival. 

Consider a mission to approach a hostile coastline and provide AAW surveillance 
for the protection of an amphibious landing force (illustrated in figure 10-6). 
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Figure 10-6: Radar and ESM intercept decision aid. 



Chapter 10: Tactical Applications 147 

For this mission, it is highly desirable to remain undetected for as long as 
possible. You anticipate the coastal mountain ranges will provide you cover from ESM 
intercept. Using the combination radar detection and ESM vulnerability decision aid, you 
can visualize your detection ranges for the anticipated threat aircraft and also see the 
vulnerability of your air surveillance radar to a hostile ESM receiver. In this example, 
the environment is a surface-based duct at your ship's location that rises to become an 
elevated duct over the coastal terrain. This ducting condition provides fairly reasonable 
detection for targets at ranges of 100 nautical miles. As you would expect, your radar is 
vulnerable to intercept at even greater ranges. You can see, however, an ESM receiver 
that is located 120 nautical miles away and within a valley beyond 2 mountain ranges, is 
still capable of intercepting your radar's energy. The coastal mountains do not provide 
the intercept protection you were expecting. For this case, the mission commander may 
choose to use an airborne platform for AAW surveillance instead of a ship platform. 

UHF/VHF Communications 

It is commonly thought that UHF/VHF communications is a line-of-sight event. 
This is true under standard atmospheric conditions. Consider a tactical application such 
as a ship trying to communicate with ground troops over a water and terrain path. The 
communications decision aid shown in figure 10-7, for a standard atmosphere indicates a 
loss of surface communications at a range of approximately 8 nautical miles. 
Communications is not regained until 25 nautical miles from the ship with the troops at 
an altitude of 250 feet. By examining the areas of no communications, the ashore forces 
can determine a good location to establish a command center with adequate 
communications to the afloat platform or to aid in troop positioning. 
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Figure 10-7: UHF communications decision aid. 
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Tactics for ASW helicopter operations may also benefit from the knowledge of 
ducting or nonducting conditions. For example, under standard atmospheric conditions 
as illustrated in figure 10-8, the helicopter (at an altitude of approximately 50 feet) can 
maintain both ASW surveillance with its dipping sonar and communicate with the ship at 
a range of approximately 33 nautical miles. 
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Figure 10-8: UHF communications under standard atmosphere conditions. 

Under surface-based ducting conditions, figure 10-9, the helicopter at the same 
altitude could extend the communication ranges well beyond 60 nautical miles. In 
addition, the decision aid shows surface-based ducting skip zones that could preclude 
communications at certain ranges. 
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Figure 10-9: UHF communications under surface-based ducting conditions. 

Use for Hardware Maintenance 

An operator will experience days when detection of radar targets or 
communication with other units over the horizon is possible and days when extended 
ranges are not possible. In addition, the radar operator will experience false targets or 
radar "ghosts" under ducting conditions.     Without the knowledge of anomalous 
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propagation conditions, it may be thought that decreased ranges are indicative of 
hardware problems. Without knowledge of the interference patterns, signal fading in 
UHF communications may also be thought of as indications of hardware problems. A 
decision aid for the given day will explain such anomalies and, therefore, preclude 
unnecessary maintenance calls. 

Consider the following example. A naval task force is traveling in formation with 
specified spacing between units. The Officer-of-the-Deck finds he is not able to 
communicate with the closest ship, yet can communicate with another ship farther away. 
The first thought may be that the radio receivers of the closest ship are not working 
correctly. Examining a communication coverage display as illustrated in figure 10-10 
reveals, however, surface ducting conditions with its inherent "skip zones." The spacing 
between the two ships is such that the closest ship is within a skip zone while the farther 
ship is not. With this knowledge, the ship's spacing may be altered to avoid the skip 
zones. 
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Figure 10-10: Surface-based ducting skip zone conditions. 

The same situation may apply to a naval unit approaching a gun or missile range 
for an exercise. A radio check-in is unsuccessful. It is not uncommon to think that either 
the radio is not functioning correctly (which leads to a trouble call to the electronics 
technicians) or one party is not monitoring his receivers (which leads to frustration on the 
part of both the ship's personnel and the personnel of the range who believe the ship is 
not following procedures). Examining a communication decision aid may reveal the ship 
is within a skip zone with respect to the range commander, in which case, the ship can 
simply move to a location outside of the skip zone. If no skip zone is present, then a 
trouble call can be made with some assurance that there is an equipment problem. 
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